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safety information
These warnings and precautions are included to prevent injury to you and others, and to prevent any potential damage to 
your machine. Be sure to read and understand all of these instructions before using the machine.

Use common sense for operating any electrical appliance and whenever using your machine. Also, follow all warnings and 
instructions marked on the machine and in the accompanying literature. After reading this section, keep it in a safe place 
for future reference.

Important safety symbols

This section explains the meanings of all icons and signs in the user's guide. These safety symbols are in order, according to the degree of 
danger.

Explanation of all icons and signs used in the user’s guide:

Warning Hazards or unsafe practices that may result in severe personal injury or death.

Caution Hazards or unsafe practices that may result in minor personal injury or property damage.

Do not attempt.

Do not disassemble.

Do not touch.

Unplug the power cord from the wall socket.

Make sure the machine is grounded to prevent electric shock.

Call the service center for help.

Follow directions explicitly.

Operating environment

 Warning

Do not use if the power cord is damaged or if the 
electrical outlet is not grounded.

► This could result in electric shock or fire. 

Do not bend, or place heavy objects on the power 
cord. 

► Stepping on or allowing the power cord to be 
crushed by a heavy object could result in electric 
shock or fire. 

Do not place anything on top of the machine (water, 
small metal or heavy objects, candles, lit cigarettes, 
etc.).

► This could result in electric shock or fire. 

Do not remove the plug by pulling on the cord; do not 
handle the plug with wet hands. 

► This could result in electric shock or fire. 
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 Caution

During an electrical storm or for a period of 
non-operation, remove the power plug from the 
electrical outlet. 

► This could result in electric shock or fire. 

If the plug does not easily enter the electrical outlet, do not 
attempt to force it in. 

► Call an electrician to change the electrical outlet, or this 
could result in electric shock.

Be careful, the paper output area is hot. 

► Burns could occur. 

Do not allow pets to chew on the AC power, telephone or PC 
interface cords.

► This could result in electric shock or fire and/or injury to your 
pet. 

If the machine has been dropped, or if the cabinet appears 
damaged, unplug the machine from all interface connections 
and request assistance from qualified service personnel.

► Otherwise, this could result in electric shock or fire.

If the machine does not operate properly after these 
instructions have been followed, unplug the machine from all 
interface connections and request assistance from qualified 
service personnel.

► Otherwise, this could result in electric shock or fire.

If the machine exhibits a sudden and distinct change in 
performance, unplug the machine from all interface 
connections and request assistance from qualified service 
personnel.

► Otherwise, this could result in electric shock or fire.

Operating method

 Caution

•If the machine gets overheated, it releases smoke, 
makes strange noises, or generates an odd odor, 
immediately turn off the power switch and unplug the 
machine. 
•The user should be able to access the power outlet 
in case of emergencies that might require the user to 
pull the plug out. 

► This could result in electric shock or fire. 

Do not forcefully pull the paper out during printing. 

► It can cause damage to the machine.

When printing large quantities, the bottom part of the 
paper output area may get hot. Do not allow children 
to touch. 

► Burns can occur.

Be careful not to put your hand between the machine 
and paper tray.

► You may get injured.

When removing jammed paper, do not use tweezers 
or sharp metal objects. 

► It can damage the machine.

Do not block or push objects into the ventilation opening.

► This could result in elevated component temperatures which 
can cause damage or fire.

Do not allow too many papers to stack up in the paper output 
tray.

► It can damage the machine. 
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Installation / Moving

 Warning

Do not place the machine in an area with dust, 
humidity or water leaks. 

► This could result in electric shock or fire. 

 Caution

Before moving the machine, turn the power off and 
disconnect all cords.
Then lift the machine:
• If the machine weighs under 20 kg (44.09lbs), lift 
with 1 person.
• If the machine weighs 20 kg (44.09lbs) - 40kg 
(88.18lbslbs), lift with 2 people.
• If the machine weighs more than 40 kg (88.18lbs), 
lift with 4 or more people.

► The machine could fall, causing injury or machine damage.

Do not put a cover over the machine or place it in an airtight 
location, such as a closet.

► If the machine is not well-ventilated, this could result in fire.

Choose a flat surface with enough space for 
ventilation to place the machine. Also consider the 
space required to open the cover and trays. 
The place should be well-ventilated and be far from 
direct light, heat, and humidity. 

When using the machine for a long period of time or 
printing a large number of pages in a non-ventilated 
space, it could pollute the air and be harmful to your 
health. Place the machine  in a well-ventilated space 
or open a window to circulate the air periodically.

Do not place the machine on an unstable surface.

► The machine could fall, causing injury or machine damage.

Make sure you plug the power cord into a grounded electrical 
outlet.

► Otherwise, this could result in electric shock or fire.

The machine should be connected to 
the power level which is specified on the label.

► If you are unsure and want to check the power level you are 
using, contact the electrical utility company.

Do not overload wall outlets and extension cords.

► This can diminish performance, and could result in electric 
shock or fire.

Use only No.26 AWGa

a.  AWG: American Wire Gauge

 or larger, telephone line cord, if 
necessary.

► Otherwise, it can cause damage to the machine.

Use the power cord supplied with your machine for safe 
operation. If you are using a cord which is longer than 2 meters 
(6 feet) with a 140V machine, then the gauge should be 16 
AWG or larger.

►  Otherwise, it can cause damage to the machine, and could 
result in electric shock or fire.

Be care when replacing paper or removing jammed paper. 

► New paper has sharp edges and can cause painful cuts.

This machine's power interception device is the power cord. 

► To switch off the power supply, remove the power cord from 
the electrical outlet. 
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Maintenance / Checking

 Caution

Unplug this product from the wall outlet before 
cleaning the inside of the machine. Do not clean the 
machine with benzene, paint thinner or alcohol; do 
not spray water directly into the machine. 

► This could result in electric shock or fire. 

Keep cleaning supplies away from children. 

► Children could get hurt.

When you are working inside the machine replacing 
supplies or cleaning the inside, do not operate the 
machine.

► You could get injured.

Do not disassemble, repair or rebuild the machine by 
yourself. 

► It can damage the machine. Call a certified 
technician when the machine needs repair.

Keep the power cable and the contact surface of the plug clean 
from dust or water.

► Otherwise, this could result in electric shock or fire. 

To clean and operate the machine, strictly follow the user's 
guide provided with the machine.

► Otherwise, you could damage the machine.

• Do not remove any covers or guards that are fastened with 
screws. 
• Fuser units should only be repaired by a certified service 
technician. Repair by non-certified technicians could result in 
fire or electric shock.

► The machine should only be repaired by a Samsung service 
technician.

Supply usage

 Caution

Do not disassemble the toner cartridge.

► Toner dust can be dangerous if inhaled or 
ingested.

When storing supplies such as toner cartridges, keep 
them away from children.

► Toner dust can be dangerous if inhaled or 
ingested.

Do not burn any of the supplies such as toner 
cartridge or fuser unit.

► This could cause an explosion or uncontrollable 
fire.

Using recycled supplies, such as toner, can cause damage to 
the machine.

► In case of damage due to the use of recycled supplies, a 
service fee will be charged.
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For supplies that contain toner dust (toner cartridge, waste 
toner bottle, imaging unit, etc.) follow the instructions below.

• When disposing of the supplies, follow the instructions for 
disposal. Refer to the reseller for disposal instructions.

• Do not wash the supplies.
• For a waste toner bottle, do not reuse it after emptying the bottle.

► If you do not follow the instructions above, it may cause 
machine malfunction and environmental pollution.  The 
warranty does not cover damages caused by a user's 
carelessness.

When changing the toner cartridge or removing jammed paper, 
be careful not to let toner dust touch your body or clothes.

► Toner dust can be dangerous if inhaled or ingested.

When toner gets on your clothing, do not use hot water to wash 
it. 

► Hot water sets toner into fabric. Use cold water. 
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regulatory information
This machine is designed for our sound environment and certified with several regulatory statements.

LASER SAFETY STATEMENT

The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR, chapter 1 Subchapter J for Class I(1) laser products, and 
elsewhere is certified as a Class I laser product conforming to the requirements of IEC 60825-1:1993 + A1:1997 + A2:2001.
Class I laser products are not considered to be hazardous. The laser system and printer are designed so there is never any human access to 
laser radiation above a Class I level during normal operation, user maintenance or prescribed service condition.
ML-551x Series
• Wavelength: 800 nm
• Beam divergence

- Paraller: 12 degrees
- Perpendicular: 35 degrees

• Maximum power or energy output: 15 mW
ML-651x Series
• Wavelength: 800 nm
• Beam divergence

- Paraller: 12 degrees
- Perpendicular: 35 degrees

• Maximum power or energy output: 10 mW

WARNING 
Never operate or service the printer with the protective cover removed from Laser/Scanner assembly. The reflected beam, although invisible, 
can damage your eyes.
When using this product, these basic safety precautions should always be followed to reduce risk of fire, electric shock, and injury to persons:
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OZONE SAFETY

During normal operation, this machine produces ozone. The ozone produced does not present a hazard to the operator. However, it is advis-
able that the machine be operated in a well ventilated area.
If you need additional information about ozone, request your nearest Samsung dealer.

MERCURY SAFETY

Contains Mercury, Dispose According to Local, State or Federal Laws.(U.S.A. only)

POWER SAVER

This printer contains advanced energy conservation technology that reduces power consumption when it is not in active use.
When the printer does not receive data for an extended period of time, power consumption is automatically lowered. 
ENERGY STAR and the ENERGY STAR mark are registered U.S. marks. 
For more information on the ENERGY STAR program see http://www.energystar.gov

RECYCLING

Recycle or dispose of the packaging material for this product in an environmentally responsible manner.
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CHINA ONLY
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CORRECT DISPOSAL OF THIS PRODUCT (WASTE ELECTRICAL & ELECTRONIC EQUIPMENT)

(Applicable in the with separate collection systems)

This marking on the product, accessories or literature indicates that the product and its electronic accessories (e.g. charger, headset, USB 
cable) should not be disposed of with other household waste at the end of their working life. To prevent possible harm to the environment or 
human health from uncontrolled waste disposal, please separate these items from other types of waste and recycle them responsibly to pro-
mote the sustainable reuse of material resources.
Household users should contact either the retailer where they purchased this product, or their local government office, for details of where and 
how they can take these items for environmentally safe recycling.
Business users should contact their supplier and check the terms and conditions of the purchase contract. This product and its electronic 
accessories should not be mixed with other commercial wastes for disposal.

CORRECT DISPOSAL OF BATTERIES IN THIS PRODUCT

(Applicable in the European Union and other European countries with separate battery return systems.)

This marking on the battery, manual or packaging indicates that the batteries in this product should not be disposed with other household 
waste at the end of their working life. Where marked, the chemical symbols Hg, Cd or Pb indicate that the battery contains mercury, cadmium 
or lead above the reference levels in EC Directive 2006/66. If batteries are not properly disposed of, these substances can cause harm to 
human health or the environment. To protect natural resources and to promote material reuse, please separate batteries from other types of 
waste and recycle them through your local, free battery return system.
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STATE OF CALIFORNIA PROPOSITION 65 WARNING (US ONLY)

RADIO FREQUENCY EMISSIONS

FCC Information to the User
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 
• This device may not cause harmful interference, and
• This device must accept any interference received, including interference that may cause undesired operation.
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These 
limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses 
and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to 
radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to 
try to correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or experienced radio TV technician for help.

 

Change or modifications not expressly approved by the manufacturer responsible for compliance could void the user's authority to oper-
ate the equipment.

Canadian Radio Interference Regulations
This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus as set out in the interference-causing 
equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry and Science Canada.
Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils numériques de Classe A prescrites dans la 
norme sur le matériel brouilleur: “Appareils Numériques”, ICES-003 édictée par l’Industrie et Sciences Canada.
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UNITED STATES OF AMERICA

Federal Communications Commission (FCC)

Intentional emitter per FCC Part 15
Low power, Radio LAN type devices (radio frequency (RF) wireless communication devices), operating in the 2.4 GHz/5 GHz Band, may be 
present (embedded) in your printer system. This section is only applicable if these devices are present. Refer to the system label to verify the 
presence of wireless devices.
Wireless devices that may be in your system are only qualified for use in the United States of America if an FCC ID number is on the system 
label.
The FCC has set a general guideline of 20 cm (8 inches) separation between the device and the body, for use of a wireless device near the 
body (this does not include extremities). This device should be used more than 20 cm (8 inches) from the body when wireless devices are on. 
The power output of the wireless device (or devices), which may be embedded in your printer, is well below the RF exposure limits as set by 
the FCC.
This transmitter must not be collocated or operation in conjunction with any other antenna or transmitter.
Operation of this device is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired operation of the device.

 

Wireless devices are not user serviceable. Do not modify them in any way. Modification to a wireless device will void the authorization to 
use it. Contact manufacturer for service.

FCC Statement for Wireless LAN use:

 

While installing and operating this transmitter and antenna combination the radio frequency exposure limit of 1m W/cm2 may be 
exceeded at distances close to the antenna installed. Therefore, the user must maintain a minimum distance of 20cm from the antenna at 
all times. This device cannot be colocated with another transmitter and transmitting antenna.

RUSSIA ONLY

GERMANY ONLY

ISRAEL ONLY
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TURKISH ONLY

REPLACING THE FITTED PLUG (FOR UK ONLY)

Important
The mains lead for this machine is fitted with a standard (BS 1363) 13 amp plug and has a 13 amp fuse. When you change or examine the 
fuse, you must re-fit the correct 13 amp fuse. You then need to replace the fuse cover. If you have lost the fuse cover, do not use the plug until 
you have another fuse cover. 
Contact the people from you purchased the machine.
The 13 amp plug is the most widely used type in the UK and should be suitable. However, some buildings (mainly old ones) do not have normal 
13 amp plug sockets. You need to buy a suitable plug adaptor. Do not remove the moulded plug.

 

If you cut off the moulded plug, get rid of it straight away.

You cannot rewire the plug and you may receive an electric shock if you plug it into a socket.

Important warning: 

You must earth this machine.
The wires in the mains lead have the following color code:
• Green and Yellow: Earth
• Blue: Neutral
• Brown: Live

If the wires in the mains lead do not match the colors marked in your plug, do the following:
You must connect the green and yellow wire to the pin marked by the letter “E” or by the safety ‘Earth symbol’ or colored green and yellow or 
green.
You must connect the blue wire to the pin which is marked with the letter “N” or colored black.
You must connect the brown wire to the pin which is marked with the letter “L” or colored red.
You must have a 13 amp fuse in the plug, adaptor, or at the distribution board.

DECLARATION OF CONFORMITY (EUROPEAN COUNTRIES)

Approvals and Certifications

The CE marking applied to this product symbolizes Samsung Electronics Co., Ltd. Declaration of Conformity with the following applicable 
93/68/EEC Directives of the European Union as of the dates indicated:

Hereby, Samsung Electronics declare that this product is in compliance with the essential requirements and other relevant provisions of:
ML-551x Series, ML-651x Series: R&TTE Directive (1999/5/EC)
The declaration of conformity may be consulted at www.samsung.com/printer, go to Support > Download center and enter your printer (MFP) 
name to browse the EuDoC. 
January 1, 1995: Council Directive 2006/95/EC Approximation of the laws of the member states related to low voltage equipment.
January 1, 1996: Council Directive 2004/108/EC (92/31/EEC), approximation of the laws of the Member States related to electromagnetic 
compatibility.
March 9, 1999: Council Directive 1999/5/EC on radio equipment and telecommunications terminal equipment and the mutual recognition of 
their conformity. A full declaration, defining the relevant Directives and referenced standards can be obtained from your Samsung Electronics 
Co., Ltd. representative.
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European Radio Approval Information (for products fitted with EU-approved radio devices)
Low power, Radio LAN type devices (radio frequency (RF) wireless communication devices), operating in the 2.4 GHz/5 GHz band, may be 
present (embedded) in your printer system, which is intended for home or office use. This section is only applicable if these devices are pres-
ent. Refer to the system label to verify the presence of wireless devices.
Wireless devices that may be in your system are only qualified for use in the European Union or associated areas if a CE mark 

with  a Notified Body Registration Number and the Alert Symbol is on the system label.
The power output of the wireless device or devices that may be embedded in you printer is well below the RF exposure limits as set by the 
European Commission through the R&TTE directive.

European States qualified under wireless approvals:
EU
Austria, Belgium, Cyprus, Czech Republic, Denmark, Estonia, Finland, France (with frequency restrictions), Germany, Greece, Hungary, Ire-
land, Italy, Latvia, Lithuania, Luxembourg, Malta, The Netherlands, Poland, Portugal, Slovakia, Slovenia, Spain, Sweden and the U.K.
EEA/EFTA countries
Iceland, Liechtenstein, Norway and Switzerland

European States with restrictions on use:
• EU: In France, the frequency range is restricted to 2446.5-2483.5 MHz for devices above 10 mW transmitting power such as wireless
• EEA/EFTA countries: No limitations at this time

REGULATORY COMPLIANCE STATEMENTS

Wireless Guidance
Low power, Radio LAN type devices (radio frequency (RF) wireless communication devices), operating in the 2.4 GHz/5 GHz Band, may be 
present (embedded) in your printer system. The following section is a general overview of considerations while operating a wireless device.
Additional limitations, cautions, and concerns for specific countries are listed in the specific country sections (or country group sections). The 
wireless devices in your system are only qualified for use in the countries identified by the Radio Approval Marks on the system rating label. If 
the country you will be using the wireless device in, is not listed, contact your local Radio Approval agency for requirements. Wireless devices 
are closely regulated and use may not be allowed.
The power output of the wireless device or devices that may be embedded in your printer is well below the RF exposure limits as known at this 
time. Because the wireless devices (which may be embedded into your printer) emit less energy than is allowed in radio frequency safety stan-
dards and recommendations, manufacturer believes these devices are safe for use. Regardless of the power levels, care should be taken to 
minimize human contact during normal operation.
As a general guideline, a separation of 20 cm (8 inches) between the wireless device and the body, for use of a wireless device near the body 
(this does not include extremities) is typical. This device should be used more than 20 cm (8 inches) from the body when wireless devices are 
on and transmitting.
This transmitter must not be collocated or operation in conjunction with any other antenna or transmitter.
Some circumstances require restrictions on wireless devices. Examples of common restrictions are listed below:

Radio frequency wireless communication can interfere with equipment on commercial aircraft. Current aviation regulations require wireless 
devices to be turned off while traveling in an airplane. IEEE 802.11 (also known as wireless Ethernet) and Bluetooth communication devices 
are examples of devices that provide wireless communication.

In environments where the risk of interference to other devices or services is harmful or perceived as harmful, the option to use a wireless 
device may be restricted or eliminated. Airports, Hospitals, and Oxygen or flammable gas laden atmospheres are limited examples where use 
of wireless devices may be restricted or eliminated. When in environments where you are uncertain of the sanction to use wireless devices, 
ask the applicable authority for authorization prior to use or turning on the wireless device.

Every country has different restrictions on the use of wireless devices. Since your system is equipped with a wireless device, when traveling 
between countries with your system, check with the local Radio Approval authorities prior to any move or trip for any restrictions on the use of 
a wireless device in the destination country.

If your system came equipped with an internal embedded wireless device, do not operate the wireless device unless all covers and shields are 
in place and the system is fully assembled.

Wireless devices are not user serviceable. Do not modify them in any way. Modification to a wireless device will void the authorization to use it. 
Contact manufacturer for service.

Only use drivers approved for the country in which the device will be used. See the manufacturer System Restoration Kit, or contact manufac-
turer Technical Support for additional information.
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OPENSSL LICENSE

Copyright (c) 1998-2001 The OpenSSL Project. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documen-

tation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgment: "This product includes 

software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)"
4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without
5. Prior written permission. For written permission, please contact openssl-core@openssl.org.
6. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written permis-

sion of the OpenSSL Project.
7. Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes software developed by the 

OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)"
THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DIS-
CLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDEN-
TAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THE-
ORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
This product includes cryptographic software written by Eric Young(eay@cryptsoft.com). This product includes software written by Tim Hudson 
(tjh@cryptsoft.com).

ORIGINAL SSLEAY LICENSE

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.
This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation was written so as to conform with 
Netscapes SSL.
This library is free for commercial and non-commercial use as long as the following conditions are aheared to. The following conditions apply to 
all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this 
distribution is covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com). Copyright remains Eric Young's, 
and as such any Copyright notices in the code are not to be removed. If this package is used in a product, Eric Young should be given attribu-
tion as the author of the parts of the library used. This can be in the form of a textual message at program startup or in documentation (online 
or textual) provided with the package.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documen-

tation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgement: "This product includes 

cryptographic software written by Eric Young (eay@cryptsoft.com)" The word 'cryptographic' can be left out if the routines from the library 
being used are not cryptographic related:-).

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must include an acknowl-
edgement: "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIM-
ITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN 
NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, 
OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF 
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
The licence and distribution terms for any publicly available version or derivative of this code cannot be changed. i.e. this code cannot simply 
be copied and put under another distribution licence [including the GNU Public Licence.
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about this user’s guide
This user’s guide provides information about how to use the machine. Both novice and professional users can refer to this 
as a guide for installing and using the machine.

 

• Read the safety information before using the machine.
• If you have a problem using the machine, refer to the troubleshooting chapter in the User’s Guide (See "Troubleshooting" on page 76).
• Terms used in this user’s guide are explained in the glossary chapter (See "Glossary" on page 122).
• All illustrations in this user’s guide may differ from your machine depending on its options or models.
• The procedures in this user’s guide are mainly based on Windows XP.

CONVENTION

Some terms in this guide are used interchangeably, as below:
• Document is synonymous with original.
• Paper is synonymous with media, or print media.
• Machine refers to printer or MFP.
The following table offers the conventions of this guide:

CONVENTION DESCRIPTION EXAMPLE

Bold For texts on the display or button names on the machine. Start

Note Provides additional information or detailed specification of the machine function 
and feature.  

The date format may differ from country 
to country.

Caution Gives users information to protect the machine from possible mechanical dam-
age or malfunction.  

Do not touch the green surface of the 
imaging unit. 

Footnote Provides additional more detailed information on certain words or a phrase. a. pages per minute

(“Cross-reference”) Guides users to a reference page for the additional detailed information. (See “Finding more information”)
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FINDING MORE INFORMATION

You can find information for setting up and using your machine from the following resources, either as a print-out or on screen.

MATERIAL NAME DESCRIPTION

Quick Installation 
Guide

This guide provides basic information on setting up your machine.

User’s Guide This guide provides you with step-by-step instructions for using your machine’s full features, and contains information for maintaining 
your machine, troubleshooting and replacing supplies. 

Driver Help This help provides you with help information on printer driver and instructions for setting up the options for printing (See "Using help" on 
page 53).

Samsung website If you have Internet access, you can get help, support, machine drivers, manuals, and order information from the Samsung website, 
www.samsung.com/printer.

Downloadable soft-
ware

You can download useful software from the Samsung website. 
• SyncThru™ Web Admin Service: convenient for network administrators who need to manage many machines simultaneously. 

This program is for network model only. (http://solution.samsungprinter.com)
• Samsung AnyWeb Print: helps personal users to screen-capture the website screen in Windows Internet Explorer easily. 

(http://solution.samsungprinter.com/personal/anywebprint)
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features of your new product
Your new machine is equipped with a number of special features that improve the quality of the documents you print.

SPECIAL FEATURES

Print with excellent quality and speed

• You can print with a resolution of up to 1,200 x 1,200 dpi 
effective output.

Print in various environments

• You can print with various operating system such as Win-
dows, Linux, Mac, and UNIX (See "System requirements" on 
• ML-551x Series prints A4-sized paper at up to 52 ppm, and 
letter-sized paper at up to 55 ppm. 

• ML-651x Series prints A4-sized paper at up to 62 ppm, and 
letter-sized paper at up to 65 ppm. 

Handle many different types of printable material

• The multi-purpose tray supports special types of print media 
in various sizes.

• The tray 1 and optional trays support plain paper in various 
sizes (See "Print media specifications" on page 110).

Create professional documents (Windows only)

• Print Watermarks. You can customize your documents with 
words, such as “Confidential” (See "Using watermarks" on 
page 55).

• Print Posters. The text and pictures of each page of your 
document are magnified and printed across the sheet of 
paper and can then be taped together to form a poster (See 
"Printing posters" on page 53).

• You can use preprinted forms with plain paper (See"Using 
overlay (PCL driver only)" on page 55).

Save time and money

• To save paper, you can print multiple pages on one single 
sheet of paper (See "Printing multiple pages on one sheet of 
paper" on page 53).

• This machine automatically conserves electricity by substan-
tially reducing power consumption when not in use.

• To save paper, you can print on both sides of the paper (dou-
ble-sided printing). For some models, you need to install an 
optional duplex unit to use the duplex feature (See "Printing 
on both sides of paper" on page 54).

Expand your machine’s capacity

• Your machine has an extra memory slot to expand the mem-
ory (See "Available accessories" on page 97).
Features of your new product_
page 31).
• Your machine is equipped with a USB, Parallel (optional), 

and a network interface.

Use USB flash memory devices

If you have a USB memory device, you can use it in various 
ways with your machine.
• You can directly print data stored in the device.

Eco Print

You can reduce toner and paper usage (See "Introducing the 
useful buttons" on page 29).
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FEATURES BY MODELS

Some features and optional goods may not be available depending on models or countries.
Features by models include:

FEATURES ML-5510N SERIES
ML-5510ND SERIES 
ML-5512ND SERIES
ML-5515ND SERIES

ML-6510ND SERIES 
ML-6512ND SERIES 
ML-6515ND SERIES 

USB 2.0 ● ● ●

USB Memory Interface ● ● ●

Network Interface Ethernet 10/100/1000 BaseTX wired LAN ● ● ●

Duplex Unit ○ ● ●

Hard Disk Drive (HDD) ○ ○ ○

IEEE 1284 parallel connectora

a.If you use the parallel port, you cannot use the USB cable.

○ ○ ○

Mulitbin Mailbox ○ ○ ○

Finisher (Stacker & Stapler) ○ ○ ○

Short Stand ○ ○ ○

Optional Trays ○ ○ ○

High Capacity Feeder (HCF) ○ ○ ○

Memory ○ ○ ○

IEEE 802.11 b/g/n Wireless LANb

b.Depending on your country, wireless LAN cards may not be available. Contact your local Samsung dealer or the retailer where you bought your machine.

○ ○ ○

(●: Included, ○: Optional, Blank: Not available) 
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1.introduction
This chapter gives you an overview of your machine:

This chapter includes:

• Machine overview
• Control panel overview
• Understanding the control panel
• Introducing the useful buttons
  

MACHINE OVERVIEW

Front view

7

10

11

4

5

6

9

12

14

13

8

2

15
16

18

17

1

3

 

1 Finishera(Stacker & Stapler)
 

7 High capacity feeder (HCF)a

 

2 Mailboxa
 

8 Paper level indicator
 

3 Stapler covera
 

9 Optional traya

 

4 Control board cover
 

10 Tray1
 

5 Filter cover
 

11 Multi-purpose tray cover
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Rear view

6

7

8

9

10

4

5

1

2

3

11

 

1 Finisher covera

a.Optional device

 (Stacker & Stapler)
 

7 Power switch
 

2 Rear cover
 

8 Network port
 

3 Mailbox covera
 

9 USB port and IEEE 1284 parallel connectora

 

4 Waste toner bottle cover
 

10 IEEE 802.11 b/g/n Wireless LANa

 

5 Duplex unitb

b.Optional for some models. 

 

11 USB memory port
 

6 Power receptacle

 

6 Short standa
 

12 USB memory port
 

13 Control panel
 

18 Muti-purpose tray extension
 

14 Top cover
 

15 Toner cartridge
 

16 Imaging unit
 

17
Multi-purpose tray paper 
width guides

a.Optional device
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CONTROL PANEL OVERVIEW
1 2

8 103

4

5

6 7 9
 

1 Display screen Shows the current status and prompts during an operation.

 

2 Menu
Enters Menu mode and scrolls through the available menus (See "Machine status and advanced features" on 
page 64).

 

3 Back Sends you back to the upper menu level.

 

4 Arrow Scroll through the options available in the selected menu, and increase or decrease values.

 

5 OK Confirms the selection on the screen.

 

6 Numeric keypad Use the keypad to enter numbers and characters. It is useful for entering IP addresses.

 

7 Eco Turns the Eco mode on or off (See "Eco button" on page 29).

 

8 Stop/Clear button Stops an operation at any time. The pop-up window appears on the screen showing the current job that the 
user can stop or resume.

 

9 Power button
Turns the machine on or off. (See "Power button" on page 29).

 

10 Status LED Shows the status of your machine (See "Understanding the control panel" on page 29).
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UNDERSTANDING THE CONTROL PANEL

Status LEDs
The color of the LEDs indicates the machine's current status.

LED STATUS DESCRIPTION

Off The machine is off-line.

Blinks 
green

• The machine is warming up.
• The machine is receiving data from a 

computer.
• The machine is printing data.

Solid green The machine is online and can receive data 
from a computer.

Solid red • The cover is open. Close the cover.
• There is no paper in the tray. Load paper 

in the tray.
• The machine has stopped due to a major 

error.
• The machine is experiencing system 

problems requiring service, such as LSU 
error, fuser error, or ITB error. Contact 
the service representative.

• A toner cartridge has almost reached its 
estimated cartridge lifea

a.Estimated cartridge life means the expected or estimated toner car-
tridge life, which indicates the average capacity of print-outs and is de-
signed pursuant to ISO/IEC 19752. The number of pages may be 
affected by operating environment, printing interval, graphics, media 
type and media size. Some amount of toner may remain in the car-
tridge even when red LED is on and the printer stops printing.

. It is recom-
mended to replace the toner cartridge 
(See "Replacing the toner cartridge" on 
page 98).

• The machine cannot recognize the sta-
tus of toner cartridges and the supplies 
information. Open and close the cover 
and check if the machine can operate 
properly. If the problem persists, turn the 
power off and on.

Blinks red • A minor error has occurred and the 
machine is waiting for the error to be 
cleared. When the problem is cleared, 
the machine resumes.

• A small amount of toner is left in the car-
tridge. The estimated cartridge lifea of 
toner is close. Prepare a new cartridge 
for replacement. You may temporarily 
increase the printing quality by redistrib-
uting the toner in the cartridge 
(See "Redistributing toner" on page 76).

Lights 
orange

A paper jam has occurred (See "Clearing 
paper jams" on page 77).

 

Samsung does not recommend using non-genuine Samsung toner 
cartridge such as one that is refilled or remanufactured. Samsung can-
not guarantee a non-genuine Samsung toner cartridge's quality. Ser-
vice or repair required as a result of using non-genuine Samsung 
toner cartridges will not be covered under the machine warranty. 

 

All printing errors will be appear in the Smart Panel program window. If 
the problem persists, call for service (See "Using the Smart Panel pro-
gram" on page 69).

INTRODUCING THE USEFUL BUTTONS

Menu button 

When you want to know the machine status and set your machine to use an 
advanced feature, press the Menu button (See "Machine status and 
advanced features" on page 64).

Eco button
You can turn the Eco mode on or off by simply pressing the button. You can 
set the Eco mode settings from the SyncThru™ Web Service (see "Eco" on 
page 69). 

1. Press the Eco button on the control panel.
2. The LED on the button lights on. Then, Eco mode is on.
To turn off Eco mode, press Eco button one more time.

Stop/Clear button 

By pressing the , you can: 

FUNCTION DESCRIPTION

Cancel print job
Press  during printing.

Power button 

When you want to turn the power on/off, press this button Power Down win-
dow pops up. Choose Yes, to turn the power off. This button can also be 
used to turn the machine on.
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2.getting started
This chapter gives you step-by-step instructions for setting up the USB connected machine and software.

This chapter includes:

• Setting up the hardware
• Printing a demo page
• Supplied software

• System requirements
• Installing locally connected machine’s driver

  

 

Supported optional devices and features may differ according to your 
model. Please check your model name (See "Features by Models" on 
page 25).

SETTING UP THE HARDWARE

This section shows the steps to set up the hardware, as is explained in the 
Quick Installation Guide. Make sure you read the Quick Installation Guide 
first and follow the steps below:

1. Select a stable location.
Select a level, stable place with adequate space for air circulation. Allow 
extra space to open covers and trays. 
The area should be well ventilated and away from direct sunlight or 
sources of heat, cold, and humidity. Do not set the machine close to the 
edge of your desk or table.

Printing is suitable for altitudes under 1,000 m (3,281 ft.). Refer to the 
altitude setting to optimize your printing (See "Altitude adjustment" on 
page 42).
Place the machine on a flat, stable surface so that there is no incline 
greater than 2 cm (0.79 inch). Otherwise, printing quality may be 
affected.

2cm
(0.79 in)

2cm
(0.79 in)

2. Unpack the machine and check all the enclosed items.
3. Remove the tape.
4. Install all the necessary items such as toner cartridge and optional 

goods. (See "Supplies and accessories" on page 97).
5. Load paper (See "Loading paper in tray" on page 46).
6. Make sure that all cables are connected to the machine. 
7. Turn the machine on.

 

• This equipment will be inoperable when mains power fails.
• When you move the machine, do not tilt or turn it upside down. 

Otherwise, the inside of the machine may be contaminated by 
toner, which can cause damage to the machine or bad printing 
quality.

PRINTING A DEMO PAGE

Print a demo page to make sure that the machine is operating properly.

1. Press Menu on the control panel.
2. Press the up/down arrow to highlight Information and press OK.
3. Press the up/down arrow to highlight Demo Page appears and press 

OK.
4. When Print? appears, press OK.

The machine starts to print a demo page.

SUPPLIED SOFTWARE

After you have set up your machine and connected it to your computer, you 
must install the printer software. If you are a Windows or Mac OS, install the 
software from the supplied CD and if you are a Linux or a UNIX OS user, 
download the software from the Samsung website (www.sam-
sung.com/printer) and install.

 

Machine software are occasionally updated due to release of new 
operating system and etc. If needed, download the latest version from 
the Samsung website. (www.samsung.com/printer)
Getting started_ 30

www.samsung.com/printer


OS CONTENTS

Windows • Printer driver: Use this driver to take full advantage of 
your machine’s features.

• PostScript Printer Driver: Use the PostScript driver 
to print documents with complex fonts and graphics in 
the PS language. (PostScript printer description file is 
included.)

• Smart Panel: This program allows you to monitor the 
machine’s status and alerts you when an error occurs 
during printing.

• Printer Settings Utility: This program allows you to 
set up printer’s other options from your computer desk-
top.

• Direct Printing Utility: This program allows you to 
print PDF files directly.

• SetIP: Use this program to set your machine’s TCP/IP 
addresses.

• XPS printer driver: Use to print documents in XPS 
print path. XPS printer driver can be installed only on 
Windows Vista or higher.

Mac • Printer driver: Use this driver to run your machine 
from a Mac computer and print documents. (PostScript 
printer description file is included.)

• Smart Panel: This program allows you to monitor the 
machine’s status.

• Printer Settings Utility: This program allows you to 
set up printer’s other options from your computer desk-
top.

• SetIP: Use this program to set your machine’s TCP/IP 
addresses.

Linux • Unified Linux Driver: Use this driver to take full 
advantage of your machine’s features.

• PostScript Printer Driver: Use this driver to run your 
machine from a Linux computer and print documents. 
(PostScript printer description file is included.)

• Smart Panel: This program allows you to monitor the 
machine’s status.

• Printer Settings Utility: This program allows you to 
set up printer’s other options from your computer desk-
top.

• SetIP: Use this program to set your machine’s TCP/IP 
addresses.

Unix • UNIX Printer driver:  Use this driver to take full 
advantage of your machine's feature.

SYSTEM REQUIREMENTS

Before you begin, ensure that your system meets the following require-
ments:

Microsoft® Windows®

Your machine supports the following Windows operating systems.

OPERATING 
SYSTEM

REQUIREMENT (RECOMMENDED)

CPU RAM FREE HDD 
SPACE

Windows 2000® Intel® Pentium® II 400 
MHz (Pentium III 933 
MHz)

64 MB 
(128 MB)

600 MB

Windows XP® Intel® Pentium® III 933 
MHz (Pentium IV 1 GHz)

128 MB 
(256 MB)

1.5 GB

Windows 
Server® 2003

Intel® Pentium® III 933 
MHz (Pentium IV 1 GHz)

128 MB 
(512 MB)

1.25 GB to 
2 GB

Windows 
Server® 2008

Intel® Pentium® IV 1 GHz 
(Pentium IV 2 GHz)

512 MB 
(2048 MB)

10 GB

Windows Vista® Intel® Pentium® IV 3 GHz 512 MB 
(1024 MB)

15 GB

Windows® 7 Intel® Pentium® IV 1 GHz 
32-bit or 64-bit processor 
or higher

1 GB (2 
GB)

16 GB

• Support for DirectX® 9 graphics with 128 MB memory 
(to enable the Aero theme).

• DVD-R/W Drive

Windows 
Server® 2008 R2

Intel® Pentium® IV 1 GHz 
(x86) or 1.4 GHz (x64) 
processors (2 GHz or 
faster)

512 MB 
(2048 MB)

10 GB

 

• Internet Explorer® 6.0 or higher is the minimum requirement for all 
Windows operating systems.

• Administrator rights are required to install the software.
• Windows Terminal Services is compatible with this machine.
• For Windows 2000, Services Pack 4 or higher is required. 

Mac

OPERAT-
ING SYS-

TEM

REQUIREMENTS (RECOMMENDED)

CPU RAM FREE HDD 
SPACE

Mac OS X 
10.3 ~ 10.4

• Intel® Proces-
sors

• PowerPC G4/ 
G5

• 128 MB for a 
PowerPC based 
Mac (512 MB)

• 512 MB for a 
Intel-based Mac 
(1 GB)

1 GB
Getting started_ 31



Linux

ITEM REQUIREMENT (RECOMMENDED)

Operating sys-
tem

RedHat® Enterprise Linux WS 4, 5 (32/64 bit)
Fedora 4, 5, 6, 7, 8, 9, 10, 11, 12 (32/64bit)
SuSE Linux 10.0, 10.1 (32bit)
OpenSuSE 10.2, 10.3, 11.0, 11.1, 11.2 (32/64bit)
Mandriva 2005, 2006, 2007, 2008, 2009, 2009.1 
(32/64bit)
Ubuntu 5.04, 5.10, 6.06, 6.10, 7.04, 7.10, 8.04, 8.10, 
9.04, 9.10 (32/64bit)
SuSE Linux Enterprise Desktop 10, 11 (32/64bit)
Debian 4.0, 5.0 (32/64bit)

CPU Pentium® IV 2.4 GHz (Intel Core™2)

RAM 512 MB (1024 MB)

Free HDD space 1 GB (2 GB)

UNIX

ITEM REQUIREMENTS

Operating sys-
tem

Sun Solaris 9,10 (x86, SPARC) 
IBM AIX 5.1, 5.2, 5.3, 5.4
HP-UX 11i v1, 11i v2, 11i v3 (PA-RISC, Itanium)

Free HDD space Up to 100 MB

INSTALLING LOCALLY CONNECTED 
MACHINE’S DRIVER

 

Only use an USB cable no longer then 3 m (10 ft.).

Windows
You can install the machine software using the typical or custom method.
The following steps below are recommended for most users who use a 
machine directly connected to your computer. All components necessary for 
machine operations will be installed.

1. Make sure that the machine is connected locally and powered on.
2. Insert the supplied software CD into your CD-ROM drive.

If the installation window does not appear, click Start > All programs > 
Accessories > Run.
X:\Setup.exe replacing “X” with the letter, which represents your 
CD-ROM drive and click OK.

3. Review and accept the installation agreements in the installation win-
dow. Then, click Next.

4. Select USB connection on the Printer Connection Type screen. 
Then, click Next.

5. Follow the instructions in the installation window.

 

You can select the software applications in the Select Software to 
Install Window.

 

If the printer driver does not work properly, follow the steps below to 
uninstall and reinstall the driver.

a) Make sure that the machine is connected to your computer and 
powered on.

b) From the Start menu, select Programs or All Programs > Sam-
sung Printers > Uninstall Samsung Printer Software.

c) Select the necessary option and follow the instructions in the win-
dow.

d) After uninstalling the printer driver, reinstall it (see "Installing 
locally connected machine’s driver" on page 32, "Installing network 
connected machine’s driver" on page 38).

Silent installation Mode (Windows only)
Silent installation mode is an installation method that does not require 
any user intervention. Once you start the installation, the machine driver 
and software are automatically installed on you computer. You can start 
the silent installation by typing /s or /S in the command window.

Command-line Parameters
Following table shows commands that can be used in the command win-
dow.

 

Following command-line are effective and operated when com-
mand is used with /s or /S. But /h, /H or /? are exceptional com-
mands that can be operated solely.

Mac OS X 
10.5

• Intel® Proces-
sors

• 867 MHz or 
faster Power 
PC G4/ G5

512 MB (1 GB) 1 GB

Mac OS X 
10.6 ~10.8

• Intel® Proces-
sors

1 GB (2 GB) 1 GB

OPERAT-
ING SYS-

TEM

REQUIREMENTS (RECOMMENDED)

CPU RAM FREE HDD 
SPACE
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COMMAND- 
LINE DEFINITION DESCRIPTION

/s or
/S

Starts silent installation. Installs machine drivers 
without prompting any 
UIs or user intervention.

/p”<port name>” 
or
/P”<port name>”

Specifies printer port.

 

Network Port will 
be created by use 
of Standard 
TCP/IP Port moni-
tor. For local port, 
this port must 
exist on system 
before being spec-
ified by command.

Printer port name can be 
specified as IP address, 
hostname, USB local port 
name, IEEE1284 port 
name or network path.
For example:
•  /p”xxx.xxx.xxx.xxx” in 

where, 
“xxx.xxx.xxx.xxx” 
means IP address for 
network printer. 
/p”USB001”, 
/P”LPT1:”, /p”host-
name”

• /p"\\computer_name\sha
red_printer" or 
"\\xxx.xxx.xxx.xxx\sha
red_printer" in where,  
"\\computer_name\sh
ared_printer" or 
"\\xxx.xxx.xxx.xxx\sha
red_printer" means 
the network path to 
the printer by enter-
ing two slashes, the 
computer name or 
local IP address of the 
PC sharing the 
printer, and then the 
share name of the 
printer.

/a”<dest_path>” 
or
/A”<dest_path>”

Specifies destination 
path for installation.

 

The destination 
path should be a 
fully qualified path.

Since machine drivers 
should be installed on the 
OS specific location, this 
command applies to only 
application software.

/n”<Printer 
name>” or
/N”<Printer 
name>”

Specifies printer name. 
Printer instance shall be 
created as specified 
printer name.

With this parameter, you 
can add printer instances 
as your wishes.

/nd or
/ND

Commands not to set 
the installed driver as a 
default machine driver.

It indicates installed 
machine driver will not be 
the default machine 
driver on your system if 
there are one or more 
printer drivers installed. If 
there is no installed 
machine driver on your 
system, then this option 
won’t be applied because 
Windows OS will set 
installed printer driver as 
a default machine driver.

/x or
/X

Uses existing machine 
driver files to create 
printer instance if it is 
already installed.

This command provides a 
way to install a printer 
instance that uses 
installed printer driver 
files without installing an 
additional driver.

/up”<printer 
name>” or
/UP”<printer 
name>”

Removes only specified 
printer instance and not 
the driver files.

This command provides a 
way to remove only spec-
ified printer instance from 
your system without 
effecting other printer 
drivers. It will not remove 
printer driver files from 
your system.

/d or
/D

Uninstalls all device 
drivers and applications 
from your system.

This command will 
remove all installed 
device drivers and appli-
cation software from your 
system.

/v”<share name>” 
or
/V”<share 
name>”

Shares installed 
machine and add other 
available platform driv-
ers for Point & Print.

It will install all supported 
Windows OS platform’s 
machine drivers to sys-
tem and share it with 
specified <share name> 
for point and print.

/o or 
/O

Opens Printers and 
Faxes folder after instal-
lation.

This command will open 
Printers and Faxes 
folder after the silent 
installation.

/h, /H or /? Shows Command-line Usage.

Mac
1. Make sure that the machine is connected to your computer and powered 

on.
2. Insert the supplied software CD into your CD-ROM drive.
3. Double-click the CD-ROM icon that appears on your Mac desktop.
4. Double-click the MAC_Installer folder.
5. Double-click the Installer OS X icon.
6. Enter the password and click OK.
7. The Samsung Installer window opens. Click Continue.
8. Read the license agreement and click Continue.
9. Click Agree to agree to the license agreement.
10. Select Easy Install and click Install. Easy Install is recommended for 

most users. All components necessary for machine operations will be 
installed. 
If you select Custom Install, you can choose individual components to 
install.

11. When the message which warns that all applications will close on your 
computer appears, click Continue.

12. Select Typical installation for a local printer and then click OK.

 

If you select Typical installation for a network printer during the 
machine driver installation, the SetIP program automatically runs. 
If the machine has already configured network information, close 

COMMAND- 
LINE

DEFINITION DESCRIPTION
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the SetIP program. Go to the next step.

13. After the installation is finished, click Quit.
14. Open the Applications folder > Utilities > Print Setup Utility.

• For Mac OS X 10.5~10.8, open the Applications folder > System 
Preferences and click Print and Fax.

15. Click Add on the Printer List.
• For Mac OS X 10.5~10.8, click the “+” icon; a display window will pop 

up. 
16. For Mac OS X 10.3, select the USB tab. 

• For Mac OS X10.4, click Default Browser and find the USB connec-
tion.

• For Mac OS X 10.5~10.8, click Default and find the USB connection.
17. For Mac OS X 10.3, if Auto Select does not work properly, select Sam-

sung in Printer Model and your machine name in Model Name.
• For Mac OS X 10.4, if Auto Select does not work properly, select 

Samsung in Print Using and your machine name in Model. 
• For Mac OS X 10.5~10.8, if Auto Select does not work properly, 

select Select a driver to use... and your machine name in Print 
Using. 

Your machine appears on the Printer List, and is set as the default 
machine.

18. Click Add.

 

If the printer driver does not work properly, uninstall the driver and 
reinstall it. 
Follow steps below to uninstall the driver for Mac.

a) Make sure that the machine is connected to your computer and 
powered on.

b) Insert the supplied software CD into your CD-ROM drive.
c) Double-click CD-ROM icon that appears on your Mac desktop.
d) Double-click the MAC_Installer folder.
e) Double-click the Installer OS X icon.
f) Enter the password and click OK.
g) The Samsung Installer window opens. Click Continue.
h) Select Uninstall and click Uninstall. 
i) When the message which warns that all applications will close on 

your computer appears, Click Continue.
j) When the uninstall is done, click Quit.

Linux
You need to download the Linux software package from the Samsung web-
site to install the printer software. 
Follow the steps below to install the software.

Installing the Linux Unified Driver
1. Make sure that the machine is connected to your computer and pow-

ered on.
2. When the Administrator Login window appears, type in root in the 

Login field and enter the system password.

 

You must log in as a super user (root) to install the machine 
software. If you are not a super user, ask your system adminis-
trator.

3. From the Samsung website, download the Unified Linux Driver pack-
age to your computer.

4. Right click the Unified Linux Driver package and extract the pack-
age. 

5. Double click cdroot > autorun.
6. When the welcome screen appears, click Next.

7. When the installation is complete, click Finish.
The installation program has added the Unified Driver Configurator 
desktop icon and the Unified Driver group to the system menu for your 
convenience. If you have any difficulties, consult the on screen help that 
is available through your system menu or can otherwise be called from 
the driver package Windows applications, such as Unified Driver Con-
figurator or Image Manager.

Installing the SmartPanel
1. Make sure that the machine is connected to your computer and pow-

ered on.
2. When the Administrator Login window appears, type in root in the 

Login field and enter the system password.

 

You must log in as a super user (root) to install the machine 
software. If you are not a super user, ask your system adminis-
trator.

3. From the Samsung website, download the Smart Panel package to 
your computer.

4. Right click the Smart Panel package and extract the package. 
5. Double click cdroot > Linux > smartpanel > install.sh.
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Installing the Printer Settings Utility
1. Make sure that the machine is connected to your computer and pow-

ered on.
2. When the Administrator Login window appears, type in root in the 

Login field and enter the system password.

 

You must log in as a super user (root) to install the machine 
software. If you are not a super user, ask your system adminis-
trator.

3. From the Samsung website, download the Printer Setting Utility 
package to your computer.

4. Right click the Printer Settings Utility package and extract the 
package. 

5. Double click cdroot > Linux > psu > install.sh.

 

If the printer driver does not work properly, uninstall the driver and 
reinstall it again. 
Follow the steps below to uninstall the driver for Linux.

a) Make sure that the machine is connected to your computer and 
powered on.

b) When the Administrator Login window appears, type in “root” 
in the Login field and enter the system password.
You must log in as a super user (root) to uninstall the printer 
driver. If you are not a super user, ask your system administra-
tor.

c) Click the icon at the bottom of the desktop. When the Terminal 
screen appears, type in:
[root@localhost root]#cd /opt/Samsung/mfp/uninstall/
[root@localhost uninstall]#./uninstall.sh

d) Click Uninstall.
e) Click Next. 
f) Click Finish.
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3.network setup
This chapter gives you step-by-step instructions for setting up the network connected machine and software.

This chapter includes:

• Network environment
• Introducing useful network programs
• Using a wired network

• Installing network connected machine’s driver
• IPv6 Configuration

  

 

Supported optional devices and features may differ according to your 
model. Please check your model name (See "Features by Models" on 
page 25).

NETWORK ENVIRONMENT

You need to set up the network protocols on the machine to use it as your 
network machine. You can set up the basic network settings through the 
machine's control panel.

The following table shows the network environments supported by the 
machine:

ITEM SPECIFICATIONS

Network interface • Ethernet 10/100/1000 Base-TX
• 802.11 b/g/n Wireless LAN (Optional)

Network operating system • Windows 
2000/XP/2003/2008/Vista/7/2008 
Server R2

• Various Linux OS
• Mac OS X 10.3 ~ 10.8
• UNIX
• Novell NetWare 5.x, 6.x (TCP/IP Only)

Network protocols • TCP/IPv4
• 802.1x
• DHCP, BOOTP, AutoIP
• DNS, WINS, Bonjour, SLP, UPnP
• Standard TCP/IP Printing (RAW), LPR, 

IPP, WSD
• SNMPv 1/2/3, HTTP (S), Telnet, SMTP 

(S), LDAP (S), IPSec
• SMB, FTP, Kerberos
• TCP/IPv6 (DHCP, DNS, RAW, LPR, 

SNMPv 1/2/3, HTTP (S), IPSec)
(See "IPv6 Configuration" on page 40.)

Wireless security 
(Optional)

• Authentication: Open System, Shared 
Key, WPA Personal, WPA2 Personal 
(PSK)

• Encryption: WEP64, WEP128, TKIP, 
AES

INTRODUCING USEFUL NETWORK PROGRAMS

There are several programs available to setup the network settings easily in 
network environment. For the network administrator especially, managing 
several machines on the network is possible.

 

Before using the programs below, set the IP address first.

SyncThru™ Web Service
Web server embedded on your network machine, which allows you to:
• Configure the network parameters necessary for the machine to connect 

to various network environments.
• Customize machine settings.

(See "Using SyncThru™ Web Service" on page 68.)

SyncThru™ Web Admin Service
A web-based machine management solution for network administrators. 
SyncThru™ Web Admin Service provides you with an efficient way of man-
aging network devices and lets you remotely monitor and troubleshoot net-
work machines from any site with corporate internet access. Download this 
program from http://solution.samsungprinter.com.

SetIP
This utility program allows you to select a network interface and manually 
configure the IP addresses for use with the TCP/IP protocol (See "IPv4 set-
ting using SetIP Program (Windows)" on page 37, "IPv4 setting using SetIP 
Program (Mac)" on page 37 or "IPv4 setting using SetIP Program (Linux)" 
on page 38).

 

TCP/IPv6 is not supported by this program.

USING A WIRED NETWORK

You must set up the network protocols on your machine to use it on your 
network. This chapter will show you how this is easily accomplished.

You can use network after connecting network cable to a corresponding 
port on your machine. 

Printing configuration report
You can print a Configuration Report from the machine’s control panel that 
will show the current machine’s network settings. This will help you to set up 
a network and troubleshoot problems.
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1. Press Menu on the control panel.
2. Press the up/down arrow to highlight Information and press OK.
3. Press the up/down arrow to highlight Configuration and press OK.

The machine prints the Configuration Report.
Using this Configuration Report, you can find your machine MAC address 
and IP address.
For example:
• MAC Address: 00:15:99:41:A2:78
• IP Address: 192.0.0.192

Setting IPv4 address
You must set up an IPv4 address for network printing and management. In 
most cases a new IP address will be automatically assigned by a DHCP 
(Dynamic Host Configuration Protocol) server located on the network.

 

If you use IPv6 address, refer to "IPv6 Configuration" on page 40

In a few situations the IP address must be set manually. This is called a 
static IP and is often required in corporate Intranets for security reasons.
• DHCP IP assignment: Connect your machine to the network, and wait a 

few minutes for the DHCP server to assign an IP address to the 
machine. Then, print the Configuration Report as explained above. If 
the report shows that the IP address has changed, the assignment was 
successful. You will see the new IP address in the report.

• Static IP assignment: Use the SetIP program to change the IP address 
from your computer. If your machine has a control panel, you can also 
change the IP address using the machine's control panel.

In an office environment, we recommend that you contact a network admin-
istrator to set this address for you.

IPv4 setting using control panel
1. Connect your machine to the network with a network cable.
2. Turn on the machine.
3. Press Menu on the control panel.
4. Press the up/down arrow to highlight Network and press OK.
5. Press the up/down arrow to highlight TCP/IP (IPv4) and press OK.
6. Press the up/down arrow to highlight Set IPv4 Address and press 

OK.
7. Press the up/down arrow to highlight Manual and press OK.
8. Enter the IP address using numeric keypad and press OK.
9. In the same way, enter other parameters such as Subnet Mask and -

Gateway and press OK.
10. After entering all parameters, press Stop/Clear to return to the ready 

mode.
Now go to "Installing network connected machine’s driver" on page 38.

IPv4 setting using SetIP Program (Windows)
This program is for manually setting the network IP address of your 
machine using its MAC address to communicate with the machine. A 
MAC address is the hardware serial number of the network interface and 
can be found in the Configuration Report.
For using SetIP program, disable the computer firewall before continuing 
by performing the following:

1. Open Control Panel.
2. Double click Security Center.
3. Click Windows Firewall.
4. Disable the firewall.

Installing the program
1. Insert the Printer Software CD-ROM provided with your machine. 

When the driver CD runs automatically, close that window.
2. Start a web browser such as Internet Explorer and open the X drive. 

(X represents your CD-ROM drive.)
3. Double-click Application > SetIP.
4. Double-click Setup.exe to install this program.
5. Click OK. If necessary, select a language from the drop-down list.
6. Follow the instructions in the window and complete the installation.

Starting the program
1. Connect your machine and the computer using network cable.
2. Turn on the machine.
3. From the Windows Start menu, select All Programs > Samsung 

Printers > SetIP > SetIP.
4. Click on the  icon (third from left) in the SetIP window to open the 

TCP/IP configuration window.
5. Enter the machine’s new information into the configuration window 

as follows:

• MAC Address: Find the machine’s MAC address on the Config-
uration Report and enter it without the colons. For example, 
00:15:99:29:51:A8 becomes 0015992951A8.

 

A MAC address is a hardware serial number of the machine’s 
network interface and can be found in the Configuration 
Report.

• IP Address: Enter a new IP address for your printer.
For example, if your computer’s IP address is 192.168.1.150, 
enter 192.168.1.X. (X is number between 1 and 254 other than 
the computer’s address.)

• Subnet Mask: Enter a new Subnet Mask for your machine.
• Default Gateway: Enter a new Gateway for your machine.

6. Click Apply, and then click OK. The machine will automatically print 
the Configuration Report. Confirm that all of the settings are cor-
rect.

7. Click Exit to close the SetIP program.
8. If necessary, restart the computer’s firewall.

IPv4 setting using SetIP Program (Mac)
For using SetIP program, disable the computer firewall before continuing 
by performing the following:

 

The path and UIs may differ by Mac OS version. Refer to the Mac 
OS manual to turn firewall off.

1. Open System Preferences.
2. Click Security.
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3. Click the Firewall menu.
4. Turn the firewall off.

 

The following instructions may vary for your model.

Perform the following to configure the IP address:

1. Connect your machine and the computer using network cable.
2. Insert the Installation CD-ROM, and open the disk window. Open the 

MAC_Installer > MAC_Printer > SetIP > SetIPApplet.html.
3. Double click the file and Safari will automatically open, then select 

Trust. The browser will open the SetIPApplet.html page that shows 
the printer’s name and IP address information. 

4. Click on the  icon (third from left) in the SetIP window to open the 
TCP/IP configuration window.

5. Enter the printer’s new information into the configuration window as 
follows. In a corporate intranet, you may need to have this informa-
tion assigned by a network manager before proceeding.
• MAC Address: Find the machine’s MAC address from the Con-

figuration Report and enter it without the colons. For example, 
00:15:99:29:51:A8 becomes 0015992951A8.

 

The MAC address is the hardware serial number of the 
on-board network interface and can be found on the Con-
figuration Report.

• IP Address: Enter a new IP address for your printer.
For example, if your computer’s IP address is 192.168.1.150, 
enter 192.168.1.X. (X is number between 1 and 254 other than 
the computer’s address.)

• Subnet Mask: Enter a new Subnet Mask for your machine.
• Default Gateway: Enter a new Gateway for your machine.

6. Select Apply, then OK, and OK again. The printer will automatically 
print the configuration report. Confirm that all of the settings are cor-
rect. Quit Safari. You may close and eject the installation CD-ROM. 
If necessary, restart the computer’s firewall. You have successfully 
changed the IP address, subnet mask, and gateway.

IPv4 setting using SetIP Program (Linux)
The SetIP program should be automatically installed during the printer 
driver installation.

 

The path and UIs may differ by Linux OS version. Refer to the 
Linux OS manual to turn firewall off.

1. Print the machine’s configuration report to find your machine’s MAC 
address. 

2. Open the /opt/Samsung/mfp/share/utils/.
3. Double click the SetIPApplet.html file. 
4. Click to open the TCP/IP configuration window. 
5. Enter the MAC address, IP address, subnet mask, default gateway, 

and then click Apply. 

 

When you enter the MAC address, enter it without a colon(:).

6. The machine prints the network information. Confirm all of the set-
tings are correct. 

7. Close the SetIP program. 

Network parameter setting
You can also set up the various network settings through the network 
administration programs such as SyncThru™ Web Admin Service and 
SyncThru™ Web Service.

Restoring factory default settings using SyncThru™ 
Web Service
1. Start a web browser such as Internet Explorer, Safari or Firefox and 

enter your machine’s new IP address in the browser window.
2. Click Go to access the SyncThru™ Web Service.
3. Click Login on the upper right of the SyncThru™ Web Service web-

site.
A log-in page appears. 

4. Type in the ID and Password then click Login.
If it’s your first time logging into SyncThru™ Web Service, type in the 
below default ID and password.
• ID: admin 
• Password: sec00000 

5. When the SyncThru™ Web Service window opens, click Settings 
> Network Settings > Restore Default.

6. Click Clear for network.
7. Turn off and restart machine to apply settings.

INSTALLING NETWORK CONNECTED 
MACHINE’S DRIVER

Windows
This is recommended for most users. All components necessary for 
machine operations will be installed.
Follow the steps below:

1. Make sure that the machine is connected to the network and powered 
on.

2. Insert the supplied software CD into your CD-ROM drive.

If the installation window does not appear, click Start > All programs > 
Accessories > Run.
X:\Setup.exe replacing “X” with the letter, which represents your 
CD-ROM drive and click OK.

3. Review and accept the installation agreements in the installation win-
dow. Then, click Next.

4. Select Newtork connection on the Printer Connection Type screen. 
Then, click Next.

5. Follow the instructions in the installation window.

 

You can select the software applications in the Select Software to 
Install Window.

Silent installation Mode (Windows only)
Silent installation mode is an installation method that does not require 
any user intervention. Once you start the installation, the machine driver 
and software are automatically installed on you computer. You can start 
the silent installation by typing /s or /S in the command window (See 
"Silent installation Mode (Windows only)" on page 32).
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Mac
1. Make sure that the machine is connected to your network and powered 

on. Also, your machine’s IP address should have been set. 
2. Insert the supplied software CD into your CD-ROM drive.
3. Double-click the CD-ROM icon that appears on your Mac desktop.
4. Double-click the MAC_Installer folder.
5. Double-click the Installer OS X icon.
6. Enter the password and click OK.
7. The Samsung Installer window opens. Click Continue.
8. Read the license agreement and click Continue.
9. Click Agree to agree to the license agreement.
10. The Samsung Installer window opens. Click Continue.
11. Select Easy Install and click Install. Easy Install is recommended for 

most users. All components necessary for machine operations will be 
installed. 
• If you select Custom Install, you can choose individual components 

to install.
12. The message which warns that all applications will close on your com-

puter appears. Click Continue.

 

If you select Typical installation for a network printer during the 
machine driver installation, the SetIP program automatically runs. 
If the machine has already configured network information, close 
the SetIP program. Go to the next step.

13. After the installation is finished, click Quit.
14. Open the Applications folder > Utilities > Print Setup Utility.

• For Mac OS X 10.5~10.8, open the Applications folder > System 
Preferences and click Print & Fax.

15. Click Add on the Printer List.
• For Mac OS X 10.5~10.8, click the “+” icon; a display window will pop 

up. 
16. For Mac OS X 10.3, select the IP Printing tab. 

• For Mac OS X 10.4, click IP Printer.
• For Mac OS X 10.5~10.8, click IP.

17. Select Socket/HP Jet Direct in Printer Type.

 

When printing a document containing many pages, printing perfor-
mance may be enhanced by choosing Socket for Printer Type 
option.

18. Enter the machine’s IP address in the Printer Address field.
19. Enter the queue name in the Queue Name field. If you cannot determine 

the queue name for your machine server, try using the default queue 
first.

20. For Mac OS X 10.3, if Auto Select does not work properly, select Sam-
sung in Printer Model and your machine name in Model Name.
• For Mac OS X 10.4, if Auto Select does not work properly, select 

Samsung in Print Using and your machine name in Model. 
• For Mac OS X 10.5~10.8, if Auto Select does not work properly, 

select Select a driver to use... and your machine name in Print 
Using. 

Your machine appears on the Printer List, and is set as the default 
machine.

21. Click Add.

 

If the printer driver does not work properly, uninstall the driver and 
reinstall it. 
Follow steps below to uninstall the driver for Mac.

a) Make sure that the machine is connected to your computer and 
powered on.

b) Insert the supplied software CD into your CD-ROM drive.
c) Double-click CD-ROM icon that appears on your Mac desktop.
d) Double-click the MAC_Installer folder.
e) Double-click the Installer OS X icon.
f) Enter the password and click OK.
g) The Samsung Installer window opens. Click Continue.
h) Select Uninstall and click Uninstall. 
i) When the message which warns that all applications will close 

on your computer appears, Click Continue.
j) When the uninstall is done, click Quit.

Linux

Install Linux Driver
1. Make sure that the machine is connected to your network and pow-

ered on. Also, your machine’s IP address should have been set. 
2. From the Samsung website, download the Unified Linux Driver pack-

age to your computer.
3. Right click the Unified Linux Driver package and extract the pack-

age. 
4. Double click cdroot > autorun.
5. The Samsung Installer window opens. Click Continue.
6. The Add printer wizard window opens. Click Next.
7. Select Network printer and click Search button.
8. The Printer’s IP address and model name appears on list field.
9. Select your machine and click Next.
10. Input the printer description and Next.
11. When the add printer is done, click Finish.
12. When the install is done, click Finish.

Add network Printer
1. Double-click the Unified Driver Configurator.
2. Click Add Printer…
3. The Add printer wizard window opens. Click Next.
4. Select Network printer and click the Search button.
5. The printer’s IP address and model name appears on list field.
6. Select your machine and click Next.
7. Input the printer description and Next.
8. When the add printer is done, click Finish.

UNIX
To use UNIX Printer Driver, you have to install the UNIX printer driver pack-
age first, then setup the printer. You can download the UNIX Printer Driver 
package from the Samsung website.

Installing the UNIX printer driver package
Installation procedure is common for all variants of UNIX OS mentioned 
(See "UNIX" on page 32).

1. From the Samsung website, download and unpack the UNIX Printer 
Driver package to your computer.

2. Acquire root privileges. 
su -

3. Copy appropriate driver archive to the target UNIX computer.

 

See administration guide of your UNIX OS for details.
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4. Unpack the UNIX printer driver package archive.
For example, on IBM AIX use the following commands.
cd /tmp
gzip –dc /cdrom/unix/packages/aix_power/aix_power.tar.gz | tar 
–xvf –
The “binaries” folder consists of binz, install, share files and folders

5. Copy the “binaries” folder to any local folder.
6. Change to the driver’s “binaries” directory.

cd aix_power/binaries
7. Run the install script.

./install
install is the installer script file which is used to install or uninstall the 
UNIX Printer Driver package.
Use “chmod 755 install” command to give the permission to the 
installer script.

8. Execute the “. /install –c” command to verify install results.
9. Run ‘installprinter’ from the command line. This will bring up the 

Add Printer Wizard window. Setup the printer in this window refer-
ring the procedure next.

 

On some UNIX OS, for example on Solaris 10 just added 
printer may not be enabled and/or may not accept jobs. In this 
case run the following two commands on the root terminal:
accept <printer_name>
enable <printer_name>

Uninstalling the printer driver package

 

The uninstalling printer utility should be used to delete the printer 
installed in the system.

a) Run “uninstallprinter” command from the terminal.
It will open the Uninstall Printer Wizard
The installed printers are listed in the drop-down list

b) Select the printer to be deleted.
c) Click Delete to delete the printer from the system.
d) Execute the “. /install –d” command to uninstall the whole 

package.
e) To verify uninstall results, execute the “. /install –c” command.

To reinstall it again, use the command “. /install” to reinstall the binaries.

Setting up the printer
To add the printer to your UNIX system, run ‘installprinter’ from the com-
mand line. This will bring up the Add Printer Wizard window. Setup the 
printer in this window according to the following steps:

1. Type the name of the printer.
2. Select appropriate printer model from model list.
3. Enter any description corresponding to the type of the printer in the 

Type field. This is optional.
4. Specify any printer description in the Description field. This is 

optional.
5. Specify printer location in the Location field.
6. Type the IP address or DNS name of the printer in the Device text-

box for network-connected printers. On IBM AIX with jetdirect 
Queue type only DNS name is possible, numeric IP address is not 
allowed.

7. Queue type shows the connection as lpd or jetdirect in the corre-
sponding list box. Additionally usb type is available on Sun Solaris 
OS.

8. Select Copies to set the number of copies.

9. Check the Collate option to receive copies already sorted.
10. Check the Reverse Order option to receive copies in the reverse 

order.
11. Check the Make Default option to set this printer as default.
12. Click OK to add the printer.

IPV6 CONFIGURATION

 

TCP/IPv6 is supported properly only in Windows Vista or higher.

 

If the IPv6 network seems to not be working, set all the network setting 
to the factory defaults and try again (See "Restoring factory default 
settings using SyncThru™ Web Service" on page 38).

To use the IPv6 network environment, follow the next procedure to use the 
IPv6 address:

1. Connect your machine to the network with a network cable.
2. Turn on the machine.
3. Print a Configuration Report from the machine’s control panel that will 

check IPv6 addresses (see "Printing configuration report" on page 36).
4. Select Start > Control Panel > Hardware and Sound > Printers > Add 

Printer.
5. Click Add a local printer on the Add Printer windows.
6. Follow the instruction on the window.

 

If the machine does not work in the network environment, activate 
IPv6. Refer to the next section followed by.

Activating IPv6
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight Network and press OK.
3. Press the up/down arrow to highlight TCP/IP (IPv6) and press OK.
4. Press the up/down arrow to highlight IPv6 Activate and press OK.
5. Press the up/down arrow to highlight On and press OK.
6. Turn the machine off and turn it on again.
7. Reinstall your printer driver.

Setting IPv6 addresses
Machine supports following IPv6 addresses for network printing and man-
agements.
• Link-local Address: Self-configured local IPv6 address. (Address starts 

with FE80.)
• Stateless Address: Automatically configured IPv6 address by a net-

work router.
• Stateful Address: IPv6 address configured by a DHCPv6 server.
• Manual Address: Manually configured IPv6 address by a user.

DHCPv6 address configuration (Stateful)
If you have a DHCPv6 server on your network, you can set one of the 
following option for default dynamic host configuration:

1. Press Menu on the control panel.
2. Press the up/down arrow to highlight Network and press OK.
3. Press the up/down arrow to highlight TCP/IP (IPv6) and press OK.
4. Press the up/down arrow to highlight DHCPv6 Config and press 

OK.
5. Press the up/down arrow to access the required value.

• Router: Use DHCPv6 only when requested by a router.
• DHCPv6 Addresses: Always use DHCPv6 regardless of router 
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request.
• DHCPv6 Off: Never use DHCPv6 regardless of router request.

6. Press OK.

Manual address configuration
1. Start a web browser such as Internet Explorer that supports IPv6 

addressing as a URL (See "Connecting SyncThru™ Web Service" 
on page 41).

 

For IPv4, enter the IPv4 address (http://xxx.xxx.xxx.xxx) in the 
address field and press the Enter key or click Go.

2. Click Login on the upper right of the SyncThru™ Web Service web-
site.
A log-in page appears. 

3. Type in the ID and Password then click Login.
If it’s your first time logging into SyncThru™ Web Service, type in the 
below default ID and password.
• ID: admin 
• Password: sec00000 

4. When the SyncThru™ Web Service window opens, click Settings 
> Network Settings.

5. Click TCP/IPv6.
6. Enable the Manual Address in the TCP/IPv6 section.

 

IPv6 Protocol should be enabled.

7. Select the Address / Prefix and click the Add button, then the router 
prefix will automatically be entered into the address field. 
Enter the rest of address. (ex: 3FFE:10:88:194::AAAA. “A” is the 
hexadecimal 0 through 9, A through F.)

8. Click the Apply button.

Installing printer driver
Driver installation for network printer in IPv6 network environment is same 
as TCP/IPv4 (See "Installing network connected machine’s driver" on 
page 38).
Select TCP/IP Port and when the list of machines are displayed, simply 
select your machine's IPv6 address.

Connecting SyncThru™ Web Service
1. Start a web browser such as Internet Explorer that supports IPv6 

addressing as a URL.
2. Click Go to access the SyncThru™ Web Service.
3. Click Login on the upper right of the SyncThru™ Web Service website.

A log-in page appears. 
4. Type in the ID and Password then click Login.

If it’s your first time logging into SyncThru™ Web Service, type in the 
below default ID and password.
• ID: admin 
• Password: sec00000 

5. Select one of the IPv6 addresses (Link-local Address, Stateless 
Address, Stateful Address, Manual Address) from Configuration 
Report.

6. Enter the IPv6 addresses. (ex: http://[FE80::215:99FF:FE66:7701]) 

 

Address must be enclosed in '[]' brackets.
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4.basic setup
After installation is complete, you may want to set the machine’s default settings. Refer to the next section if you would like 
to set or change values. This chapter gives you step-by-step instructions for setting up the machine.

This chapter includes:

• Altitude adjustment
• Changing the display language
• Setting the date and time
• Changing the clock mode
• Quiet Mode

• Entering characters using the number keypad
• Using the power saving mode
• Setting job time-out
• Auto continue
• Changing the font setting

  

ALTITUDE ADJUSTMENT

The print quality is affected by atmospheric pressure, which is determined 
by the height of the machine above sea level.

Before you set the altitude value, determine the altitude where you are.

0

1 High 3
2 High 2
3 High 1

4 Normal

1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Altitude Adjustmet and press OK.
4. Press the up/down arrow until the setting option you want appears.
5. Press OK to save the selection.
6. Press Stop/Clear to return to the ready mode.

CHANGING THE DISPLAY LANGUAGE
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Language and press OK.
4. Press the up/down arrow to highlight the language you want.
5. Press OK to save the selection.
6. Press Stop/Clear to return to the ready mode.

SETTING THE DATE AND TIME

 

• If the machine’s power is cut off, you need to reset the correct time 
and date once the power has been restored.

• Some menus may not appear in the display depending on options 
or models. If so, it is not applicable to your machine.

1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Date & Time and press OK.

4. Enter the correct time and date using up/down, left/right arrow or 
numeric keypad.

5. Press OK to save the selection.
6. Press Stop/Clear to return to the ready mode.

CHANGING THE CLOCK MODE

You can set your machine to display the current time using either a 12-hour 
or 24-hour format.

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine.

1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Clock Mode and press OK.
4. Press the up/down arrow until the setting option you want appears.
5. Press OK to save the selection.
6. Press Stop/Clear to return to the ready mode.

QUIET MODE

You can reduce the printing noise by turning on the Quiet Mode. However 
the printing speed may be slowed down.

1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Quiet Mode and press OK.
4. Press the up/down arrow until the setting option you want appears.
5. Press OK to save the selection.
6. Press Stop/Clear to return to the ready mode.

ENTERING CHARACTERS USING THE NUMBER 
KEYPAD

As you perform various tasks, you may need to enter names and numbers.

Entering alphanumeric characters
1. When you are prompted to enter a letter, locate the button labeled with 

the character you want. Press the button until the correct letter appears 
on the display. 
For example, to enter the letter O, press 6, labeled with MNO.
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Each time you press 6, the display shows a different letter, M, N, O, m, 
n, o and finally 6.

2. To enter additional letters, repeat step 1.
If the next letter is printed on the same button, move the cursor by press-
ing the left/right arrow button and then press the button labeled with the 
letter you want. The cursor will move to the right and the next letter will 
appear on the display.
You can enter a space by pressing 1 twice.

3. When you have finished entering letters, press OK.

Correcting numbers or names
If you make a mistake while entering a number or name, press the left/right 
arrow button to delete the last digit or character.

USING THE POWER SAVING MODE
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Power Save and press OK.
4. Press the up/down arrow to select the time you want.
5. Press OK to save the selection.
6. Press Stop/Clear to return to the ready mode.

SETTING JOB TIME-OUT

When there is no input for a certain period of time, the machine cancels the 
current job. You can set the amount of time the machine will wait before 
canceling the job.

1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Job Timeout and press OK.
4. Enter the time using up/down arrow or numeric keypad.
5. Press OK to save the selection.
6. Press Stop/Clear to return to the ready mode.

AUTO CONTINUE

This is the option to set the machine to continue printing or not, in case the 
paper size you have set and the paper in the tray mismatches.

1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Auto Continue and press OK.
4. Press the up/down arrow until the setting option you want appears.

• On: Automatically prints after set time passes, when the paper size 
mismatches the tray paper size.

• Off: Waits until you press Start on the control panel, when the paper 
size mismatches the tray paper size.

5. Press OK to save the selection.
6. Press Stop/Clear to return to ready mode.

CHANGING THE FONT SETTING 

Your machine has preset the font for your region or country.

If you want to change the font or set the font for special condition, such as 
the DOS environment, you can change the font setting as follows:

1. Double-click the Smart Panel icon on the Windows task bar (or Notifica-
tion Area in Linux). You can also click Smart Panel on the status bar in 
Mac OS X. 

2. Click Printer Setting.
3. Click Emulation.
4. Confirm if PCL is selected in Emulation Setting.
5. Click Apply.

 

Following information shows the proper font list for corresponding lan-
guages.
• Russian: CP866, ISO 8859/5 Latin Cyrillic
• Hebrew: Hebrew 15Q, Hebrew-8, Hebrew-7 (Israel only)
• Greek: ISO 8859/7 Latin Greek, PC-8 Latin/Greek
• Arabic & Farsi: HP Arabic-8, Windows Arabic, Code Page 864, 

Farsi, ISO 8859/6 Latin Arabic
• OCR: OCR-A, OCR-B
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5.media and tray
This chapter provides information on how to load originals and print media into your machine.

This chapter includes:

• Selecting print media
• Changing the tray size
• Loading paper in tray

• Printing on special media
• Setting the default tray and paper

  

SELECTING PRINT MEDIA

You can print on a variety of print media, such as plain paper, envelopes, 
labels. Always use print media that meet the guidelines for use with your 
machine. 

Guidelines to select the print media
Print media that does not meet the guidelines outlined in this user’s guide 
may cause the following problems:
• Poor print quality
• Increased paper jams
• Premature wear on the machine.
Properties, such as weight, composition, grain and moisture content, are 
important factors that affect the machine’s performance and the output qual-
ity. When you choose print materials, consider the following:
• The type, size and weight of the print media for your machine are 

described in print media specifications (See "Print media specifications" 
on page 110).

• Desired outcome: The print media you choose should be appropriate for 
your project.

• Brightness: Some print media are whiter than others and produce 
sharper, more vibrant images.

• Surface smoothness: The smoothness of the print media affects how 
crisp the printing looks on the paper.

 

• Some print media may meet all of the guidelines in this section and 
still not produce satisfactory results. This may be the result of 
improper handling, unacceptable temperature and humidity levels, 
or other variables over which cannot be controlled.

• Before purchasing large quantities of print media, ensure that it 
meets the requirements specifications in this user’s guide and 
meets your output requirements. 

 

• Using print media that does not meet these specifications may 
cause problems, requiring repairs. Such repairs are not covered by 
the warranty or service agreements.

• Using inflammable print media can cause a fire.
• Use designated print media (See "Print media specifications" on 

page 110).

 

The use of inflammable media or foreign materials left in the printer 
may lead to overheating of the unit and, in rare cases may cause a 
fire.

The amount of paper put into the tray may differ according to media type 
used (See "Print media specifications" on page 110).

Media sizes supported in duplex mode

Mode Size Source

Duplex printinga

a.75 to 105 g/m2 (20 to 28 lbs bond) is recommended.

For 90 to 120g/m2 (24 to 32 lbs bond) paper, we recommend you to select 
Thick for Paper Type in the Printing Preferences window (see 
"Opening printing preferences" on page 52).

For some models, optional duplex unit needs to be installed to use the du-
plex feature (see "Features by Models" on page 25).

Letter, A4, Legal, Folio, 
Oficio

All trays

CHANGING THE TRAY SIZE

The tray is preset to Letter or A4 size, depending on your country. To 
change the size, you need to adjust the paper guides.

1 2

1 Paper width guide

2 Paper length guide
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1. Squeeze and slide the paper width guide and paper length lever to 
locate them in the correct paper size slot marked at the bottom of the 
tray to adjust to the paper size.

 

• To adjust the tray to fit paper smaller than A5, slide the tray 
length guide inward to A5 marked at the bottom of the tray. 
Then the handle in the middle of the paper length guide will be 
separated. Squeeze and slide the separated handle inward to 
the paper size you want.

• The duplex unit (optional for some models) is preset to Letter 
or A4 size, depending on your country. To change the paper 
size, adjust the guide as shown below.

• Do not push the paper width guide too far causing the media to 
warp. 

• If you do not adjust the paper width guide, it may cause paper 

jams.

2. Flex or fan the edge of the paper stack to separate the pages before 
loading papers.

3.  Place paper with the side you want to print facing down.

 

Paper quantity indicator shows the amount of paper in the tray. 

1 2

1 Full

2 Empty
4. After inserting the paper into the tray, squeeze and slide the paper width 

guide and paper length guide to adjust to the paper size.
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LOADING PAPER IN TRAY

Tray 1 / optional tray
1. Pull out the paper tray. And adjust the tray size to the media size you are 

loading. (See "Changing the tray size" on page 44.)
2. Flex or fan the edge of the paper stack to separate the pages before 

loading paper.

3.  Place paper with the side you want to print facing down.

 

Paper quantity indicator shows the amount of paper in the tray. 

1 2

1 Full

2 Empty
4. Set the paper type and size for the tray. (See "Setting the default tray 

and paper" on page 49.)

5. To print in application, see "Basic printing" on page 52. 

Multi-purpose tray
The multi-purpose tray can hold special sizes and types of print material, 
such as postcards, note cards, and envelopes. It is useful for single page 
printing on letterhead or colored paper, please check maximum sheets you 
can load based on thickness (See "Print media specifications" on 
page 110).

Tips on using the multi-purpose tray
• Load only one type, size and weight of print media at time in the 

multi-purpose tray.
• To prevent paper jams, do not add paper while printing when there is 

still paper in the multi-purpose tray. This also applies to other types 
of print media.

• Always load the specified print media only to avoid paper jams and 
print quality problems. (See "Print media specifications" on 

page 110.)
• Flatten any curl on postcards, envelopes, and labels before loading 

them into the multi-purpose tray.

1. Hold the handle of multi-purpose tray and pull it down to open and 
pull out the multi-purpose tray paper extension.

3

2. Flex or fan the edge of the paper stack to separate the pages before 
loading paper.

3. Place paper with the side you want to print facing up.

 

• When printing the special media, you must follow the load-
ing guideline. (See "Printing on special media" on page 47.)

• When papers overlap when printing using Multi-purpose 
tray, open tray 1 and remove overlapping papers then try 
printing again. 

• When paper does not feed well while printing, push the 
paper in manually until it starts feeding automatically. 
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4. Squeeze the multi-purpose tray paper width guides and adjust them 
to the width of the paper. Do not force them too much, or the paper 
will bent resulting in a paper jam or skew.

5. When you print a document, set the paper type and size for the 
multi-purpose tray. For information about setting the paper type and 
size on the control panel (see "Setting the default tray and paper" on 
page 49).

PRINTING ON SPECIAL MEDIA

The table below shows the available special media for each tray. 

The paper setting in the machine and driver should match to print without a 
paper mismatch error. 

To change the paper setting set in the machine, from the Samsung Easy 

Printer Manager select (Switch to advanced mode) > Device Set-

tings.

Or if your machine supports a display screen, you can set it using the 

(Menu) button on the control panel.

Then, set the paper type from the Printing preferences window > Paper 
tab > Paper Type (see "Opening printing preferences" on page 52).

 

When using special media, we recommend you feed one paper at a 
time. Check the maximum input number of media for each tray (See 
"Print media specifications" on page 110).

Types Tray 1 Optional tray
Multi-purpose 

tray

Plain ● ● ●

Thick ● ● ●

Thicker ●

Thin ● ● ●

Bond ● ● ●

Color ● ● ●

CardStock ● ● ●

Labels ● ● ●

Transparency ● ●

Envelope ● ● (only for 
optional tray 2) ●

Preprinted ● ● ●

Cotton ● ● ●

Recycled ● ● ●

Archive ● ● ●

Hole Punched ● ● ●

(●: Supported, Blank: Not supported) 

 

When you use recycled paper as a used paper, printouts might be 
wrinkled and/or jamming may occur due to excessive curl.

Envelope
Successful printing on envelopes depends upon the quality of the enve-
lopes. 
To print an envelope, place it flap side up with the stamp area bottom the 
top right side.

• When selecting envelopes, consider the following factors:
- Weight: The weight of the envelope paper should not exceed 

90 g/m2 otherwise, jam may occur.
- Construction: Prior to printing, envelopes should lie flat with less 

than a 7 mm curl and should not contain air.
- Condition: Envelopes should not be wrinkled, nicked, either dam-

aged.
- Temperature: Use envelopes that are compatible with the heat and 

pressure of the machine during operation.
• Use only well-constructed envelopes with sharp-and well-creased folds.
• Do not use stamped envelopes.
• Do not use envelopes with clasps, snaps, windows, coated lining, 

self-adhesive seals, or other synthetic materials.
• Do not use damaged or poorly made envelopes.
• Be sure the seam at both ends of the envelope extends all the way to 

the corner of the envelope.

21

1  Acceptable

2  Unacceptable
• Envelopes with a peel-off adhesive strip or with more than one flap that 

folds over to seal must use adhesives compatible with the machine’s 

Types Tray 1 Optional tray Multi-purpose 
tray
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fusing temperature about 170°C (338 °F) for 0.1 second. The extra flaps 
and strips might cause wrinkling, creasing, or jams and may even dam-
age the fuser.

• For the best print quality, position margins no closer than 15 mm from 
the edges of the envelope.

• Avoid printing over the area where the envelope’s seams meet.

Transparency
To avoid damaging the machine, use only transparencies designed for use 
in laser printers.

• Transparencies used in the machine must be able to withstand 
machine’s fusing temperature.

• Place them on a flat surface after removing them from the machine.
• Do not leave unused transparencies in the paper tray for long periods of 

time. Dust and dirt may accumulate on them, resulting in spotty printing.
• To avoid smudging caused by fingerprints, handle them carefully.
• To avoid fading, do not expose printed transparencies to prolonged sun-

light.
• Ensure that transparencies are not wrinkled, curled, or have any torn 

edges.
• Do not use transparencies that separates from the backing sheet.
• To prevent transparencies from sticking to each other, do not let the 

printed sheets stack up as they are begin printed out. 
• Base type transparency (ex. Xerox 3R3117) results in better image and 

paper handling quality than paper backed (ex. Xerox 3R3028) or remov-
able stripe (3R3108) ones.

 

Depending on the selection or storage conditions of the transpar-
ency, jam or image scratch might occur.

Labels
To avoid damaging the machine, use only labels designed for use in laser 
machines.

• When selecting labels, consider the following factors:
- Adhesives: The adhesive material should be stable at your 

machine’s fusing temperature about 170°C (338 °F).

- Arrangement: Only use labels with no exposed backing between 
them. Labels can peel off sheets that have spaces between the 
labels, causing serious jams.

- Curl: Prior to printing, labels must lie flat with no more than 13 mm 
of curl in any direction.

- Condition: Do not use labels with wrinkles, bubbles, or other indica-
tions of separation.

• Do not use labels with slick back.
• Do not use partially used labels. 
• Do not use the labels with separated edges.
• Make sure that there is no exposed adhesive material between labels. 

Exposed areas can cause labels to peel off during printing, which can 
cause paper jams. Exposed adhesive can also cause damage to 
machine components.

• Do not run a sheet of labels through the machine more than once. The 
adhesive backing is designed for only a single pass through the 
machine.

• Do not use labels that are separating from the backing sheet or are wrin-
kled, bubbled, or otherwise damaged.

Card stock/Custom-sized paper

• Do not print on media smaller than 76.2 mm (3 inches) wide or 127 mm 
(5 inches) long.

• In the software application, set margins at least 6.4 mm (0.25 inches) 
away from the edges of the material.

• Usable minimum weight of 3*5 inches paper is 105g/m². (28 lbs bond)
• Ensure that 76.2 mm (3 inches) X 127 mm (5 inches) is not curled or has 

no torn edges. Depending on the curl of 76.2 mm (3 inches) X 127 mm 
(5 inches) paper, jam might occur.
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Letterhead/Preprinted paper

Single-sided double-sided

Tray1
Optional tray

Face 
down

Face 
up

Multi-pur-
pose tray

Face 
up

Face 
down

• Letterhead/ Preprinted paper must be printed with heat-resistant ink that 
will not melt, vaporize, or release hazardous emissions when subjected 
to the machine’s fusing temperature for 0.1 second. Check your 
machine’s specification to view the fusing temperature about 170°C (338 
°F).

• Letterhead/ Preprinted paper ink must be non-flammable and should not 
adversely affect machine rollers.

• Forms and letterhead should be sealed in a moisture-proof wrapping to 
prevent changes during storage.

• Before you load letterhead/preprinted paper, verify that the ink on the 
paper is dry. During the fusing process, wet ink can come off preprinted 
paper, reducing print quality.

Used paper
When loading used paper, printed side should be facing down with an 
uncurled edge at the front. If you experience problems with paper feed, turn 
the paper around. Note that print quality is not guaranteed.

• Used paper must be printed with heat-resistant ink that will not melt, 
vaporize, or release hazardous emissions when subjected to the 
machine’s fusing temperature for 0.1 second. Check your machine’s 
specification to view the fusing temperature about 170°C(338 °F). 

• Used paper ink must be non-flammable and should not adversely affect 

machine rollers.
• Before you load used paper, verify that the ink on the paper is dry. Dur-

ing the fusing process, wet ink can come off used paper, reducing print 
quality.

SETTING THE DEFAULT TRAY AND PAPER

The paper setting in the machine and driver should match to print without a 
paper mismatch error. 

To change the paper setting set in the machine, from the Samsung Easy 

Printer Manager select (Switch to advanced mode) > Device Set-

tings.

Or if your machine supports a display screen, you can set it using the 

(Menu) button on the control panel.

Then, set the paper type from the Printing preferences window > Paper 
tab > Paper Type (see "Opening printing preferences" on page 52).

In the control panel

Setting the paper size
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight Paper and press OK.
3. Press the up/down arrow to select the tray you want and press OK.
4. Press the up/down arrow to highlight Paper Size and press OK.
5. Press the up/down arrow to select the paper size you want and press 

OK.
6. Press Stop/Clear to return to the ready mode.

Setting the paper type
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight Paper and press OK.
3. Press the up/down arrow to select the tray you want and press OK.
4. Press the up/down arrow to highlight Paper Type and press OK.
5. Press the up/down arrow to select the paper tray you want and press 

OK.
6. Press Stop/Clear to return to the ready mode.

Setting the paper source
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight Paper and press OK.
3. Press the up/down arrow to select the paper source you want and 

press OK.
4. Press Stop/Clear to return to ready mode.

In the computer

Windows
1. Click the Windows Start menu. 
2. For Windows 2000, select Settings > Printers.

• For Windows XP/2003, select Printers and Faxes. 
• For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers. 
• For Windows 7, select Control Panel > Hardware and Sound > 

Devices and Printers. 
• For Windows Server 2008 R2, select Control Panel > Hardware 

> Devices and Printers. 
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3. Right-click your machine.
4. For Windows XP/2003/2008/Vista, press Printing Preferences.

For Windows 7 and Windows Server 2008 R2, from context menus, 
select the Printing Preferences.

 

If Printing Preferences item has ► mark, you can select other 
printer drivers connected with selected printer.

5. Click Paper tab. 
6. Select tray and its options, such as paper size and type.
7. Press OK.

 

If you want to use special-sized paper such as a billing paper, 
select Paper tab > Size > Edit... in the Printing Preferences (See 
"Opening printing preferences" on page 52).

Mac
Mac does not support this function. Mac users need to change the 
default setting manually each time they want to print using other set-
tings. 

1. Open a Mac application and select the file you want to print.
2. Open the File menu and click Print.
3. Go to Paper Feed pane.
4. Set appropriate tray from which you want to print.
5. Go to Paper pane.
6. Set paper type to correspond to the paper loaded in the tray from 

which you want to print.
7. Click Print to print. 

Linux
1. Open Terminal Program
2. When the Terminal screen appears, type in the following: 

[root@localhost root]# lpr [FileName]
3. Select Printer and click Properties…
4. Click Advanced tab.
5. Select tray (source) and its options, such as paper size and type.
6. Press OK.
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6.printing
This chapter explains common printing tasks.

This chapter includes:

• Printer driver features
• Basic printing
• Opening printing preferences
• Using help
• Using special print features
• Using direct printing utility

• Changing the default print settings
• Setting your machine as a default machine
• Printing to a file (PRN)
• Mac printing
• Linux printing
• UNIX printing

  

 

The procedures in this chapter are mainly based on Windows XP.

PRINTER DRIVER FEATURES

Your printer drivers support the following standard features:
• Paper orientation, size, source and media type selection
• Number of copies

In addition, you can use various special printing features. The following 
table shows a general overview of features supported by your printer driv-
ers:

 

Some models or operating system may not support the certain fea-
ture(s) in the following table.

PCL Printer driver

FEATURE WINDOWS

Print quality option ●

Booklet printing ●

Poster printing ●

Multiple pages per sheet ●

Fit to page printing ●

Reduce and enlarge printing ●

Different source for first page ●

Watermark ●

Overlay ●

Double-sided printing (duplex)a

a.For some models, optional duplex unit needs to be installed to use the 
duplex feature (see "Features by Models" on page 25).

●

(●: Supported, Blank: Not supported) 

PostScript Printer driver 

FEATURE WINDOWS MAC LINUX UNIX

Print quality 
option

● ● ● ●

Poster printing ●

Multiple pages 
per sheet

● ● ●
(2, 4)

●
(2, 4)

Fit to page print-
ing

● ● ● ●

Reduce and 
enlarge printing

● ●

Watermark ●

Double-sided 
printing (duplex)a

a.For some models, optional duplex unit needs to be installed to use the 
duplex feature (see "Features by Models" on page 25).

● ● ● ●

(●: Supported, Blank: Not supported) 

XPS Printer driver

 

• XPS printer driver can be installed only on Windows Vista OS or 
higher.

• You can install the XPS printer driver when you insert the software 
CD into your CD-ROM drive. When the installation window 
appears, select Advanced Installation > Custom Installation. 
You can select the XPS printer driver in the Select Software and 
Utilities to Install window.

• Install optional memory when an XPS job does not print because 
the printer is out of memory.
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FEATURE WINDOWS

Print quality option ●

Booklet printing ●

Poster printing ●

Multiple pages per sheet ●

Fit to page printing ●

Reduce and enlarge printing ●

Different source for first page ●

Watermark ●

Double-sided printing (duplex) ●

(●: Supported, Blank: Not supported) 

BASIC PRINTING

Your machine allows you to print from various Windows, Mac, Linux or 
UNIX applications. The exact steps for printing a document may vary 
depending on the application you use.

 

• Your Printing Preferences window that appears in this user’s 
guide may differ depending on the machine in use. However, the 
composition of the Printing Preferences window is similar. Check 
the operating system(s) that are compatible with your machine 
(See "System requirements" on page 31).

• When you select an option in Printing Preferences, you may see 

a warning mark, , or . An exclamation mark ( ) means you 
can select that certain option but it is not recommended, and ( ) 
mark means you cannot select that option due to the machine’s 
setting or environment.

The following procedure describes the general steps required for print-
ing from various Windows applications. 

 

• Mac basic printing (See "Mac printing" on page 57).
• Linux basic printing (See "Linux printing" on page 59).
• UNIX basic printing (See "UNIX printing" on page 60).

The following Printing Preferences window is for Notepad in Windows XP. 
Your Printing Preferences window may differ, depending on your operat-
ing system or the application you are using. 

1. Open the document you want to print.
2. Select Print from the File menu. The Print window appears. 
3. Select your machine from the Select Printer list.

The basic print settings including the number of copies and print range 
are selected within the Print window. 

 

To take advantage of the printer features provided by your printer 
driver, click Properties or Preferences in the application’s Print 
window to change the print setting (See "Opening printing prefer-
ences" on page 52).

4. To start the print job, click OK or Print in the Print window.

 

• The PostScript driver is recommended for best print image quality 
from PostScript-based applications such as Acrobat Reader®, 
Adobe Illustrator®, Adobe Photoshop®, etc.

• If you are using Windows Internet Explorer, the Samsung AnyWeb 
Print too will save your time for screen-captured images or printing 
the image. Click Start > All programs > Samsung Printers > 
your machine name > Samsung AnyWeb > Download the lat-
est version to link the website where the tool is available for the 
download.

Canceling a print job
If the print job is waiting in a print queue or print spooler, cancel the job as 
follows:

1. Click the Windows Start menu.
2. For Windows 2000, select Settings > Printers.

• For Windows XP/2003, select Printers and Faxes. 
• For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers. 
• For Windows 7, select Control Panel > Hardware and Sound > 

Devices and Printers. 
• For Windows Server 2008 R2, select Control Panel > Hardware > 

Devices and Printers. 
3. For Windows 2000, XP, 2003, Vista and 2008, double-click your 

machine.
For Windows 7 and Windows Server 2008 R2, right click your printer 
icon > context menus > See what’s printing.

 

If See what’s printing item has ► mark, you can select other 
printer drivers connected with selected printer.

4. From the Document menu, select Cancel.

 

You can also access this window by simply double-clicking the 

machine icon ( ) in the Windows task bar. 

You can also cancel the current job by pressing Stop/Clear on the 
control panel.

OPENING PRINTING PREFERENCES

You can preview the settings you selected on the upper right of the Printing 
Preferences.

 

The following windows may differ, depending on your operating sys-
tem, printer models or the application you are using.

1. Open the document you want to print.
2. Select Print from the file menu. The Print window appears. 
3. Select your machine from the Select Printer. 
4. Click Properties or Preferences. 
5. The Printing Preferences window opens.
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Using a favorite setting
The Presets option, which is visible on each of the preferences tab except 
for the Samsung tab, allows you to save the current preferences for future 
use. 
To save a Presets item:

1. Change the settings as needed on each tab. 
2. Enter a name for the item in the Presets input box.

3. Click  (Add). When you save Presets, all current driver settings are 
saved.

Select more options and click  (Update), settings will be added to the 
Presets you made.
To use a saved setting, select it from the Presets drop-down list. The 
machine is now set to print according to the settings you have selected.
To delete saved settings, select it from the Presets drop-down list and click 

 (Delete). 
You can also restore the printer driver’s default settings by selecting Default 
Preset from the Presets drop-down list.

USING HELP

Click the question mark from the upper-right corner of the window and click 
on any option you want to know about. Then a pop up window appears with 
information about that option's feature which is provided from the driver. 

If  button does not appear, select the option you want to know about 

and press F1 on your keyboard. 

If you want to search information via a keyword, click the Samsung tab in 
the Printing Preferences window, and enter a keyword in the input line of 
the Help option. To get information about supplies, driver update or registra-
tion and so on, click appropriate buttons.

USING SPECIAL PRINT FEATURES

Special print features include:
• "Printing multiple pages on one sheet of paper" on page 53.
• "Printing posters" on page 53.
• "Printing booklets" on page 54.
• "Printing on both sides of paper" on page 54.
• "Change percentage of your document" on page 54.
• "Fitting your document to a selected paper size" on page 54.
• "Using watermarks" on page 55.

• "Using overlay (PCL driver only)" on page 55.
• "Print Mode" on page 56.
• "Graphics options" on page 56.

Printing multiple pages on one sheet of paper
You can select the number of pages to print on a single sheet of paper. To 
print more than one page per sheet, the pages will be reduced in size and 
arranged in the order you specify. You can print up to 16 pages on one 
sheet. 

1. To change the print settings from your software application, access 
Printing Preferences (See "Opening printing preferences" on page 52).

2. Click the Basic tab, select Multiple Pages Per Side in the Type 
drop-down list.

3. Select the number of pages you want to print per sheet (2, 4, 6, 9, or 16) 
in the Pages per Side drop-down list.

4. Select the page order from the Page Order drop-down list, if necessary. 
5. Check Print Page Border to print a border around each page on the 

sheet.
6. Click the Paper tab, select the Size, Source and Type.
7. Click OK or Print until you exit the Print window.

Printing posters
This feature allows you to print a single-page document onto 4, 9, or 16 
sheets of paper, for the purpose of pasting the sheets together to form one 
poster-size document.

1. To change the print settings from your software application, access 
Printing Preferences (See "Opening printing preferences" on page 52)

2. Click the Basic tab, select Poster Printing in the Type drop-down list.
3. Select the page layout you want.

Specification of the page layout:
• Poster 2x2: Document will be enlarged and be divided into 4 pages.
• Poster 3x3: Document will be enlarged and be divided into 9 pages.
• Poster 4x4: Document will be enlarged and be divided into 16 

pages.
4. Select the Poster Overlap value. Specify Poster Overlap in millimeters 

or inches by selecting the radio button on the upper right of Basic tab to 
make it easier to paste the sheets together.

5. Click the Paper tab, select the Size, Source and Type.
6. Click OK or Print until you exit the Print window.
7. You can complete the poster by pasting the sheets together.
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Printing booklets
This feature prints your document on both sides of a paper and arranges the 
pages so that the paper can be folded in half after printing to produce a 
booklet.

 

If you want to make a booklet, you need to print on Letter, Legal, A4, 
US Folio, or Oficio sized print media. 

8 9

1. To change the print settings from your software application, access the 
Printing Preferences (See "Opening printing preferences" on page 52).

2. Click the Basic tab, select Booklet Printing from the Type drop-down 
list.

3. Click the Paper tab, select the Size, Source and Type.

 

The Booklet Printing option is not available for all paper sizes. In 
order to find out the available paper size for this feature, select the 
available paper size in the Size option on the Paper tab.
If you select an unavailable paper size, this option can be automat-
ically cancelled. Select only available paper. (paper without  or 

 mark).

4. Click OK or Print until you exit the Print window.
5. After printing, fold and staple the pages.

Printing on both sides of paper
You can print on both sides of a paper; duplex. Before printing, decide how 
you want your document oriented. You can use this feature with Letter, 
Legal, A4, US Folio, or Oficio sized paper. 

 

We recommend not to print on both sides of the special media, such 
as labels, envelopes, or thick paper to print on both sides of paper. It 
may cause a paper jam or damage the machine. 

1. To change the print settings from your software application, access 
Printing Preferences (See "Opening printing preferences" on page 52).

2. Click the Basic tab.
3. From the Double-Sided Printing section, select the binding option you 

want.
• Printer Default: If you select this option, this feature is determined 

by the setting you’ve made on the control panel of the machine. 
• None 
• Long Edge: This option is the conventional layout used in book-

binding.

• Short Edge: This option is the conventional layout used in calen-

dars.

• Reverse Double-Sided Printing: Check this option to reverse the 
print order when duplex printing.

4. Click the Paper tab, select the Size, Source and Type.
5. Click OK or Print until you exit the Print window.

Change percentage of your document
 You can change the size of a document to appear larger or smaller on the 
printed page by typing in a percentage you want.

1. To change the print settings from your software application, access 
Printing Preferences (See "Opening printing preferences" on page 52).

2. Click the Paper tab.
3. Enter the scaling rate in the Percentage input box.

You can also click the up/down arrows to select the scaling rate. 
4. Select the Size, Source and Type in Paper Options. 
5. Click OK or Print until you exit the Print window.

Fitting your document to a selected paper size
This printer feature allows you to scale your print job to any selected paper 
size regardless of the document size. This can be useful when you want to 
check fine details on a small document. 

A

1. To change the print settings from your software application, access 
Printing Preferences (See "Opening printing preferences" on page 52).

2. Click the Paper tab.
3. Select the paper size you want from the Fit to Page.
4. Select the Size, Source and Type in Paper Options. 
5. Click OK or Print until you exit the Print window.
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Using watermarks
The watermark option allows you to print text over an existing document. 
For example, you use it when you want to have large gray letters reading 
“DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all 
pages of a document. 

There are several predefined watermarks that come with the machine. They 
can be modified, or you can add new ones to the list. 

Using an existing watermark
1. To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on 
page 52).

2. Click the Advanced tab and select the desired watermark from the 
Watermark drop-down list. You will see the selected watermark in 
the preview image. 

3. Click OK or Print until you exit the print window. 

Creating a watermark
1. To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on 
page 52).

2. From the Advanced tab, select Edit from the Watermark drop-down 
list. The Edit Watermarks window appears. 

3. Enter a text message in the Watermark Message box. You can 
enter up to 256 characters. The message displays in the preview 
window.
When the First Page Only box is checked, the watermark prints on 
the first page only.

4. Select watermark options. 
You can select the font name, style, size and shade from the Font 
Attributes section, as well as set the angle of the watermark from 
the Message Angle section. 

5. Click Add to add a new watermark to the Current Watermarks list.
6. When you have finished editing, click OK or Print until you exit the 

Print window.
To stop printing the watermark, select None from the Watermark 
drop-down list. 

Editing a watermark
1. To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on 
page 52).

2. Click the Advanced tab, select Edit from the Watermark drop-down 
list. The Edit Watermarks window appears. 

3. Select the watermark you want to edit from the Current Watermarks 
list and change the watermark message and options. 

4. Click Update to save the changes.
5. Click OK or Print until you exit the Print window. 

Deleting a watermark
1. To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on 
page 52).

2. Click the Advanced tab, select Edit from the Watermark drop-down 
list. The Edit Watermarks window appears. 

3. Select the watermark you want to delete from the Current Water-
marks list and click Delete. 

4. Click OK or Print until you exit the Print window.

Using overlay (PCL driver only)
An overlay is text and/or images stored in the computer hard disk drive 
(HDD) as a special file format that can be printed on any document. Over-
lays are often used to take the place of letterhead paper. Rather than using 
preprinted letterhead, you can create an overlay containing exactly the 
same information that is currently on your letterhead. To print a letter with 
your company’s letterhead, you do not need to load preprinted letterhead 
paper in the machine just print the letterhead overlay on your document.

Creating a new page overlay
To use a page overlay, you must create a new page overlay containing 
your logo or image.

1. Create or open a document containing text or an image for use in a 
new page overlay. Position the items exactly as you wish them to 
appear when printed as an overlay.

2. To save the document as an overlay, access Printing Preferences 
(See "Opening printing preferences" on page 52).

3. Click the Advanced tab, and select Edit from the Text drop-down 
list. Edit Overlay window appears.

4. In the Edit Overlay window, click Create. 
5. In the Save As window, type a name of up to eight characters in the 

File name box. Select the destination path, if necessary. (The 
default is C:\Formover.)

6. Click Save. The name appears on the Overlay List. 
7. Click OK or Print until you exit the Print window.
8. The file is not printed. Instead, it is stored on your computer hard disk 

drive.

 

The overlay document size must be the same as the document 
you print with the overlay. Do not create an overlay with a water-
mark.

Using a page overlay
After an overlay has been created, it is ready to be printed with your doc-
ument. To print an overlay with a document:

1. Create or open the document you want to print.
2. To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on 
page 52).

3. Click the Advanced tab. 
4. Select the desired overlay from the Text drop-down list. 
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5. If the overlay file you want does not appear in the Text drop-down 
list, select Edit from the list and click Load. Select the overlay file 
you want to use. 
If you have stored the overlay file you want to use in an external 
source, you can also load the file when you access the Load win-
dow. 
After you select the file, click Open. The file appears in the Overlay 
List box and is available for printing. Select the overlay from the 
Overlay List box. 

6. If necessary, check Confirm Page Overlay When Printing box. If 
this box is checked, a message window appears each time you sub-
mit a document for printing, asking you to confirm your wish to print 
an overlay on your document. 
If this box is not checked and an overlay has been selected, the 
overlay automatically prints with your document. 

7. Click OK or Print until you exit the Print window. 
The selected overlay prints on your document. 

 

The resolution of the overlay document must be the same as that 
of the document you will print with the overlay.

Deleting a page overlay
You can delete page overlays that you no longer use. 

1. In the Printing Preferences window, click the Advanced tab. 
2. Select Edit in the Overlay drop down list. 
3. Select the overlay you want to delete from the Overlay List box. 
4. Click Delete. 
5. When a confirming message window appears, click Yes.
6. Click OK or Print until you exit the Print window.

Print Mode
This option allows you to choose how to print the printing files by using the 
optional hard disk drive (HDD) or enabling the RAM disk.

1. To change the print settings from your software application, access 
Printing Preferences (See "Opening printing preferences" on page 52)

2. Select the option you want.

 

Store and Print and Print Schedule mode is available only if you 
have installed the optional hard disk drive (HDD). 

• Print Mode
- Normal: This mode prints without storing your document in the 

RAM disk or the optional hard disk drive (HDD). 
- Proof: This mode is useful when you print more than one copy. 

You can print one copy first to check, then print the rest of copies 
later. 

- Confidential: This mode is used for printing confidential docu-
ment. You need to enter a password to print. 

- Store: Select this setting to save a document in the RAM disk or 
optional hard disk drive (HDD) without printing. 

- Store and Print: Select this setting to save a document in the 
RAM disk or optional hard disk and print it.

- Print Schedule: Select this setting to print the document at a 
specified time.

3. Click OK or Print until you exit the Print window.

Graphics options
Use the following Graphics options to adjust the print quality for your spe-
cific printing needs.

1. To change the print settings from your software application, access 
Printing Preferences (See "Opening printing preferences" on page 52)

2. Click the Graphics tab, select the option you want.
• Quality: You can select the printout quality option. The higher the 

setting, the sharper the clarity of printed characters and graphics. 
The higher setting may also increase the printing time of a docu-
ment.

• Font/ Text: Select All Text Black to prints solid black, regardless of 
the color it appears on the screen.

• Advanced: Select to set advanced settings.
• Toner Save: Selecting this option extends the life of your toner car-

tridge and reduces your cost per page without a significant reduction 
in print quality.

• PostScript Options: You can select post script options such as 
ouptput format, post script language, and printing an error page.

 

This option is available for PostScript driver only.

3. Click OK or Print until you exit the Print window.

USING DIRECT PRINTING UTILITY

This chapter explains how to use the Direct Printing Utility to print PDF 
files without having to open the files.

 

• Hard disk drive (HDD) should be installed on your machine, to print 
PDF files using this program. 

• You cannot print PDF files that are restricted to print. Deactivate 
the printing restriction feature, and retry printing.

• You cannot print PDF files that are protected by a password. 
Deactivate the password feature, and retry printing.

• Whether or not a PDF file can be printed using the Direct Printing 
Utility program depends on how the PDF file was created.

• The Direct Printing Utility program supports the PDF version 
1.4 and below. For a higher version, you must open the file to print 
it.

What is Direct Printing Utility?
Direct Printing Utility is a program that sends PDF files directly to your 
machine to print without having to open the file. It sends data through the 
Windows spooler using the port of the printer driver. 
To install this program, select Custom installation and put a check mark in 
this program when you install the printer driver.

Printing
There are several ways you can print using the Direct Printing Utility.

From the Direct Printing Utility window
1. From the Start menu select Programs or All Programs > Samsung 

Printers > Direct Printing Utility > Direct Printing Utility.
The Direct Printing Utility window opens.

2. Select your machine from the Select Printer drop-down list and click 
Browse.

3. Select the file you wish to print and click Open.
The file is added in the Selected Files section.

4. Customize the machine settings for your needs. 
5. Click Print. The selected PDF file is sent to the machine.
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Using the right-click menu
1. Right-click on the PDF file you wish to print and select Direct Printing 

Utility.
The Direct Printing Utility window opens with the PDF file is added.

2. Select the machine you wish to use.
3. Customize the machine settings for your needs. 
4. Click Print. The selected PDF file is sent to the machine.

CHANGING THE DEFAULT PRINT SETTINGS
1. Click the Windows Start menu. 
2. For Windows 2000, select Settings > Printers.

• For Windows XP/2003, select Printers and Faxes. 
• For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers. 
• For Windows 7, select Control Panel > Hardware and Sound > 

Devices and Printers. 
• For Windows Server 2008 R2, select Control Panel > Hardware > 

Devices and Printers. 
3. Right-click your machine.
4. For Windows XP/2003/2008/Vista, press Printing Preferences.

For Windows 7 and Windows Server 2008 R2, from context menus, 
select the Printing preferences.

 

If Printing preferences item has ► mark, you can select other 
printer drivers connected with selected printer.

5. Change the settings on each tab. 
6. Click OK.

 

If you want to change the settings for each print job, change it in Print-
ing Preferences. 

SETTING YOUR MACHINE AS A DEFAULT 
MACHINE
1. Click the Windows Start menu.
2. For Windows 2000, select Settings > Printers.

• For Windows XP/2003, select Printers and Faxes. 
• For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers. 
• For Windows 7, select Control Panel > Hardware and Sound > 

Devices and Printers. 
• For Windows Server 2008 R2, select Control Panel > Hardware > 

Devices and Printers. 
3. Select your machine.
4. Right-click your machine and select Set as Default Printer.

 

For Windows 7 and Windows Server 2008 R2
If Set as default printer item has ► mark, you can select other 
printer drivers connected with selected printer.

PRINTING TO A FILE (PRN)

You will sometimes need to save the print data as a file. 

To create a file:

1. Check the Print to file box at the Print window.

2. Click Print.
3. Type in the destination path and the file name, and then click OK.

For example c:\Temp\file name.

 

If you type in only the file name, the file is automatically saved in 
My Documents.

MAC PRINTING

 

Some features may not be available depending on models or options. 
It means that the features are not supported.

This section explains how to print using Mac. You need to set the print envi-
ronment before printing. 
• USB connected (See "Mac" on page 33).
• Network connected (See "Mac" on page 39).

Printing a document
When you print with a Mac, you need to check the printer driver setting in 
each application you use. Follow the steps below to print from a Mac:

1. Open the document you want to print.
2. Open the File menu and click Page Setup (Document Setup in some 

applications).
3. Choose your paper size, orientation, scaling, other options and make 

sure that your machine is selected. Click OK.

4. Open the File menu and click Print. 
5. Choose the number of copies you want and indicate which pages you 

want to print. 
6. Click Print.
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Changing printer settings
You can use advanced printing features provided by your machine.
Open an application and select Print from the File menu. The machine 
name, which appears in the printer properties pane may differ depending on 
the machine in use. Except for the name, the composition of the printer 
properties pane is similar to the following.

 

The setting options and following panes may differ depending on print-
ers and Mac OS version.

The following pane is the first pane you will see when you open the printer 
properties pane. Select other advanced features from the drop down list. 

Layout
The Layout tab provides options to adjust how the document appears 
on the printed page. You can print multiple pages on one sheet of paper. 
• Pages Per Sheet: This option determines how many pages to be 

printed on one page (See "Printing multiple pages on one sheet of 
paper" on page 58).

• Layout Direction: This option allows you to select the printing 
direction on a page similar to the examples on UI.

• Border: This option allows you to print a border around each page 
on the sheet.

• Two-Sided: This option allows you to print on both sides of a paper 
(See "Printing on both sides of paper" on page 58).

• Reverse Page Orientation: This option allows you to rotate paper 
180 degrees. 

Graphics
The Graphics tab provides options for selecting Quality.

Paper
Set Paper Type to correspond to the paper loaded in the tray from 
which you want to print. This will let you get the best quality printout. If 
you load a different type of print material, select the corresponding paper 
type.

Printer Settings
Set toner save option to save toner.

Job Setting

 

• You can only use this option if you have enabled RAM disk or 
installed an optional hard disk drive (HDD).

• Store, Store and Print, and Print Schedule mode is available 
only if you have installed the optional hard disk drive (HDD). 

• Print Mode
- Normal: This mode prints without storing your document in the 

RAM disk or the optional hard disk. 
- Confidential: This mode is used for printing confidential docu-

ment. You need to enter a password to print. 

- Store: Select this setting to save a document in the hard disk 
without printing. 

- Store and Print: Select this setting to save a document in the 
RAM disk or the optional hard disk and print it.

- Print Schedule: Select this setting to print the document at a 
specified time.

• User ID: This option is used when you need to find a saved file 
using the control panel. 

• Job Name: This option is used when you need to find a saved file 
using the control panel. 

Printer Features
• Reverse Duplex Printing: This option allows you to select general 

print order compared to duplex print order. If this option does not 
appear, your machine does not have this feature.

• Skip Blank Pages: Check not to print blank pages.
• Clear Text: Select this option to print texts clearer than on a normal 

document.
• Output Mode: Select the output mode. The printouts will be ori-

ented differently depending on the output mode you select.
• Output Bin: Select the output bin to use.
• Staple: Select to staple printouts. 
• Sort Options(Offset): Select to shift the output position of eachset.

Printing multiple pages on one sheet of paper
You can print more than one page on a single sheet of paper. This feature 
provides a cost-effective way to print draft pages.

1. Open an application, and select Print from the File menu.
2. Select Layout. In the Pages per Sheet drop-down list, select the num-

ber of pages you want to print on one sheet of paper.

3. Select the other options you want to use.
4. Click Print, then machine prints the selected number of pages you want 

to print on one sheet of paper.

Printing on both sides of paper

 

Some features may not be available depending on models or options. 
It means that the features are not supported.

You can print on both sides of the paper. Before printing in the duplex mode, 
decide on which edge you will be binding your finished document. The bind-
ing options are, as follows:
• Long-Edge Binding: This option is the conventional layout used in 

book binding.
• Short-Edge Binding: This option is the type often used with calendars.
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1. From your Mac application, select Print from the File menu.
2. Select Layout from the drop-down list under Orientation. 
3. Select a binding orientation from Two Sided Printing option.
4. Select the other options you want to use.
5. Click Print, then the machine prints the selected number of pages on a 

side of a paper.

 

If you print more than 2 copies, the last page of the first copy and the 
first page of the second copy might print on same sheet of paper. 
Avoid using this feature when you are printing more than 1 copy. 

LINUX PRINTING

 

Some features may not be available depending on models or options. 
It means that the features are not supported.

Printing from applications

 

The following windows may differ, depending on your operating sys-
tem, printer models or the application you are using.

There are a lot of Linux applications that allow you to print using Common 
UNIX Printing System (CUPS). You can print on your machine from any 
such application.

1. Open an application, and select Print from the File menu
2. Select Print directly using lpr.
3. In the LPR GUI window, select the model name of your machine from 

the printer list and click Properties.

4. Change the print job properties using the following four tabs displayed at 
the top of the window.

• General: This option allows you to change the paper size, the paper 
type and the orientation of the documents. It enables the duplex fea-
ture, adds start and end banners and changes the number of pages 
per sheet.

 

Automatic/manual duplex printing may not be available 
depending on models. You can alternatively use the lpr printing 
system or other applications for odd-even printing.

• Text: This option allows you to specify the page margins and set the 
text options, such as spacing or columns.

• Graphics: This option allows you to set image options that are used 
when printing image files, such as color options, image size, or 
image position.

• Advanced: This option allows you to set the print resolution, paper 
source and special print features.

5. Click Apply to apply the changes and close the Properties window.
6. Click OK in the LPR GUI window to start printing.
7. The Printing window appears, allowing you to monitor the status of your 

print job.
To abort the current job, click Cancel.

Printing files
You can print many different types of files on your machine using the stan-
dard CUPS way, directly from the command line interface. The CUPS lpr 
utility allows you to do that. But the drivers package replaces the standard 
lpr tool by a much more user-friendly LPR GUI program.
To print any document file:

1. Type lpr <file_name> from the Linux shell command line and press 
Enter. The LPR GUI window appears.
When you type only lpr and press Enter, the Select file(s) to print win-
dow appears first. Just select any files you want to print and click Open.

2. In the LPR GUI window, select your machine from the list, and change 
the print job properties.

3. Click OK to start printing.

Configuring Printer Properties
Using the Printer Properties window provided by the Printers configura-
tion, you can change the various properties for your machine as a printer.

1. Open the Unified Driver Configurator.
If necessary, switch to Printers configuration.
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2. Select your machine on the available printers list and click Properties.
3. The Printer Properties window opens.

The following five tabs display at the top of the window:
• General: This option allows you to change the printer location and 

name. The name entered in this tab displays on the printer list in 
Printers configuration.

• Connection: This option allows you to view or select another port. If 
you change the machine port from USB to parallel or vice versa 
while in use, you must re-configure the machine port in this tab.

• Driver: This option allows you to view or select another machine 
driver. By clicking Options, you can set the default device options.

• Jobs: This option shows the list of print jobs. Click Cancel job to 
cancel the selected job and select the Show completed jobs check 
box to see previous jobs on the job list.

• Classes: This option shows the class that your machine is in. Click 
Add to Class to add your machine to a specific class or click 
Remove from Class to remove the machine from the selected 
class.

4. Click OK to apply the changes and close the Printer Properties win-
dow.

UNIX PRINTING 

 

Some features may not be available depending on models or options. 
It means that the features are not supported.

Proceeding the print job
After installing the printer, choose any of the image, text, PS or HPGL files 
to print.

1. Execute “printui <file_name_to_print>” command.
For example, you are printing “document1”
printui document1
This will open the UNIX Printer Driver Print Job Manager in which the 

user can select various print options.

2. Select a printer which has been already added.
3. Select the printing options from the window such as Page Selection.
4. Select how many copies needed in Number of Copies.

 

To take advantage of the printer features provided by your printer 
driver, press Properties (See "Changing the printer settings" on 
page 60).

5. Press OK to start the print job.

Changing the printer settings
The UNIX Printer Driver Print Job Manager in which the user can select 
various print options in printer Properties.
The following hot keys may also be used: “H” for Help, “O” for OK and “A” 
for Apply and “C” for Cancel.

General tab
• Paper Size: Set the paper size as A4, Letter or other paper sizes, 

according to your requirements.
• Paper Type: Choose the type of the paper. Options available in the 

list box are Printer Default, Plain, and Thick.
• Paper Source: Select the source of the page. By default, it is Auto 
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Selection.
• Orientation: Select the direction in which information is printed on a 

page.
• Duplex: Print on both sides of paper to save paper.

 

Automatic/manual duplex printing may not be available 
depending on models. You can alternatively use the lpr printing 
system or other applications for odd-even printing.

• Multiple pages: Print several pages on one side of paper.
• Page Border: Choose any of the border styles (e.g.: Single-line 

hairline, Double-line hairline)

Image tab
In this tab, you can change the brightness, resolution or an image posi-
tion of your document.

Text tab
Set the character margin, line space or the columns of the actual print 
output.

HPGL/2 tab
• Use only black pen: To print all graphics in black.
• Fit plot to page: Fit the entire graphic into a single page.
• Pen Width: Change value to increase the thickness of pen lines. By 

default, it is 1000.

Margins tab
• Use Margins: Set the margins for the document. By default, mar-

gins are not enabled. The user can change the margin settings by 
changing the values in the respective fields. Set by default, these 
values depend on the page size selected.

• Unit: Change the units to points, inches or centimeters.

Printer-Specific Settings tab
Select various options in the JCL and General frames to customize var-
ious settings. These options are specific to the printer and depend on 
the PPD file.
Printing_ 61



7.using usb memory device
This chapter explains how to use a USB memory device with your machine.

This chapter includes:

• About USB memory device
• Printing from a USB memory device

• Backing up data
• Managing USB memory

  

ABOUT USB MEMORY DEVICE

USB memory devices are available with a variety of memory capacities to 
give you more room for storing documents, presentations, music and vid-
eos, high resolution photographs, or whatever other files you want to store 
or move.

Your machine supports USB memory devices with FAT16/FAT32 and sec-
tor size of 512 bytes. 

Check your USB memory device’s file system from your dealer.

You must use only an authorized USB memory device with an A plug type 
connector.

A B

Use only a USB memory device with metal-shielded connector.

Only use a USB memory device that has obtained compatibility certification; 
otherwise, the machine might not recognize it.

Insert a USB memory device into the USB memory port on your machine.

 

• Do not remove the USB memory device while it is in use. The 
machine warranty does not cover damage caused by user’s mis-
use. 

• If your USB memory device has certain features (example, secu-
rity key, security partition, booting disk, password settings and so 
forth), do not use the USB memory device with your machine. The 
files stored in the USB memory device may be corrupted, or the 
machine may not automatically detect it. For details about these 
features, see device’s User’s Guide.

PRINTING FROM A USB MEMORY DEVICE

You can directly print files stored on a USB memory device.

If your USB memory device has certain features (example, security key, 
security partition, booting disk, password settings and so forth), do not use 
the USB memory device with your machine. The files stored in the USB 
memory device may be corrupted, or the machine may not automatically 
detect it. For details about these features, see device’s User’s Guide.

Direct Print option supported file types: 
• PRN: Only files created by provided driver with your machine are com-

patible. PRN files can be created by selecting the Print to file check box 
when you print a document. The document will be saved as a PRN file, 
rather than printed on paper. Only PRN files created in this fashion can 
be printed directly from USB memory device (See "Printing to a file 
(PRN)" on page 57).

 

If you print PRN files created from other machine, the printout 
would be different.

• BMP: BMP Uncompressed
• TIFF: TIFF 6.0 Baseline
• JPEG: JPEG Baseline
• PDF: PDF 1.4 and below
• XPS

To print a document from a USB memory device:

1. Insert a USB memory device into the USB memory port on your 
machine.

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Direct USB and press OK.
4. Press the up/down arrow to highlight USB Print and press OK.

Your machine automatically detects the device and reads data stored on 
it.

5. Press the up/down arrow until the folder or file you want is highlighted 
and press OK.
If you see + in the front of a folder name, there are one or more files or 
folders in the selected folder. 

6. If you selected a file, skip to the next step. 
If you selected a folder, press the up/down arrow until the file you want is 
highlighted and press OK. 

7. Press the up/down arrow to select the number of copies to be printed or 
enter the number and press OK. 

8. Press the up/down arrow to select the tray to use for printing.
9. Press OK to start printing the selected file.

After printing the file, the display asks if you want to print another job.
10. To print another document, press the left/right arrow to highlight Yes and 

press OK. Repeat from step 4.
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Otherwise, press the left/right arrow to highlight No and press OK. 
11. Press Stop/Clear to return to ready mode.

BACKING UP DATA

Data in the machine’s memory can be accidentally erased due to power fail-
ure or storage failure.

Backing up data
1. Insert a USB memory device into the USB memory port on your 

machine.
2. Press Menu on the control panel.
3. Press the up/down arrow to highlight System Setup and press OK.
4. Press the up/down arrow to highlight Export Setting and press OK.

The machine begins backing up the data. The data is backed up to the 
USB memory.

5. Press Stop/Clear to return to ready mode.

Restoring data
1. Insert a USB memory device (which the backup data is stored) to the 

USB memory port.
2. Press Menu on the control panel.
3. Press the up/down arrow to highlight System Setup and press OK.
4. Press the up/down arrow to highlight Import Setting and press OK.

The machine begins restoring data. The data is restored to the machine.
5. Press Stop/Clear to return to ready mode.

MANAGING USB MEMORY

You can delete image files stored on a USB memory device one by one or 
all at once by reformatting the device.

 

After deleting files or reformatting a USB memory device, files cannot 
be restored. Therefore, confirm that you no longer need the data 
before deleting it.

Deleting an image file
1. Insert a USB memory device into the USB memory port on your 

machine.
2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Direct USB and press OK.
4. Press the up/down arrow to highlight File Manage and press OK.
5. Press the up/down arrow to highlight Delete and press OK.
6. Press the up/down arrow until the folder or file you want is highlighted 

and press OK.

 

If you see + in the front of a folder name, there are one or more 
files or folders in the selected folder.

If you selected a file, the display shows the size of the file for about 2 
seconds. Go to the next step.
If you selected a folder, press the up/down arrow until the file you want 
to delete highlights and press OK.

7. To delete file, press the up/down arrow to highlight Yes and press OK.
8. Press Stop/Clear to return to ready mode.

Formatting a USB memory device
1. Insert a USB memory device into the USB memory port on your 

machine.
2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Direct USB and press OK.
4. Press the up/down arrow to highlight File Manage and press OK.
5. Press the up/down arrow to highlight Format and press OK.
6. To format USB memory device, Press the up/down arrow to highlight 

Yes and press OK.
7. Press Stop/Clear to return to ready mode.

Viewing the USB memory status
1. Insert a USB memory device into the USB memory port on your 

machine.
2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Direct USB and press OK.
4. Press the up/down arrow to highlight Check Space and press OK.

The available memory space appears on the display.
5. Press Stop/Clear to return to ready mode.
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8.machine status and advanced features
This chapter explains how to browse the current status of your machine, and the method of setting for the advanced 
machine setup. Read this chapter carefully in order to use your machine's diverse features.

This chapter includes:

• Accessing the menu
• Information
• Layout
• Paper
• Graphic
• System setup 

• Emulation
• Network
• Direct USB
• Job management
• Admin Setup

  

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine.

ACCESSING THE MENU
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight desired menu item and press OK.
3. If the setting item has sub menus, repeat step 2.
4. Press the up/down arrow to access the required value.
5. Press OK to save the selection.

6. Press  to return to the ready mode.

INFORMATION

ITEM DESCRIPTION

Menu Map You can print the menu map which shows the 
layout and current settings of this machine.

Configuration You can print a report on the machine's overall 
configuration.

Supplies Info. You can print supplies’ information page. 

Demo Page You can print the demo page to check whether 
your machine is printing properly or not.

PCL Font You can print the PCL font list.

PS Font You can print the PS font list.

EPSON Font You can print the EPSON font list.

Stored Jobs a

a.This menu is available only when an optional hard disk drive (HDD) has 
been installed or Ram disk is enabled.

You can print jobs currently stored in the 
optional memory or hard disk drive (HDD). 

Completed Jobsb

b.This menu appears when optional hard disk drive (HDD) has been in-
stalled.

You can print list of completed jobs. The Com-
pleted Job page shows the list of completed 
print jobs.

Usage Counter You can print a usage page. The usage page 
contains the total number of pages printed.

Account This is only available when Job Accounting is 
enabled from the SyncThru™ Web Admin Ser-
vice. You can print the report of printout counts 
for each login user. 

LAYOUT

ITEM DESCRIPTION

Orientation This menu allows you to select the direction in 
which information is printed on a page.

Common Margin Set the margins for print materials. The margins 
you set here will be applied when printing from 
all trays.
• Simplex Margin: Set the margin of print 

materials for one-sided printing. 

• Duplex Margina: Set the margins for dou-
ble-sided printing. 

• Binding: When printing on both sides of 
paper, side A's margin closest to the binding 
will be the same as side B's margin closest to 
the binding. Likewise, the sides' margins far-
thest from the binding will be the same.

MP Tray Set the margins for print materials. The margins 
you set here will be applied when printing from 
the multi-purpose tray.
• Simplex Margin: Set the margin of print 

materials for one-sided printing. 

• Duplexa: Set the margins for double-sided 
printing. 

ITEM DESCRIPTION
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PAPER

ITEM DESCRIPTION

Copies You can select the amount of copies from 1 to 
999.

MP Tray / [Tray<x>] • Paper Size: You can select the default paper 
size. 

• Paper Type: You can select the default 
paper type for the print media

Paper Source Using this menu, you can set which tray you 
want to use.
If you select Auto, the machine can automati-
cally determine the source. 

Auto Tray Switch This is the option to set if the machine is to con-
tinue printing or not when any tray becomes 
empty. For example, if both tray 1 and tray 2 are 
filled with the same size paper, the machine 
automatically prints from tray 2 after the tray 1 
runs out of paper.

 

This option does not appear if you selected 
Auto for Paper Source.

Tray Confirm You can activate tray confirmation message. If 
you open and close a tray, a window asking you 
whether to set the paper size and type for the 
tray just opened appears.

GRAPHIC

ITEM DESCRIPTION

Resolution You can select the default resolution. If the reso-
lution is high, the clarity of the printouts is 
sharper, but the print time may take longer.
• 600 dpi-Normal: If your print jobs are 

mostly text, select this option for the highest 
quality output.

• 1200 dpi-Best: Select this option when your 
job contains bit mapped images, such as 
scanned photos or certain business graph-
ics, that will benefit from enhanced line 
screening.

Clear Text You can print texts darker than on a normal doc-
ument, select On.

Darkness You can lighten or darken the print on the page 
by changing the toner density setting. The Nor-
mal setting usually produces the best result.

SYSTEM SETUP

<Tray X> Set the margins for print materials. The margins 
you set here will be applied when printing from 
the tray1 and optional trays.
• Simplex Margin: Set the margin of print 

materials for one-sided printing.

• Duplexa: Set the margins for double-sided 
printing.

Emulation Margin When creating an emulation print page which 
does not include margin information, the 
machine uses the margin value set here.
• Top Margin: Set the top margin, from 0.0 to 

250mm.
• Left Margin: Set the left margin, from 0.0 to 

164mm.

Duplexa To print on both sides of paper, choose the bind-
ing edge. 
• Off: Set this option off.
• Long Edge: This item is the conventional 

layout used in bookbinding.

• Short Edge: This item is the conventional 
layout used in calendars.

Landscape Stapling 
Positionb

Select the position for stapling.

a.This menu appears when duplex kit is installed (Some features and op-
tional goods may not be available depending on models or countries).

b.You can only use this menu if you have installed the optional finisher 
and hard disk drive (HDD). 

ITEM DESCRIPTION

ITEM DESCRIPTION

Date & Time You can set the date and time.

Clock Mode You can select the format for displaying time 
between 12hr and 24hr. 

Form Menua • Off: Prints in normal mode.
• Single Form: Prints all page using the first 

form.
• Double Form: Prints the front page using 

the first form and the back page using the 
second form.

ITEM DESCRIPTION
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EMULATION

ITEM DESCRIPTION

Emulation Type The machine language defines how the com-
puter communicates with the machine.
If you select Auto, your machine can change the 
machine language automatically.

Setup You can set the detailed settings for the emula-
tion type you selected.

NETWORK

Refer to the Network Setup chapter of this User’s Guide for more informa-
tion on setting the network (see "Network setup" on page 36). 

Select Forma Form overlay is images stored in the printer 
hard disk drive (HDD) as a special file format 
that can be printed in layers on any document. 

 

• Select Form is not displayed when 
Form Menu is set as Off.

• 2nd Form is displayed when Form 
Menu is set as Double Form.

HDD Spoolinga To spool documents in HDD for the network 
printing, select On.

Language This menu determines the language of the text 
that appears on the control panel display and 
information printing.

Default Paper Size You can set the default paper size to use.

Power Save When the machine does not receive data for an 
extended period of time, power consumption is 
automatically lowered. You can set how long the 
machine waits before going to power save 
mode.

Wakeup Event When this option is On, you can wake up the 
machine from the power saving mode with the 
following actions:
• Pressing any button on the control panel.
• Loading paper in a tray.
• Opening or closing the front cover.
• Pulling a tray out or pushing a tray in.

Auto Continue This menu determines whether or not the 
machine continues printing when it detects the 
paper unmatched to your paper setting.
• Off: If paper mismatch occurs, the message 

will remain on the display and the machine 
will remain off-line until you insert the correct 
paper. 

• On: If paper mismatch occurs, an error 
message will display. The machine will go 
offline for 30 seconds, then automatically 
clear the message and continue printing. 

Altitude Adjustment You can optimize print quality according to your 
altitude.

Auto CR This menu allows you to append the required 
carriage return to each line feed, which is useful 
to the Unix user or DOS user.

Job Timeout When there is no input for a certain period of 
time, the machine cancels the current job. You 
can set the amount of time the machine will wait 
before canceling the job.

Multi-Binb • Mode: Select the multi-bin mode you want to 
use. 

• Default Bin: Select the bin to use as a 
default.

Import Setting You can import data stored in the USB stick to 
the machine (see "Restoring data" on page 63).

ITEM DESCRIPTION

Export Setting You can export data stored in the machine to 
the USB stick (see "Backing up data" on 
page 63).

Quiet Mode You can reduce the printing noise by turning this 
menu on. However the printing speed and qual-
ity maybe declined.

Eco Settings Eco mode is created to set the options that 
reduce toner and paper usage.
• Default Mode: Select whether to turn the 

Eco mode on or off. 
- On: Set the Eco mode on.
- Off: Set the Eco mode off.
- Onforce: Set the Eco mode on with 

password. If a user wants to turn the Eco 
mode on/off, the user needs to enter the 
password.

• Select Template: You can select the eco 
template you set from the SyncThru™ Web 
Service (see "Eco" on page 69). 

Tray Mapping Allows you to configure the settings for Printer 
Driver and Tray placement.
• General: when using the general Samsung 

driver.
• Compatible: when using the HP driver.

Clear Settings This menu allows you to restore the machine’s 
factory default settings. 

a.This menu only appears when an optional hard disk drive (HDD) has 
been installed.

b.You can only use this menu if you have installed the optional finisher 
or mailbox.

ITEMS DESCRIPTION

Ethernet Speed This menu allows you to select the ethernet 
speed. 

ITEM DESCRIPTION
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DIRECT USB

You can use USB memory with your machine (see "Using USB memory 
device" on page 62).

JOB MANAGEMENT

This menu item is available when the optional memory or hard disk drive 
(HDD) is installed (see "Printing with the optional memory or hard disk drive" 
on page 104).

ADMIN SETUP

ITEM DESCRIPTION

Password Protect You can set the password to access the Admin 
Setup menu. Select On to use this option and 
enter the password

Change Password You can change the password for accessing the 
Admin Setup.

Maintenance This menu allows you to maintain your machine.
• Clean Fuser: Cleans the fuser by printing a 

sheet. The printed sheet has toner debris on 
it. 

• Supplies Info.: This item allows you to 
check how many pages are printed and how 
much toner are left in the cartridge. 

• TonerLow Alert: If toner in the cartridge 
has run out, a message informing user to 
change the toner cartridge appears. You can 
set the option for this message to appear or 
not.

• Ram Disk: You can enable/disable RAM 
disk to manage jobs. Depending on the 
installed optional memory size, you can set 
the RAM disk size between 32 and 64 MB. 
This option does not appear if you have 
installed hard disk drive (HDD).

 

Reboot the machine to apply the 
change.

802.1x You can select the user authentication for network 
communication. For details information consult the 
network administrator.

TCP/IP(IPv4) Select appropriate protocol and configure parame-
ters to use the network environment.

 

There are lots of parameters to be set; there-
fore, if you are not sure, leave as is, or con-
sult the network administrator.

TCP/IP(IPv6) Selects this option to use the network environment 
through IPv6. 

Wirelessa Configure the wireless network environments

Clear Settings This menu performs a simple reset and restores 
the factory default settings for the network configu-
ration. This setting will only take effect after you 
have reset the printer. 

Network Configu-
ration

This menu allows you to print a page showing the 
network parameters you set. 

Net. Activate You can set to use Ethernet on or off.

Http Activate You can set to use SyncThru™ Web Service or 
not. If you set this option to “off”, users cannot 
access SyncThru™ Web Service. 

a.This menu only appears when an optional wireless network interface 
has been installed.

ITEMS DESCRIPTION ITEM DESCRIPTION
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9.management tools
This chapter introduces management tools provided to help you make full use of your machine. 

This chapter includes:

• Introducing useful management tools
• Using SyncThru™ Web Service

• Using the Smart Panel program
• Using the Unified Linux Driver Configurator

  

INTRODUCING USEFUL MANAGEMENT TOOLS

The programs below help you to use your machine conveniently.
• "Using SyncThru™ Web Service" on page 68.
• "Using the Smart Panel program" on page 69.
• "Using the Unified Linux Driver Configurator" on page 70.

USING SYNCTHRU™ WEB SERVICE

 

Internet Explorer 6.0 or higher is the minimum requirement for 
SyncThru™ Web Service.

If you have connected your machine to a network and set up TCP/IP net-
work parameters correctly, you can manage the machine via SyncThru™ 
Web Service, an embedded web server. Use SyncThru™ Web Service to:
• View the machine’s device information and check its current status.
• Change TCP/IP parameters and set up other network parameters.
• Change printer preference.
• Set the email notifications advising of the machine’s status.
• Get support for using the machine.

To access SyncThru™ Web Service:
1. Access a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address 
field and press the Enter key or click Go.

2. Your machine’s embedded website opens.

Logging into SyncThru™ Web Service
Before configuring options in SyncThru™ Web Service, you need to 
log-in as an administrator. You can still use SyncThru™ Web Service 
without logging in but you won’t have access to Settings tab and Secu-
rity tab. 

1. Click Login on the upper right of the SyncThru™ Web Service web-
site.
A log-in page appears. 

2. Type in the ID and Password then click Login.
If it’s your first time logging into SyncThru™ Web Service, type in the 
below default ID and password.
• ID: admin 
• Password: sec00000 

SyncThru™ Web Service overview

 

Some tabs may not appear depending on your model.

Information tab
This tab gives you general information about your machine. You can 
check things, such as the machine’s IP address, remaining amount of 
toner, ethernet information, firmware version and more. You can also 
print reports such as an error report and so on. 
• Active Alerts: This item allows you to check the alerts occurred in 

the machine and their severity.
• Supplies: This item allows you to check how many pages are 

printed and amount of toner left in the cartridge.
• Usage Counters: This item allows you to check the usage count by 

print types: simplex, duplex.

• Current Settings: This item allows you to check the machine and 
network information. 

• Print information: This item allows you to print reports such as sys-
tem related reports, e mail address and font reports.

Job Management tab

 

You can only use this option if you have enabled RAM disk or 
installed an optional hard drive disk (HDD).

This tab allows you to delete or print jobs stored in the RAM disk or an 
optional hard drive disk (HDD). Select the job from the list and click on 
the Delete or the Print button. 
• Active Jobs: You can see the list of jobs in queue.
• Completed Jobs: You can see the list of completed jobs. Com-

pleted Jobs only appears if you have installed an optional hard drive 
disk (HDD).

• Stored Print: You can see the list of jobs saved in the RAM disk.
• Secured Print: You can see the list of secured jobs that the user 

has set in the printer driver. You need to enter the User ID and Pass-
word set in the printer driver to delete or print secured jobs.

Setting tab
This tab allows you to set configurations provided by your machine and 
network. You need to log-in as an administrator to view this tab. 
• Machine Settings tab: This tab allows you to set options provided 

by your machine. 
• Network Settings tab: This tab allows you to view and change the 

network environment. You can set things, such as TCP/IP, network 
protocols and so on. 

Security tab
This tab allows you to set system and network security information. You 
need to log-in as an administrator to view this tab.
• System Security: You can set the system administrator’s informa-

tion and also enable or disable machine features.

• Network Security: You can set settings for HTTPs, IPSec, 
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IPv4/IPv6 filtering, 802.1x, Authentication servers.

• User Access Control: You can set configurations for user accessi-
bility.

Maintenance tab
This tab allows you to maintain your machine by upgrading firmware and 
setting contact information for sending emails. You can also connect to 
Samsung website or download drivers by selecting the Link menu.
• Firmware Version: You can check your machine’s firmware version 

and upgrade it by using the Upgrade Wizard button. You can only 
see the Upgrade Wizard button if you login as an administrator.

• Contact Information: You can view the contact information.
• Link: You can view the links to useful sites where you can download 

or check information. 

Eco
You can enable the Eco mode and change the custom eco settings. 

Turning the Eco mode
1. From the SyncThru™ Web Service, select the Settings tab > 

Machine Settings > System > Eco > Settings.
2. On the main pane, select one of the options; On, Off, and 

On-Forced for Eco Default Mode.
• Off: Select to turn the Eco mode off.
• On: Select to turn the Eco mode on.
• On-Forced: Select to turn the Eco mode on with password. If a 

user wants to turn the Eco mode on/off, the user needs to enter 
the password.

 

If you selected On or On-Forced, check the setting you want 
to use; Factory Default or Custom Settings

3. Click Apply.

Changing the Custom Settings
1. From the SyncThru™ Web Service, select the Settings tab > 

Machine Settings > System > Eco > Settings.
2. Select On or On-Forced for Eco Default Mode.
3. Select Custom Settings.

 

You cannot change the settings for Factory Default option.

4. Click Edit & Preview Simulator.
5. Check the current settings from the Edit & Preview Simulator win-

dow and change the settings.
6. Click on Apply.

When you apply the changes, you can preview the result of reduced 
emission of carbon dioxide, used electricity, and the amount of 
saved paper in accordance with the settings you selected. The 
results are calculated on the basis that the total number of printed 
pages is one hundred without a blank page when the eco mode is 
disabled.
• Referred to the calculation coefficient for CO2, energy, and paper 

from IEA, the index of Ministry of Internal Affairs and Communi-
cation of Japan, and www.remanufacturing.org.uk. Each model 
has a different index.

• The power consumption in printing mode refers to the average 
printing power consumption in this machine.

• The actual saved or reduced amount may differ depending on the 
operating system used, computing performance, application soft-
ware, connection method, media type, media size, job complex-

ity, and etc.

 

The Undo button clears all the values set so far.

E-mail notification setup
You can receive emails about your machine’s status by setting this option. 
By setting information such as IP address, host name, e-mail address and 
SMTP server information, the machine status (toner cartridge shortage or 
machine error) will be sent to a certain person's e-mail automatically. This 
option may be used more frequently by a machine administrator. 

1. Start a web browser, such as Internet Explorer, from Windows.
Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address 
field and press the Enter key or click Go.

2. Your machine’s embedded website opens.
3. From the Settings tab, select Machine Settings > E-mail Notification. 

 

If you haven’t configured outgoing server environment, go to Set-
tings > Network Settings > Outgoing Mail Server (SMTP) to 
configure network environment before setting e-mail notification. 

4. Click Add button to add e-mail notification user. 
Set the recipient name and e-mail address(es) with notification items 
you want to receive an alert for.

5. Click Apply. 

 

If the firewall is activated, the e-mail may not be sent successfully. In 
that case, contact the a network administrator.

Setting the system administrator information
Set the system administrator information. This setting is necessary for using 
the e-mail notification option.

1. Start a web browser, such as Internet Explorer, from Windows.
Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address 
field and press the Enter key or click Go.

2. Your machine’s embedded website opens.
3. From the Security tab, select System Security > System Administra-

tor
4. Enter the name of the administrator, phone number, location and E-mail 

address. 
5. Click Apply. 

USING THE SMART PANEL PROGRAM

Smart Panel is a program that monitors and informs you of the machine sta-
tus, and allows you to customize the machine’s settings. For Windows and 
Mac, Smart Panel is installed automatically when you install the machine 
software. For Linux, you can download Smart Panel from Samsung website 
and install (See "Installing the SmartPanel" on page 34).

 

To use this program, you need the following system requirements:
• Windows. Check for windows operating system(s) compatible with 

your machine (See "System requirements" on page 31).
• Mac OS X 10.3 or higher.
• Linux. Check for Linux systems that are compatible with your 

machine (See "System requirements" on page 31).
• Internet Explorer version 5.0 or higher for flash animation in HTML 

Help.
Management tools_ 69



Understanding Smart Panel
If an error occurs while printing, you can check the error from the Smart 
Panel.
You can also launch Smart Panel manually. Double-click the Smart Panel 
icon on the Windows task bar (in Windows), or Notification Area (in Linux). 
You can also click it on the status bar (in Mac OS X).

Windows Double-click this icon in Windows.

Mac Click this icon in Mac OS X.

Linux Click this icon in Linux.

Or, if you are a Windows user, you can launch it from the Start menu, select 
Programs or All Programs > Samsung Printers > your machine name > 
Smart Panel.

 

• If you have already installed more than one Samsung machine, 
first select the correct machine model you want in order to access 
the corresponding Smart Panel.
Right-click (in Windows or Linux) or click (in Mac OS X) the Smart 
Panel icon and select your machine.

• The Smart Panel window and its contents shown in this user’s 
guide may differ depending on the machine or operating system in 
use.

The Smart Panel program displays the current status of the machine, the 
estimated level of toner remaining in the toner cartridge(s), and various 
other types of information. You can also change settings.

 

1

Toner Level View the level of toner remaining in the toner car-
tridge(s). The machine and the number of toner 
cartridge(s) shown in the above window may differ 
depending on the machine in use. Some machines 
do not have this feature.

 

2 Buy Now Order replacement toner cartridge(s) online.

 

3

User’s Guide View User’s Guide.

 

This button changes to Troubleshooting 
Guide when error occurs. You can directly 
open troubleshooting section in the user’s 
guide. 

 

4

Printer Set-
ting

Configure various machine settings in the Printer 
Settings Utility window. Some machines do not 
have this feature.

 

If you connect your machine to a network, 
the SyncThru™ Web Service window 
appears instead of the Printer Settings Utility 
window.

 

5

Driver Setting Set all of the machine options you need in the 
Printing Preferences window. This feature is 
available only for Windows (See "Opening printing 
preferences" on page 52).

Changing the Smart Panel Program Settings
Right-click (in Windows or Linux) or click (in Mac OS X) the Smart Panel 
icon and select Options. Select the settings you want from the Options 
window. 

USING THE UNIFIED LINUX DRIVER CONFIGU-
RATOR

Unified Driver Configurator is a tool primarily intended for configuring 
machine devices. You need to install Unified Linux Driver to use Unified 
Driver Configurator (See "Installing the Linux Unified Driver" on page 34).

After the driver is installed on your Linux system, the Unified Driver Configu-
rator icon will automatically be created on your desktop.

Opening the Unified Driver Configurator
1. Double-click the Unified Driver Configurator on the desktop.

You can also click the Startup Menu icon and select Samsung Unified 
Driver > Unified Driver Configurator.

2. Click each button on the left to switch to the corresponding configuration 
window.

1 Printers Configu-
ration 

2 Ports Configura-
tion 

 

 To use the on screen help, click Help.

3. After changing the configurations, click Exit to close the Unified Driver 
Configurator.
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Printers configuration
Printers configuration has the two tabs: Printers and Classes.

Printers tab
View the current system’s printer configuration by clicking on the 
machine icon button on the left side of the Unified Driver Configurator 
window.

 

1 Switches to Printers configuration.
 

2 Shows all of the installed machine.
 

3 Shows the status, model name and URI of your machine.

The printer control buttons are, as follows:
• Refresh: Renews the available machines list.
• Add Printer: Allows you to add a new machines.
• Remove Printer: Removes the selected machine.
• Set as Default: Sets the current selected machine as a default 

machine.
• Stop/Start: Stops/starts the machine.
• Test: Allows you to print a test page to ensure the machine is work-

ing properly.
• Properties: Allows you to view and change the printer properties. 

Classes tab
The Classes tab shows a list of available machine classes.

 

1 Shows all of the machine classes.

 

2
Shows the status of the class and the number of machines in the 
class.

• Refresh: Renews the classes list.
• Add Class: Allows you to add a new machine class.
• Remove Class: Removes the selected machine class.
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Ports configuration
In this window, you can view the list of available ports, check the status of 
each port and release a port that is stalled in a busy state when its owner 
has terminated the job for any reason.

 

1 Switches to Ports configuration.
 

2 Shows all of the available ports.
 

3 Shows the port type, device connected to the port, and status.

• Refresh: Renews the available ports list.
• Release port: Releases the selected port.
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10.maintenance
This chapter provides information for maintaining your machine and the toner cartridge.

This chapter includes:

• Printing a machine report
• Monitoring the supplies life
• Using Toner Low Alert

• Cleaning a machine
• Storing the toner cartridge
• Tips for moving & storing your machine

  

PRINTING A MACHINE REPORT

You can print the machine's information and job report.

1. Press Menu on the control panel.
2. Press the up/down arrow to highlight Information and press OK.
3. Press the up/down arrow until the report or list you want to print appears 

and press OK.
4. Press the up/down arrow to highlight Yes at the Print? prompt and 

press OK.

 

You can use SyncThru™ Web Service to print the machine's configu-
ration or browse the status. Open the web browser in the networked 
computer and type the machine's IP address. When SyncThru™ Web 
Service opens, click Information > Print Information.

MONITORING THE SUPPLIES LIFE

To view the supply life indicators, follow the steps below:

1. Press Menu on the control panel.
2. Press the up/down arrow to highlight Admin Setup and press OK.
3. Press the up/down arrow to highlight Maintenance and press OK.
4. Press the up/down arrow to highlight Supplies Info. and press OK.
5. Press the up/down arrow to highlight the setting option you want 

appears.
6. Press OK to save the selection.
7. Press Stop/Clear to return to the ready mode.

USING TONER LOW ALERT

If toner in the cartridge has run out, a message informing user to change the 
toner cartridge appears. You can set the option for this message to appear 
or not. 

1. Press Menu on the control panel.
2. Press the up/down arrow to highlight Admin Setup and press OK.
3. Press the up/down arrow to highlight Maintenance and press OK.
4. Press the up/down arrow to highlight Toner Low Alert and press OK.
5. Press the up/down arrow to highlight the setting option you want 

appears.
6. Press OK to save the selection.
7. Press Stop/Clear to return to the ready mode.

CLEANING A MACHINE

Ensure power is off and the power cord is unplugged from the wall outlet 
before cleaning your machine. If printing quality problems occur or if you 
use your machine in a dusty environment, you need to clean your machine 
regularly to keep the best printing condition and use your machine longer.

 

• Cleaning the cabinet of the machine with cleaning materials con-
taining large amounts of alcohol, solvent, or other strong sub-
stances can discolor or distort the cabinet. 

• If your machine or the surrounding area is contaminated with 
toner, we recommend you use cloth or tissue dampened with 
water to clean it. If you use a vacuum cleaner, toner blows in the 
air and might be harmful to you.

Cleaning the outside
Clean the machine cabinet with a soft, lint-free cloth. Dampen the cloth 
slightly with water, but be careful not to let any water drip onto or into the 
machine.

Cleaning the inside
During the printing process, paper, toner and dust particles can accumulate 
inside the machine. This buildup can cause print quality problems, such as 
toner specks or smearing. Cleaning the inside of the machine clears and 
reduces these problems.

1. Turn the machine off and unplug the power cord. Wait for the machine to 
cool down.

2. Open the top cover and pull the toner cartridge out. Set it on a clean flat 
surface.
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3. Pull the imaging unit out. Set it on a clean flat surface.

 

• Do not touch the green surface of the imaging unit. 
• To prevent damage to the imaging unit, do not expose it to light 

for more than a few minutes. Cover it with a piece of paper, if 
necessary.

4. With a dry lint-free cloth, wipe away any dust and spilled toner.

 

• While cleaning the inside of the machine, be careful not to 
touch the transfer roller, located underneath the toner car-
tridge. Oil from your fingers can cause print quality problems.

5. Locate and clean the long strip of glass (LSU) inside the machine and 
using a cotton swab.

6. Reinsert the imaging unit and toner cartridge.
7. Close the top cover. Make sure that the cover is securely closed.
8. Plug in the power cord and turn the machine on.

STORING THE TONER CARTRIDGE

Toner cartridges contain components that are sensitive to light, temperature 
and humidity. Samsung suggests users follow the recommendations below 
to ensure the optimum performance, highest quality and longest life from 
your new Samsung toner cartridges.

Store this cartridge in the same environment as the printer it will be used in; 
this should be in controlled office temperature and humidity conditions. The 
toner cartridge should remain in its original, unopened package until instal-
lation – If original packaging is not available, cover the top opening of the 
cartridge with paper and store in a dark cabinet.

Opening the cartridge package prior to use dramatically shortens its useful 
shelf and operating life. Do not store on the floor. If the toner cartridge is 
removed from the printer, always store the cartridge:
• Inside the protective bag from the original package. 
• Store lying flat (not standing on end) with the same side facing up as if 

they were installed in the machine.
• Do not store consumables in;

- Temperature greater than 40°C (104°F).
- Humidity range not less than 20% nor not greater than 80%.
- An environment with extreme changes in humidity or temperature.
- Direct sunlight or room light.
- Dusty places.
- A car for a long period of time.
- An environment where corrosive gases are present.
- An environment with salty air.

Handling instructions
• Do not touch the surface of the photosensitive drum in the cartridge.
• Do not expose the cartridge to unnecessary vibrations or shock.
• Never manually rotate the drum, especially in the reverse direction; this 

can cause internal damage and toner spillage.
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Use of non-Samsung and refilled toner cartridge
Samsung Electronics does not recommend or approve the use of non-Sam-
sung brand toner cartridges in your printer including generic, store brand, 
refilled, or remanufactured toner cartridges.

 

Samsung’s printer warranty does not cover damage to the machine 
caused by the use of a refilled, remanufactured, or non-Samsung 
brand toner cartridge.

Estimated cartridge life
Estimated cartridge life (the life of the toner cartridge yield) depends on the 
amount of toner that print jobs require. The actual print-out number may 
vary depending on the print density of the pages you print on, operating 
environment, printing interval, media type, and/or media size. For example, 
if you print a lot of graphics, the consumption of the toner is high and you 
may need to change the cartridge more often.

TIPS FOR MOVING & STORING YOUR MACHINE
• When moving the machine, do not tilt or turn it upside down. Otherwise, 

the inside of the machine may be contaminated by toner, which can 
cause damage to the machine or bad print quality.

• When moving the machine, make sure at least two people are holding 
the machine securely, you may wish to remove the consumables before 
moving the machine. 
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11.troubleshooting
This chapter gives helpful information for what to do if you encounter an error. If your machine has a display screen, check 
the message on the display screen first to solve the error. If you cannot find a solution in this User's Guide or the problem 
consists, call for service. 

This chapter includes:

• Redistributing toner
• Tips for avoiding paper jams
• Clearing paper jams

• Understanding display messages
• Solving other problems

  

REDISTRIBUTING TONER

When the toner cartridge is near the end of its life:
• White streaks or light printing occurs. 
• The toner-related message saying that the toner is low may appear on 

the display.
• The Status LED blinks red. 

If this happens, you can temporarily improve the print quality by redistribut-
ing the remaining toner in the cartridge. In some cases, white streaks or light 
printing will still occur even after you have redistributed the toner.

1. Open the top cover and pull the toner cartridge out.

2. Thoroughly roll the cartridge five or six times to distribute the toner 
evenly inside the cartridge.

 

If toner gets on your clothing, wipe it off with a dry cloth and wash 
clothing in cold water. Hot water sets toner into fabric.

3. Reinsert the toner cartridge.

4. Close the top cover. Ensure that the cover is securely closed. 

 

If the top cover is not completely closed, the machine will not oper-
ate. 

TIPS FOR AVOIDING PAPER JAMS

By selecting the correct media types, most paper jams can be avoided. 
When a paper jam occurs, refer to the next guidelines. 
• Ensure that the adjustable guides are positioned correctly (See "Loading 

paper in tray" on page 46).
Do not overload the tray. Ensure that the paper level is below the paper 
capacity mark on the inside of the tray.

• Do not remove paper from the tray while your machine is printing.
• Flex, fan and straighten paper before loading. 
• Do not use creased, damp, or highly curled paper.
• Do not mix paper types in a tray.
• Use only recommended print media (See "Setting the default tray and 

paper" on page 49).
• Ensure that the recommended side of the print media is facing down in 

the tray, or facing up in the multi-purpose tray.
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CLEARING PAPER JAMS

When a paper jam occurs, a warning message appears on the display 
screen. 

 

To avoid tearing the paper, pull the jammed paper out slowly and gen-
tly. Follow the instructions in the following sections to clear the jam. 

In tray 1

 

Click this link to open an animation about clearing a jam.

1. Open and close the top cover. The jammed paper is automatically 
ejected from the machine.

If the paper does not exit, go to the next step.
2. Pull out the tray 1.

3. Remove the jammed paper by pulling in the direction shown. To avoid 
tearing the paper, pull it out gently and slowly.

If the paper does not move when you pull, or if you do not see the paper 
in this area, check the fuser area around the toner cartridge (See "Inside 
the machine" on page 79).

4. Insert tray 1 back into the machine until it snaps into place. 
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5. Open and close the top cover to resume printing.

 

If the top cover is not completely closed, the machine will not oper-
ate.

In optional tray 2

 

• Click this link to open an animation about clearing a jam.
• The procedure is same for all optional trays.

1. Pull out the optional tray 2.
2. Remove the jammed paper by pulling in the direction shown. To avoid 

tearing the paper, pull it out gently and slowly.

If the paper does not move when you pull or if you do not see the paper 
in this area, stop and go to the next step.

3. Pull tray 1 half-way out.

4. Pull the jammed paper straight up and out.

5. Insert the trays back into the machine. 
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6. Open and close the top cover to resume printing.

 

If the top cover is not completely closed, the machine will not oper-
ate.

In the optional high capacity feeder
1. Open the cover of the optional high capacity feeder.

2. Remove the jammed paper by pulling in the direction shown. To avoid 
tearing the paper, pull it out gently and slowly.

3. Close the optional high capacity feeder cover.
4. Open and close the top cover to resume printing.

 

If the top cover is not completely closed, the machine will not oper-
ate.

In the multi-purpose tray

 

Click this link to open an animation about clearing a jam.

1. If the paper is not feeding properly, pull the paper out of the machine.

2. Open and close the top cover to resume printing.

 

If the top cover is not completely closed, the machine will not oper-
ate.

Inside the machine

 

Click this link to open an animation about clearing a jam.

 

The fuser area is hot. Take care when removing paper from the 
machine.

1. Open the top cover and pull the toner cartridge out.
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2. Pull the imaging unit out.

 

• Do not touch the green surface of the imaging unit. 
• To prevent damage to the imaging unit, do not expose it to light 

for more than a few minutes. Cover it with a piece of paper, if 
necessary.

3. Remove the jammed paper by pulling in the direction shown. To avoid 
tearing the paper, pull it out gently and slowly.

If you do not see the jammed paper or if there is any resistance when 
you pull, stop and go to the next step.

4. Unscrew the two screws on the guide envelope (steel plate) and lift up 
the guide envelope.

5. Remove the jammed paper by pulling in the direction shown. To avoid 
tearing the paper, pull it out gently and slowly.

If the paper does not move when you pull, or if you do not see the paper 
in this area, check inside the machine (see "In the exit area" on 
page 81).

6. Place the guide envelope (steel plate) and screw back the two screws.
7. Reinsert the imaging unit and toner cartridge.
8. Open and close the top cover to resume printing.

 

If the top cover is not completely closed, the machine will not oper-
ate.
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In the exit area

 

Click this link to open an animation about clearing a jam.

1. Open and close the top cover. The jammed paper is automatically 
ejected from the machine.

2. Remove the jammed paper by pulling in the direction shown. To avoid 
tearing the paper, pull it out gently and slowly.

If you do not see the jammed paper or if there is any resistance when 
you pull, stop and go to the next step.

3. Open the rear cover.
4. By opening the fuser lever, loosen the jammed paper. Then gently pull 

the paper straight out.

5. Put the fuser levers to their original position and close the rear cover. 
Printing automatically resumes.

In the duplex unit area 
If the duplex unit is not inserted correctly, paper jam may occur. Make sure 
that the duplex unit is inserted correctly.
For some models, optional duplex unit needs to be installed to use the 
duplex feature (see "Features by Models" on page 25).

 

Click this link to open an animation about clearing a jam.

1. Open the rear cover

2. Remove the jammed paper by pulling in the direction shown. To avoid 
tearing the paper, pull it out gently and slowly.

3. Close the rear cover.
If the paper does not move when you pull or if you do not see the paper 
in this area, stop and go to the next step.
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4. Pull the duplex unit out of the machine.

5. Locate the jammed paper and remove it.

6. Insert the duplex unit into the slot.
7. Open and close the top cover to resume printing.

 

If the top cover is not completely closed, the machine will not oper-
ate.

In the optional finisher (stacker & stapler)

Paper jam in front of the finisher

 

Click this link to open an animation about clearing a jam.

1. Open the finisher’s rear cover.

2. Open the machine’s rear cover.
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3. Locate the jammed paper and remove it. The jammed paper might 
be inside the finisher or the machine. To avoid tearing the paper, pull 
it out gently and slowly.

4. Close the finisher’s rear cover and machine’s rear cover.

Paper jam inside the finisher

 

Click this link to open an animation about clearing a jam.

1. Open the finisher’s rear cover.

2. Remove the jammed paper by pulling in the direction shown. To 
avoid tearing the paper, pull it out gently and slowly.

3. Close the finisher’s rear cover.
Troubleshooting_ 83

../common/swf/jam_tray1.htm


Paper jam at the exit of the finisher

 

Click this link to open an animation about clearing a jam.

1. Remove the jammed paper by pulling in the direction shown. To 
avoid tearing the paper, pull it out gently and slowly.

2. Open and close the finisher’s rear cover to resume printing.

In the optional multi-bin mailbox

Paper jam in front of the multi-bin mailbox

 

Click this link to open an animation about clearing a jam.

1. Open the mailbox’s rear cover.

2. Open the machine’s rear cover.
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3. Locate the jammed paper and remove it. The jammed paper might 
be inside the mailbox or the machine. To avoid tearing the paper, 
pull it out gently and slowly.

4. Close the mailbox’s rear cover and machine’s rear cover.

Paper jam inside the multi-bin mailbox

 

Click this link to open an animation about clearing a jam.

1. Open the mailbox’s rear cover.

2. Remove the jammed paper by pulling in the direction shown. To 
avoid tearing the paper, pull it out gently and slowly.

3. Close the mailbox’s rear cover.

Paper jam at the exit of the multi-bin mailbox

 

Click this link to open an animation about clearing a jam.
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1. Remove the jammed paper by pulling in the direction shown. To 
avoid tearing the paper, pull it out gently and slowly.

2. Open and close the mailbox’s rear cover to resume printing.

UNDERSTANDING DISPLAY MESSAGES

Messages appear on the Smart Panel program window or on the control 
panel display to indicate machine status or errors. Refer to the tables below 
to understand the messages’ meaning to correct the problem. Messages 
and their explanations are listed in alphabetical order.

 

• Select the error message and press OK in the control panel to see 
in details.

• If a message is not in the table, reboot the power and try the print-
ing job again. If the problem persists, call for service.

• When you call for service, provide the service representative with 
the contents of display message.

• Some messages may not appear in the display depending on the 
options or models. 

• [error number] indicates the error number. 
• [tray type] indicates the tray number. 
• [media type] indicates the media type.
• [media size] indicates the media size.

MESSAGE MEANING
SUGGESTED SOLU-

TIONS

802.1x Network 
Error

Fail to authenticate. Check the network 
authentication protocol. 
If the problem persists, 
contact your network 
administrator.

Door is open.
Close it

The door is open. Close the door.

Error: [error num-
ber]
Call for service

A systematic error has 
occurred

Unplug the power cord 
and plug it back in. If the 
problem persists, call 
for service.

Error: [error num-
ber]
Turn off then on

The machine unit cannot 
be controlled.

Unplug the power cord 
and plug it back in. If the 
problem persists, call 
for service.

Error: [#C1-1311] Toner is not evenly dis-
tributed. 

Redistribute the toner 
(See "Redistributing 
toner" on page 76).

Error: [#H1-1230, 
#H1-1233,
#H1-1330, #H1-1333, 
#H1-1430, #H1-1433, 
#H1-1530, #H1-1533, 
#H1-2230, #H1-2233, 
#H1-2330, #H1-2333, 
#H1-2430, #H1-2433]

The machine cannot 
communicate with the 
optional tray.

Reinstall the optional 
tray(s). If the problem 
persists, call for service. 

Error: 
[#H2-1710,#H2-1711, 
#H2-1720, #H2-1721, 
#H2-1730, #H2-1731, 
#H2-1750, #H2-1751, 
#H2-1752, #H2-1753, 
#H2-1760, #H2-1761, 
#H2-1800, #H2-1A50, 
#H2-1A52,#H2-1A70, 
#H2-1A80]

There is a problem in the 
finisher. 

Check the finisher. Call 
for service if needed.
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Error: [#H2-4700, 
#H2-4701, #H2-4710, 
#H2-4711, #H2-4A50]

There is a problem in the 
mailbox. 

Check the mailbox. Call 
for service if needed.

Finisher door Open The finisher door is open Close the finisher door.
Finisher stacker Full Too much paper in fin-

isher stacker.
Remove the printed 
paper.

Fuser not compati-
ble

The fuser unit you have 
installed is not for your 
machine.

Install a Samsung-gen-
uine fuser unit, 
designed for your 
machine.

IMG. Not Compati-
ble

The imaging unit you 
have installed is not for 
your machine.

Install a Samsung-gen-
uine imaging unit, 
designed for your 
machine.

IMG. Not Installed The imaging unit is not 
installed or the CRUM 
(Consumer Replaceable 
Unit Monitor) in the imag-
ing unit is not properly 
connected.

Reinstall the imaging 
unit two or three times. 
If the problem persists, 
the imaging unit is not 
being detected.Call for 
service.

Install duplex unit Duplex unit is not 
installed.

Installed the duplex unit. 
Refer to the installation 
guide that came with the 
duplex unit.

Install waste toner The waste toner bottle is 
not installed.

Install the waste toner 
bottle. If the problem 
persists, the waste 
toner bottle is not being 
detected. Call for ser-
vice.

IP Conflict The IP address is used 
elsewhere. 

Check the IP address or 
obtain a new IP 
address.

Jam bottom of 
duplex

Paper has jammed in the 
duplex area.

Clear the jam (See "In 
the duplex unit area" on 
page 81).

Jam exit of Finisher Paper has jammed in the 
finisher area.

Clear the jam (See 
"Paper jam at the exit of 
the finisher" on 
page 84).

Jam at mailbox [bin 
number]

Paper has jammed in the 
mailbox area.

Clear the jam (See 
"Paper jam at the exit of 
the multi-bin mailbox" 
on page 85).

Jam front of Fin-
isher

Paper has jammed in the 
finisher area.

Pull the paper out. (See 
"Paper jam in front of 
the finisher" on 
page 82).

• Jam front of mail-
box

• Jam front of [bin 
number]

Paper has jammed in the 
mailbox area.

Pull the paper out. (See 
"Paper jam in front of 
the multi-bin mailbox" 
on page 84).

Jam in exit area Paper has jammed in the 
exit area.

Clear the jam (See "In 
the exit area" on 
page 81).

Jam inside Finisher Paper has jammed in the 
finisher area.

Clear the jam (See 
"Paper jam inside the 
finisher" on page 83).

MESSAGE MEANING SUGGESTED SOLU-
TIONS

Jam inside machine Paper has jammed 
inside the machine.

Clear the jam (See 
"Inside the machine" on 
page 79).

Jam inside mailbox Paper has jammed in the 
mailbox area.

Clear the jam (See 
"Paper jam inside the 
multi-bin mailbox" on 
page 85).

Mailbox bin [num-
ber] full

Too much paper in mail-
box stacker.

Remove the printed 
paper.

Mailbox door Open The mailbox door is open Close the mailbox door.
Not Supply Toner The machine cannot 

detect the toner car-
tridge.

Reinstall the toner car-
tridge two or three 
times, or check if the 
imaging unit’s sealing 
paper is removed.
Refer to the Quick 
Installaton Guide.

Output bin full Too much paper in the 
output tray.

Remove the printed 
paper.

Paper Empty in [tray 
type]

There is no paper in the 
tray.

Load paper in the tray 
("Loading paper in tray" 
on page 46).

Paper Jam in [tray 
type]

Paper has jammed in the 
tray area.

Clear the jam (See "In 
tray 1" on page 77 "In 
optional tray 2" on 
page 78, "In the optional 
high capacity feeder" on 
page 79).

Paper Jam in MP 
tray

Paper has jammed in the 
tray area.

Clear the jam (See "In 
the multi-purpose tray" 
on page 79).

Prepare IMG. unit Small amount of toner is 
left in the imaging unit. 
The estimated imaging 
unit life is close.

Prepare a new imaging 
unit for replacement. 

Prepare new toner Small amount of toner is 
left in the cartridge. The 
estimated cartridge life of 
toner is close.

Prepare a new cartridge 
for replacement. You 
may temporarily 
increase the printing 
quality by redistributing 
the toner (See "Redis-
tributing toner" on 
page 76).

Rear Door Open The rear door is open. Close the rear door.
Replace Fuser unit The fuser unit has 

reached the end of its 
lifespan.

This message appears 
when the fuser unit is 
worn. Replace the fuser 
unit with a new one. Call 
for service.

MESSAGE MEANING SUGGESTED SOLU-
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Replace IMG.unit The indicated imaging 
unit has almost reached 
its estimated cartridge 
life. The machine might 
stop printing. 

 

Estimated car-
tridge life means 
the expected or 
estimated toner 
cartridge life, which 
indicates the aver-
age capacity of 
print-outs and is 
designed pursuant 
to ISO/IEC 19752. 
The number of 
pages may be 
affected by the per-
centage of image 
area, operating 
environment, print-
ing interval, media 
type and media 
size. Some amount 
of toner may 
remain in the car-
tridge even when 
red LED is turns on 
and the printer 
stops printing.

• Replace the imaging 
unit for the best print 
quality when this 
message appears. 
Using the imaging 
unit beyond this 
stage can result in 
printing quality 
issues. (See "Replac-
ing the imaging unit" 
on page 99)

 

Samsung does 
not recom-
mend using 
non-genuine 
Samsung toner 
cartridge such 
as refilled or 
remanufac-
tured. Sam-
sung cannot 
guarantee 
non-genuine 
Samsung toner 
cartridge's qual-
ity. Service or 
repair required 
as a result of 
using non-gen-
uine Samsung 
toner car-
tridges will not 
be covered 
under the 
machine war-
ranty.

• If the machine stops 
printing, replace the 
imaging unit (See 
"Replacing the imag-
ing unit" on page 99).

MESSAGE MEANING SUGGESTED SOLU-
TIONS

Replace new toner The indicated toner car-
tridge has almost 
reached its estimated 
cartridge life. The 
machine might stop print-
ing. 

 

Estimated car-
tridge life means 
the expected or 
estimated toner 
cartridge life, which 
indicates the aver-
age capacity of 
print-outs and is 
designed pursuant 
to ISO/IEC 19752. 
The number of 
pages may be 
affected by the per-
centage of image 
area, operating 
environment, print-
ing interval, media 
type and media 
size. Some amount 
of toner may 
remain in the car-
tridge even when 
red LED is turns on 
and the printer 
stops printing.

• You can choose Stop
or Continue as 
shown on the control 
panel. If you select 
Stop, the printer 
stops printing and 
you cannot print any 
more without chang-
ing the cartridge. If 
you select Continue, 
the printer keeps 
printing but the print-
ing quality cannot be 
guaranteed.
Replace the toner 
cartridge for the best 
print quality when this
message appears. 
Using a cartridge 
beyond this stage 
can result in printing 
quality issues. (See 
"Replacing the toner 
cartridge" on 
page 98)

 

Samsung does 
not recom-
mend using 
non-genuine 
Samsung toner 
cartridge such 
as refilled or 
remanufac-
tured. Sam-
sung cannot 
guarantee 
non-genuine 
Samsung toner 
cartridge's qual-
ity. Service or 
repair required 
as a result of 
using non-gen-
uine Samsung 
toner car-
tridges will not 
be covered 
under the 
machine war-
ranty.

• If the machine stops 
printing, replace the 
toner cartridge (See 
"Replacing the toner 
cartridge" on 
page 98).

Shake toner cart. Toner is not evenly dis-
tributed. 

Redistribute the toner 
(See "Redistributing 
toner" on page 76).
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SOLVING OTHER PROBLEMS

The following chart lists some conditions that may occur and the recom-
mended solutions. Follow the suggested solutions until the problem is cor-
rected. If the problem persists, call for service.

Other problems include:
• See "Power problems" on page 89.
• See "Paper feeding problems" on page 90.
• See "Printing problems" on page 90.
• See "Printing quality problems" on page 92.
• See "Common PostScript problems" on page 94.
• See "Common Windows problems" on page 95.
• See "Common Linux problems" on page 95.
• See "Common Mac problems" on page 96.

Power problems

 

Click this link to open an animation about power problems.

CONDITION SUGGESTED SOLUTIONS

The machine is 
not receiving 
power; 
or the printer 
cable connection 
between the com-
puter and the 
machine is not 
connected prop-
erly.

• Plug in the power cord and then press the power 
switch to turn the machine on. 

Or press  (power) on the control panel.

• Disconnect the machine printer cable and recon-
nect it.
- For Local USB

- For Network Printing 

Staple Empty Staple cartridge is 
empty. 

Replace the staple car-
tridge (See "Replacing 
the stapler cartridge" on 
page 106) 

Staple Low Staple cartridge is low. Prepare a new staple 
cartridge

Toner Not Compati-
ble

The toner cartridge you 
have installed is not for 
your machine.

Install a Samsung-gen-
uine toner cartridge, 
designed for your 
machine.

Toner not installed The toner cartridge is not 
installed or the CRUM 
(Consumer Replaceable 
Unit Monitor) in the car-
tridge is not properly con-
nected.

Reinstall the toner car-
tridge two or three 
times. If the problem 
persists, the toner car-
tridge is not being 
detected. Call for ser-
vice.

[tray type] cassette 
Out

The tray is not properly 
inserted.

Close the tray.

Waste toner Full The waste toner bottle is 
full.

Replace the waste toner 
bottle.

MESSAGE MEANING SUGGESTED SOLU-
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Paper feeding problems

CONDITION SUGGESTED SOLUTIONS

Paper jams during 
printing.

Clear the paper jam (See "Clearing paper jams" 
on page 77).

Paper sticks 
together.

• Check the maximum paper capacity of the 
tray (See "Print media specifications" on 
page 110).

• Make sure that you are using the correct type 
of paper (See "Print media specifications" on 
page 110).

• Remove paper from the tray and flex or fan 
the paper.

• Humid conditions may cause some paper to 
stick together, install paper from a fresh ream.

Multiple sheets of 
paper do not feed.

Different types of paper may be stacked in the 
tray. Load paper of only one type, size, and 
weight.

Paper does not feed 
into the machine.

• Remove any obstructions from inside the 
machine.

• Paper has not been loaded correctly. Remove 
paper from the tray and reload it correctly.

• There is too much paper in the tray. Remove 
excess paper from the tray.

• The paper is too thick. Use only paper that 
meets the specifications required by the 
machine (See "Print media specifications" on 
page 110).

• If an original does not feed into the machine, 
the document feeder rubber pad may require 
to be replaced. Contact a service representa-
tive.

The paper keeps 
jamming.

• There is too much paper in the tray. Remove 
excess paper from the tray. If you are printing 
on special materials, use the multi-purpose 
tray.

• An incorrect type of paper is being used. Use 
only paper that meets the specifications 
required by the machine (See "Print media 
specifications" on page 110).

• There may be debris inside the machine. 
Open the front door and remove any debris.

• If an original does not feed into the machine, 
the document feeder rubber pad may need to 
be replaced. Contact a service representative.

Envelopes skew or 
fail to feed correctly.

Ensure that the paper guides are against both 
sides of the envelopes.

Printing problems

CONDITION
POSSIBLE 

CAUSE
SUGGESTED SOLU-

TIONS

The machine 
does not print.

The machine is not 
receiving power.

Check the power cord con-
nections. Check both power 
switches and the power 
source.

The machine is not 
selected from the 
available printers 
list.

Select this printers “Name” 
from the available printers 
drop-down list in the applica-
tion you are printing from

Check the machine for the following:
• The front door is not closed. Close the front 

door.
• Paper is jammed. Clear the paper jam (See 

"Clearing paper jams" on page 77).
• No paper is loaded. Load paper (See "Loading 

paper in tray" on page 46).
• The toner cartridge is not installed. Install the 

toner cartridge.
If a system error occurs, contact your service repre-
sentative.

The connection 
printer cable 
between the com-
puter and the 
machine is not con-
nected properly.

Disconnect the machine 
printer cable and reconnect 
it.

The connection 
printer cable 
between the com-
puter and the 
machine is defec-
tive.

If possible, attach the printer 
cable to another computer 
that is working properly and 
print a job. You can also try 
using a different machine 
printer cable.

The port setting is 
incorrect.

Check the Windows printer 
settings to make sure that 
the print job is sent to the 
correct port. If the computer 
has more than one port, 
make sure that the machine 
is attached to the correct 
one.

The machine may 
be configured incor-
rectly. 

Check the Printing Prefer-
ences to ensure that all of 
the print settings are correct 
(See "Opening printing pref-
erences" on page 52).

The printer driver 
may be incorrectly 
installed.

Repair the machine software 
(See "Installing locally con-
nected machine’s driver" on 
page 32).

The machine is 
malfunctioning.

Check the display message 
on the control panel to see if 
the machine is indicating a 
system error. Contact a ser-
vice representative.
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The document size 
is so big that the 
hard disk space of 
the computer is 
insufficient to 
access the print job.

Make available more hard 
disk space and print the doc-
ument again.

The machine 
selects print 
materials from 
the wrong paper 
source.

The paper option 
that was selected in 
the Printing Pref-
erences may be 
incorrect.

For many software applica-
tions, the paper source 
selection is found under the 
Paper tab within the Print-
ing Preferences. Select the 
correct paper source. See 
the printer driver help screen 
(See "Opening printing pref-
erences" on page 52).

A print job is 
extremely slow.

The job may be 
very complex.

Reduce the complexity of 
the page or try adjusting the 
print quality settings.

Half the page is 
blank.

The page orienta-
tion setting may be 
incorrect.

Change the page orientation 
in your application. See the 
printer driver help screen.

The paper size and 
the paper size set-
tings do not match.

Ensure that the paper size in 
the printer driver settings 
matches the paper in the 
tray.
Or, ensure that the paper 
size in the printer driver set-
tings matches the paper 
selection in the software 
application settings you use.

CONDITION POSSIBLE 
CAUSE

SUGGESTED SOLU-
TIONS

The machine 
prints, but the 
text is wrong, 
garbled, or 
incomplete.

The machine cable 
is loose or defec-
tive.

Disconnect the machine 
printer cable and reconnect. 
Try a print job that you have 
already printed success-
fully. If possible, attach the 
printer cable and the 
machine to another com-
puter that you know works 
ensure print driver is 
installed and try a print job. 
Finally, try a new machine 
printer cable.

The wrong printer 
driver was selected.

Check the application’s 
printer selection menu to 
ensure that your machine is 
selected.

The software appli-
cation is malfunc-
tioning.

Try printing a job from 
another application.

The operating sys-
tem is malfunction-
ing.

Exit Windows and reboot the 
computer. Turn the machine 
off and back on again.

If you are in a DOS 
environment, the 
font setting for your 
machine may be 
set incorrectly.

Change the language set-
ting (See "Changing the dis-
play language" on page 42).

Printer driver cor-
rupted.

Reinstall printer driver.

Pages print, but 
they are blank.

The toner cartridge 
is defective or out of 
toner.

Redistribute the toner, if 
necessary. 
If necessary, replace the 
toner cartridge.

The file may have 
blank pages.

Check the file to ensure that 
it does not contain blank 
pages.

Some parts, such 
as the controller or 
the board, may be 
defective.

Contact a service represen-
tative.

The machine 
does not print 
PDF files cor-
rectly. Some 
parts of graph-
ics, text, or illus-
trations are 
missing.

Incompatibility 
between the PDF 
file and the Acrobat 
products.

Printing the PDF file as an 
image may enable the file to 
print. Turn on Print As 
Image from the Acrobat 
printing options. 

 

It will take longer to 
print when you print a 
PDF file as an image.

CONDITION POSSIBLE 
CAUSE

SUGGESTED SOLU-
TIONS
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Printing quality problems
If the inside of the machine is dirty or paper has been loaded improperly, 
there might be a reduction in print quality. See the table below to clear the 
problem. 

The print quality 
of photos is not 
good. Images are 
not clear.

The resolution of 
the photo is very 
low. 

Reduce the photo size. If 
you increase the photo size 
in the software application, 
the resolution will be 
reduced. 

Before printing, 
the machine 
emits vapor near 
the output tray.

Using damp paper 
can cause vapor 
during printing.

This is not a problem. Just 
keep printing.

The machine 
does not print 
special- sized 
paper, such as 
billing paper.

Paper size and 
paper size setting 
do not match.

Set the correct paper size in 
the Paper tab in the Print-
ing Preferences (See 
"Opening printing prefer-
ences" on page 52).

CONDITION SUGGESTED SOLUTIONS

Light or faded print • If a vertical white streak or faded area 
appears on the page, the toner supply is low 
or the imaging unit is worn. You may be able 
to temporarily extend the toner cartridge life 
(See"Redistributing toner" on page 76). If this 
does not improve the print quality, install a 
new toner cartridge or imaging unit.

• The paper may not meet paper specifications; 
for example, the paper may be too moist or 
rough (See "Print media specifications" on 
page 110).

• If the entire page is light, the print resolution 
setting is too low or the toner save mode is 
on. Adjust the print resolution and turn the 
toner save mode off. See the help screen of 
the printer driver.

• A combination of faded or smeared defects 
may indicate that the imaging unit needs 
cleaning (See "Cleaning the inside" on 
page 73).

• The surface of the LSU part inside the 
machine may be dirty (See "Cleaning the 
inside" on page 73).

Toner specks

A aB bC c
A aB bC c
A aB bC c
A aB bC c
A aB bC c

• The paper may not meet specifications; for 
example, the paper may be too moist or rough 
(See "Print media specifications" on 
page 110).

• The transfer roller may be dirty. Clean the 
inside of your machine. Contact a service rep-
resentative.

• The paper path may need cleaning. Contact a 
service representative.

CONDITION POSSIBLE 
CAUSE

SUGGESTED SOLU-
TIONS

Dropouts

A a B b C
A a B b C
A a B b C
A a B b C
A a B b C

If faded areas, generally rounded, occur ran-
domly on the page:
• A single sheet of paper may be defective. 

Try reprinting the job.
• The moisture content of the paper is uneven 

or the paper has moist spots on its surface. 
Try a different brand of paper (See "Print 
media specifications" on page 110).

• The paper lot is bad. The manufacturing pro-
cesses can cause some areas to reject 
toner. Try a different kind or brand of paper.

• Change the printer option and try again. Go 
to Printing Preferences, click Paper tab, 
and set type to Thick (See "Opening printing 
preferences" on page 52).

• If these steps do not correct the problem, 
contact a service representative.

White Spots If white spots appear on the page:
• The paper is too rough and a lot of dirt from a 

paper falls to the inner devices within the 
machine, so the transfer roller may be dirty. 
Clean the inside of your machine (See 
"Cleaning the inside" on page 73).

• The paper path may need cleaning (See 
"Cleaning the inside" on page 73).

Vertical lines If black vertical streaks appear on the page:
• The surface (drum part) of the imaging unit 

inside the machine has probably been 
scratched. Remove the imaging unit and 
install a new one (See "Replacing the imag-
ing unit" on page 99).

If white vertical streaks appear on the page:
• The surface of the LSU part inside the 

machine may be dirty (See "Cleaning the 
inside" on page 73).

Color or Black 
background

If the amount of background shading becomes 
unacceptable:
• Change to a lighter weight paper (See "Print 

media specifications" on page 110).
• Check the environmental conditions: very 

dry conditions or a high level of humidity 
(higher than 80% RH) can increase the 
amount of background shading.

• Remove the old imaging unit and, install a 
new one (See "Replacing the imaging unit" 
on page 99). If this problem persists, contact 
a service representative.

CONDITION SUGGESTED SOLUTIONS
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Toner smear If toner smears on the page: 
• Clean the inside of the machine (See "Clean-

ing the inside" on page 73).
• Check the paper type and quality (See "Print 

media specifications" on page 110).
• Remove the imaging unit and then, install a 

new one (See "Replacing the imaging unit" 
on page 99).

Vertical repetitive 
defects

If marks repeatedly appear on the printed side of 
the page at even intervals:
• The imaging unit may be damaged. If you 

still have the same problem, remove the 
imaging unit and, install a new one (See 
"Replacing the imaging unit" on page 99).

• Parts of the machine may have toner on 
them. If the defects occur on the back of the 
page, the problem will likely correct itself 
after a few more pages.

• The fusing assembly may be damaged. Con-
tact a service representative.

Background scat-
ter

A
Background scatter results from bits of toner 
randomly distributed on the printed page. 
• The paper may be too damp. Try printing 

with a fresh ream of paper. Do not open 
reams of paper until necessary so that the 
paper does not absorb too much moisture.

• If background scatter occurs on an envelope, 
change the printing layout to avoid printing 
over areas that have overlapping seams on 
the reverse side. Printing on seams can 
cause problems.

• If background scatter covers the entire sur-
face area of a printed page, adjust the print 
resolution through your software application 
or in Printing Preferences (See "Opening 
printing preferences" on page 52).

Toner particles are 
around bold char-
acters or pictures

The toner might not adhere properly to this type 
of paper.
• Change the printer option and try again. 

Go to the Printing Preferences, click the 
Paper tab, and set the paper type to Recy-
cled.

CONDITION SUGGESTED SOLUTIONS

Misformed charac-
ters

• If characters are improperly formed and pro-
ducing hollow images, the paper stock may 
be too slick. Try different paper (See "Print 
media specifications" on page 110).

Page skew

A a B b CA a B b CA a B b CA a B b CA a B b C c

• Ensure that the paper is loaded properly.
• Check the paper type and quality (See "Print 

media specifications" on page 110).
• Ensure that the guides are not too tight or too 

loose against the paper stack.

Curl or wave • Ensure that the paper is loaded properly.
• Check the paper type and quality. Both high 

temperature and humidity can cause paper 
curl (See "Print media specifications" on 
page 110).

• Turn the stack of paper over in the tray. Also 
try rotating the paper 180° in the tray.

Wrinkles or 
creases

• Ensure that the paper is loaded properly.
• Check the paper type and quality (See "Print 

media specifications" on page 110).
• Turn the stack of paper over in the tray. Also 

try rotating the paper 180° in the tray.

Back of printouts 
are dirty

Check for leaking toner. Clean the inside of the 
machine (See "Cleaning the inside" on 
page 73).

CONDITION SUGGESTED SOLUTIONS
Troubleshooting_ 93



Common PostScript problems
The following situations are PS language specific and may occur when sev-
eral printer languages are used.

PROBLEM POSSIBLE 
CAUSE SOLUTION

PostScript file can-
not be printed.

The PostScript 
driver may not be 
installed correctly.

• Install the PostScript 
driver (See "Installing 
locally connected 
machine’s driver" on 
page 32).

• Print a configuration 
page and verify that 
the PS version is avail-
able for printing.

• Reinstall the PS 
driver. If the problem 
persists, contact a ser-
vice representative.

“Limit Check Error” 
report prints.

The print job was 
too complex.

You might need to 
reduce the complexity of 
the page or install more 
memory (See "Installing 
a memory module" on 
page 103).

A PostScript error 
page prints.

The print job may 
not be PostScript.

Make sure that the print 
job is a PostScript job. 
Check to see whether 
the software application 
expected a setup or 
PostScript header file to 
be sent to the machine.

The optional tray is 
not selected in the 
driver.

The printer driver 
has not been con-
figured to recog-
nize the optional 
tray.

Open the PostScript 
driver properties, select 
the Device Options tab, 
and set the tray option.

When printing a doc-
ument in Mac with 
Acrobat Reader 6.0 
or higher, colors 
print incorrectly.

The resolution set-
ting in the printer 
driver may not be 
matched with the 
one in Acrobat 
Reader.

Make sure that the reso-
lution setting in your 
printer driver matches 
the one in Acrobat 
Reader.

Solid Color or 
Black pages

A
• The imaging unit may not be installed prop-

erly. Remove the imaging unit and reinsert it.
• The imaging unit may be defective. Remove 

the imaging unit and install a new one (See 
"Replacing the imaging unit" on page 99).

• The machine may require repair. Contact a 
service representative.

Loose toner • Clean the inside of the machine (See "Clean-
ing the inside" on page 73).

• Check the paper type and quality (See "Print 
media specifications" on page 110).

• Remove the imaging unit and then, install a 
new one (See "Replacing the imaging unit" on 
page 99).

• If the problem persists, the machine may 
require repair. Contact a service representa-
tive.

Character Voids

A
Character voids are white areas within parts of 
characters that should be solid black:
• You may be printing on the wrong surface of 

the paper. Remove the paper and turn it 
around. 

• The paper may not meet paper specifica-
tions (See "Print media specifications" on 
page 110).

Horizontal stripes

A a B b C
A a B b C
A a B b C
A a B b C
A a B b C

If horizontally aligned black streaks, white 
streaks or smears appear:
• The imaging unit may be installed improp-

erly. Remove the imaging unit and reinsert it.
• The imaging unit may be defective. Remove 

the imaging unit and install a new one (See 
"Replacing the imaging unit" on page 99).

• The machine might had a minor shock dur-
ing printing or copying. There is no problem 
with the machine. Try printing again. 

• If the problem persists, the machine may 
require repair. Contact a service representa-
tive.

Curl If the printed paper is curled or paper does not 
feed into the machine:
• Turn the stack of paper over in the tray. Also 

try rotating the paper 180° in the tray. 
• Change the printer option and try again. Go 

to Printing Preferences, click Paper tab, 
and set type to Thin (See "Opening printing 
preferences" on page 52).

CONDITION SUGGESTED SOLUTIONS

An unknown image 
repetitively 
appears on a few 
sheets or loose 
toner, light print, or 
contamination 
occurs.

Your machine is probably being used at an alti-
tude of 1,000 m (3,281 ft.) or above.
The high altitude may affect the print quality, 
such as loose toner or light imaging. Change the 
correct altitude setting to your machine (See 
"Altitude adjustment" on page 42).

CONDITION SUGGESTED SOLUTIONS
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Common Windows problems

CONDITION SUGGESTED SOLUTIONS

“File in Use” mes-
sage appears dur-
ing installation.

Exit all software applications. Remove all soft-
ware from the printer’s startup group, then 
restart Windows. Reinstall the printer driver.

“General Protection 
Fault”, “Exception 
OE”, “Spool 32”, or 
“Illegal Operation” 
messages appear.

Close all other applications, reboot Windows 
and try printing again.

“Fail To Print”, “A 
printer timeout error 
occurred” mes-
sages appear.

These messages may appear during printing. 
Just keep waiting until the machine finishes 
printing. If the message appears in standby 
mode or after printing has been completed, 
check the connection and/or whether an error 
has occurred.

 

Refer to Microsoft Windows User’s Guide that came with your com-
puter for further information on Windows error messages.

Common Linux problems

CONDITION SUGGESTED SOLUTIONS

The machine does 
not print.

• Check if the printer driver is installed in your 
system. Open Unified Driver Configurator and 
switch to the Printers tab in Printers config-
uration window to look at the list of available 
machines. Make sure that your machine is 
displayed on the list. If not, open Add new 
printer wizard to set up your device.

• Check if the machine is started. Open Print-
ers configuration and select your machine 
on the printers list. Look at the description in 
the Selected printer pane. If its status con-
tains Stopped string, press the Start button. 
After that normal operation of the machine 
should be restored. The “stopped” status 
might be activated when some problems in 
printing occurred. For instance, this could be 
an attempt to print a document when the port 
is claimed by a scanning application.

• Ensure the port is not busy. Since functional 
components of machine (printer and scanner) 
share the same I/O interface (port), the situa-
tion of simultaneous access of different user 
applications to the same port is possible. To 
avoid possible conflicts, only one of them at a 
time is allowed to gain control over the device. 
The other user will encounter “device busy” 
response. You should open ports configura-
tion and select the port assigned to your 
machine. In the Selected port pane you can 
see if the port is occupied by some other 
application. If this is the case, you should 
either wait for completion of the current job or 
press the Release port button, if you are sure 
that the present application is not functioning 
properly.

• Check if your application has special print 
option such as “-oraw”. If “-oraw” is specified 
in the command line parameter, then remove 
it to print properly. For Gimp front-end, select 
“print” -> “Setup printer” and edit command 
line parameter in the command item.

• The CUPS (Common UNIX Printing System) 
version distributed with SuSE Linux 9.2 
(cups-1.1.21) has a problem with ipp (Internet 
Printing Protocol) printing.Use the socket 
printing instead of ipp or install a later version 
of CUPS (cups-1.1.22 or higher).

Some color images 
come out all black.

This is a known bug in Ghostscript (until GNU 
Ghostscript version 7.05) when the base color 
space of the document is indexed color space 
and it is converted through CIE color space. 
Because Postscript uses CIE color space for 
Color Matching System, you should upgrade 
Ghostscript on your system to at least GNU 
Ghostscript version 7.06 or later. You can find 
recent Ghostscript versions at www.ghost-
script.com.
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Refer to Linux User’s Guide that came with your computer for further 
information on Linux error messages.

Common Mac problems

CONDITION SUGGESTED SOLUTIONS

The machine does 
not print PDF files 
correctly. Some 
parts of graphics, 
text, or illustrations 
are missing.

Printing the PDF file as an image may enable 
the file to print. Turn on Print As Image from the 
Acrobat printing options. 

 

It will take longer to print when you print a 
PDF file as an image.

The document has 
printed, but the print 
job has not disap-
peared from the 
spooler in Mac OS X 
10.3.2.

Update your Mac OS to OS Mac OS X 10.3.3. or 
higher.

Some letters are not 
displayed normally 
during the cover 
page printing.

Mac OS cannot create the font during the cover 
page printing. The English alphabet and num-
bers are displayed normally on the cover page.

When printing a doc-
ument in Mac with 
Acrobat Reader 6.0 
or higher, colors 
print incorrectly.

Make sure that the resolution setting in your 
machine driver matches the one in Acrobat 
Reader.

 

Refer to Mac User’s Guide that came with your computer for further 
information on Mac error messages.

Some color images 
come out in unex-
pected color.

This is a known bug in Ghostscript (until GNU 
Ghostscript version 7.xx) when the base color 
space of the document is indexed RGB color 
space and it is converted through CIE color 
space. Because Postscript uses CIE color space 
for Color Matching System, you should upgrade 
Ghostscript on your system to at least GNU 
Ghostscript version 8.xx or later. You can find 
recent Ghostscript versions at www.ghost-
script.com.

The machine does 
not print whole 
pages and its output 
is half page printed.

It is a known problem that occurs when a color 
printer is used on version 8.51 or earlier of 
Ghostscript, 64-bit Linux OS, and reported to 
bugs.ghostscript.com as Ghostscript Bug 
688252.
The problem is solved in AFPL Ghostscript v. 
8.52 or above. Download the latest version of 
AFPL Ghostscript from http://source-
forge.net/projects/gho

I encounter error 
“Cannot open port 
device file” when 
printing a document.

Avoid changing print job parameters (via LPR 
GUI, for example) while a print job is in progress. 
Known versions of CUPS (Common UNIX Print-
ing System) server break the print job whenever 
print options are changed and then try to restart 
the job from the beginning. Since Unified Linux 
Driver locks the port while printing, the abrupt 
termination of the driver keeps the port locked 
and unavailable for subsequent print jobs. If this 
situation occurs, try to release the port by select-
ing Release port in Port configuration window.

CONDITION SUGGESTED SOLUTIONS
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12.supplies and accessories
This chapter provides information on purchasing supplies, accessories and maintenance parts available for your machine.

• How to purchase
• Available supplies
• Available accessories
• Maintenance parts
• Replacing the toner cartridge
• Replacing the imaging unit
• Necessary precautions to take when installing accessories

• Activating the added accessories in printer properties
• Installing a wireless network interface card
• Upgrading a memory module
• Installing a hard disk
• Printing with the optional memory or hard disk drive

• Replacing the stapler cartridge

  

 

Available accessories may differ from country to country. Contact your 
sales representatives to obtain the list of available accessories.

HOW TO PURCHASE

To order Genuine Samsung supplies, accessories and, maintenance parts, 
contact your local Samsung dealer or the authorized retailer where you pur-
chased your machine. You can also visit www.samsung.com/supplies, 
select your country/region, and obtain information on calling for service.

AVAILABLE SUPPLIES

When supplies reach their lifespan, you can order the following types of 
supplies for your machine:

TYPE AVERAGE YIELDa

a.Declared yield value in accordance with ISO/IEC 19752.

Toner cartridge
Approx. 10,000 pages MLT-D309S

Approx. 30,000 pages MLT-D309L

Approx. 40,000 pages MLT-D309E

Imaging Unit Approx. 80,000 pages MLT-R309

To replace a toner cartridge see "Replacing the toner cartridge" on page 98.

 

Depending on the options and percentage of image area, job mode 
used, the toner cartridge’s lifespan may differ.

 

You must purchase supplies, including toner cartridges, in the same 
country where you purchased your machine. Otherwise, supplies will 
be incompatible with your machine since the system configurations 
vary from country to country.

AVAILABLE ACCESSORIES

You can purchase and install accessories to enhance your machine’s per-
formance and capacity.

PART NAME

ACCESSORY FUNCTION PART NAME

Memory module Extend your machine’s mem-
ory capacity (512 MB).

ML-MEM170

Optional tray If you are experiencing paper 
supply problems, you can 
attach an additional trays. You 
can print documents in various 
sizes and types of print materi-
als.

• ML-5510 6510 
Series: 
ML-S6510A

• ML-5512 5515 
6512 6515 
Series: 
ML-S6512A

High Capacity 
Feeder (HCF)

If you are frequently experienc-
ing paper supply problems, you 
can attach an high capacity 
tray.

 

When using the optional 
High Capacity Feeder, 
you must install the foot 
as shown in the High 
Capacity Feeder Installa-
tion Guide provided with 
the optional High Capac-
ity Feeder. Otherwise, the 
machine can fall down 
and break, causing injury 
to human. 

• ML-5510 6510 
Series: 
ML-H6510A

• ML-5512 5515 
6512 6515 
Series: 
ML-H6512A

Multbin Mailbox You can stack printouts in 4 dif-
ferent stacker.

ML-MBT65

Finisher (Stacker & 
Stapler) 

You can sort and staple print-
outs.

 

HDD needs be installed to 
use some of the finisher 
related options in the 
printer driver.

ML-OCT65

Duplex unit Allows you to print on both 
sides of the paper.

ML-U5510A

Hard disk drive 
(HDD)

Allows you to enhance the 
machine’s capability and print in 
various ways.

ML-HDK470
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MAINTENANCE PARTS

To purchase maintenance parts, contact the source where you bought the 
machine. 

Replacing maintenance parts can be performed only by an authorized ser-
vice provider, dealer, or the retailer where you bought the machine. The 
warranty does not cover the replacement of any maintenance parts once it 
has reached its “Average Yield”.

Maintenance parts are replaced at specific intervals to avoid print quality 
and paper feed problems resulting from worn parts, see table below. The 
purpose of which is to maintain your machine in top working condition. The 
maintenance parts below should be replaced when the life span of each 
item has been met.

PARTS AVERAGE YIELDa

a. It will be affected by operating system used, computing performance, 
application software, connecting method, media type, media size and 
job complexity.

Fuser unit Approx. 150,000 pages

TR Assy Approx. 100,000 pages

Tray1 Retard Roller Approx. 100,000 pages

Pickup/Forward Roller Approx. 200,000 pages

REPLACING THE TONER CARTRIDGE

 

Click this link to open an animation about replacing the toner cartridge.

When the toner cartridge reaches its estimated cartridge life:
• The Smart Panel program window appears on the computer telling you 

the toner cartridge needs to be replaced.
• The LCD display shows a message telling you the toner cartridge needs 

to be replaced.
• The machine stops printing.

At this stage, the toner cartridge needs to be replaced. Check the type of the 
toner cartridge for your machine (see "Available supplies" on page 97).

1. Open the top cover and pull the toner cartridge out.

2. Remove the new toner cartridge from its bag.

 

Do not use sharp objects, such as a knife or scissors, to open the 
toner cartridge package. They might scratch the drum of the car-
tridge.

IEEE 802.11 b/g/n 
Wireless LANa

Allows you to connect your 
printer to a wireless network.

ML-NWA65L

Short Stand You can easily move the 
machine using the stand with its 
wheels.

 

When using the optional 
Stand, you must install 
the foot as shown in the 
Stand Installation Guide 
provided with the optional 
Stand. Otherwise, the 
machine can fall down 
and break, causing injury 
to human. 

ML-DSK65S

IEEE 1284 parallel 
connector

Allows you to use various inter-
face.

 

• When installing the 
printer driver with an 
IEEE 1284 parallel 
connector, the 
machine might not be 
found and after install-
ing the printer driver, 
only basic printing fea-
tures are available.

• If you want to check 
the machine’s status 
or set the settings, 
connect the machine 
to a computer with a 
USB cable or a net-
work.

• If you use the parallel 
connector, you can-
not use the USB 
cable.

ML-PAR100

Staple Cartridge Allows you to staple the print-
outs.

SCX-STP000

Maintenance Kit Consists of maintenance parts. ML-PMK65K

a.Depending on your country, wireless LAN cards may not be available. 
Contact your local Samsung dealer or the retailer where you bought 
your machine.

ACCESSORY FUNCTION PART NAME
Supplies and accessories_ 98

../common/swf/replace_toner.htm


3. Thoroughly shake the cartridge 5 or 6 times to distribute the toner evenly 
inside the cartridge.

Thoroughly roll the cartridge to assure maximum copies per cartridge. 
Save the box and the plastic bag for shipping.

 

If toner gets on your clothing, wipe it off with a dry cloth and wash 
clothing in cold water. Hot water sets toner into fabric.

4. Remove the protection seal.

5. Hold the toner cartridge by the handle and slowly insert the cartridge into 
the opening in the machine.
Tabs on the sides of the cartridge and corresponding grooves within the 
machine will guide the cartridge into the correct position until it locks into 
place completely.

6. Close the top cover. Make sure that the cover is securely closed.

REPLACING THE IMAGING UNIT

 

Click this link to open an animation about replacing the imaging unit.

When the imaging unit reaches its estimated life:
• The Smart Panel program window appears on the computer telling you 

the imaging unit needs to be replaced.
• The LCD display shows a message telling you the imaging unit needs to 

be replaced.
• The machine stops printing.

At this stage, the imaging unit needs to be replaced. Check the type of the 
imaging unit for your machine (see "Available supplies" on page 97).

1. Open the top cover and pull the toner cartridge out.
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2. Pull the imaging unit out. 

3. Remove the new imaging unit from its bag.

 

• Do not use sharp objects, such as a knife or scissors, to open 
the toner cartridge package. They might scratch the drum of 
the cartridge.

• To prevent damage to the imaging unit, do not expose it to light 
for more than a few minutes. Cover it with a piece of paper, if 
necessary.

4. Thoroughly shake the imaging unit 5 or 6 times to distribute the toner 
evenly inside the imaging unit.

5. Remove the protection cover and seal.

6. Hold the imaging unit by the handle and slowly insert the cartridge into 
the opening in the machine.
Tabs on the sides of the imaging unit and corresponding grooves within 
the machine will guide the imaging unit into the correct position until it 

locks into place completely.

 

• Do not touch the green surface of the imaging unit. 
• To prevent damage to the imaging unit, do not expose it to light 

for more than a few minutes. Cover it with a piece of paper, if 
necessary.

7. Reinsert the toner cartridge.
8. Close the top cover. Make sure that the cover is securely closed.

NECESSARY PRECAUTIONS TO TAKE WHEN 
INSTALLING ACCESSORIES
• Disconnect the power cord.

To avoid the possibility of an electrical shock, always disconnect the 
power cord when installing or removing ANY internal or external acces-
sories.

• Discharge static electricity.
The control board and internal accessories (network interface card or 
memory module) are sensitive to static electricity. Before installing or 
removing any internal accessories, discharge static electricity from your 
body by touching something metal, such as the metal back plate on any 
device plugged into a grounded power source. If you walk around before 
finishing the installation, repeat this procedure to discharge any static 
electricity again.

• Activating the added accessories in the PS driver properties.
After installing an accessory such as an optional tray, PS driver users 
must do the additional setting. Go to the PS printer properties and set 
the added accessory activated. 

 

When installing accessories, the battery inside the machine is a ser-
vice component and needs to be replaced by an authorized servicer. 
Do not change it by yourself.
There is a risk of an explosion if battery is replaced by an incorrect 
type.

ACTIVATING THE ADDED ACCESSORIES IN 
PRINTER PROPERTIES
After installing added accessories, you need to select it in the printer proper-
ties of the printer driver in order to use it.

1. Install the driver (See "Installing locally connected machine’s driver" on 
page 32 or "Installing network connected machine’s driver" on page 38).

2. Click the Windows Start menu.
3. For Windows 2000, select Settings > Printers.
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• For Windows XP/2003, select Printers and Faxes. 
• For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers. 
• For Windows 7, select Control Panel > Hardware and Sound > 

Devices and Printers. 
• For Windows Server 2008 R2, select Control Panel > Hardware > 

Devices and Printers. 
4. Right-click your machine.
5. For Windows XP/2003/2008/Vista, press Properties.

• For PS driver, select PS driver and right-click to open Properties. 
For Windows 7 and Windows Server 2008 R2, from context menus, 
select the Printer properties.

 

If Printer properties item has ► mark, you can select other 
printer drivers connected with selected printer.

6. In printer driver properties, select Device Options. 
7. In printer driver properties, set the necessary options.
8. Click OK. 

INSTALLING A WIRELESS NETWORK INTER-
FACE CARD 

 

Depending on your country, wireless LAN cards may not be available. 
Contact your local Samsung dealer or the retailer where you bought 
your printer.

The machine is equipped with a network interface which allows you to use 
your machine on a network. You can also purchase a wireless network 
interface card to enable the use of the machine in wireless network environ-
ments (See "Available accessories" on page 97).

Installing a wireless network interface card
1. Turn the machine off and unplug all cables from the machine.
2. Grasp the control board cover and remove it.

3. Take out a new wireless interface card from its bag.
4. Place the wireless network interface card into the card guide [below item 

3], ensure the connector side of the card is to the right.

1

2

3

1 wireless network interface 
card connector

2 wireless network interface 
card

3 wireless network interface 
card guide

5. Align the wireless network card connector on the right side of the card 
with the connector on the control board [1].
Press the wireless interface card [2] down firmly into the main connector 
[1] until it is completely and securely in place.

2

1

1 Connector

2 Wireless inter-
face card

6.  Close the control board cover by aligning the groove on it with the notch 
on the printer and sliding it.

7. Plug all the cables back into the machine, and turn the machine on.
8. Set the wireless network environment.

 

For information about configuring and using the printer on a wire-
less network environment, refer to the Wireless network install 
guide provided with the wireless network interface card. You can 
also configure the network parameters on the control panel; see 
the next column.
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Configuring the machine’s wireless network
Before starting you will need to know the network name(SSID) of your wire-
less network and the network key if it is encrypted. This information was set 
when the wireless router(access point) was installed. If you do not know 
about your wireless environment, please ask the person who has set up 
your network.
To configure wireless parameters, you can use both control panel and 
SyncThru™ Web Service.

Using the control panel
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight Network and press OK.
3. Press the up/down arrow to highlight Wireless and press OK.
4. Press the up/down arrow to highlight WLAN Settings and press OK.
5. Press the up/down arrow to highlight the setting option you want 

appears and press OK.

• Wizard: The wireless network interface card in your printer 
searches for wireless networks in the area and shows the results 
(see "Wizard mode" on page 102).

• Custom: You can configure the wireless settings according to 
your needs (see "Custom mode" on page 102).

Wizard mode
1. The wireless network interface card on your machine searches for 

wireless network in the area and shows the results.
2. Press the left/right arrow to select a network you want to use in 

Search List and press OK. You can select a network using SSID.
3. When None appears in WLAN Security on the display, press OK to 

save your selection. go to step 6.
If you see another messages, go to the next step.

4. Depending on the network you select, WLAN security encryption 
type will be WEP or WPA.
• In case of WEP, Press the left/right arrow to select Open System 

or SharedKey.
- Open System: Authentication is not used, and Encryption 

may or may not be used, depending on the need for data 
security. Enter the WEP Key using number keypad after 
selecting Open System.

- SharedKey: Authentication is used. A device that has a 
proper WEP Key can access the network. Enter the WEP 
Key using number keypad after selecting SharedKey.

• In case of WPA, Enter the WPA Key using number keypad. The 
Key length should be between 8 to 63 characters long.

5. Press OK.
6. Press Stop/Clear to return to ready mode.

 

• SSID: SSID (Service Set Identifier) is a name that identifies a 
wireless network. Access points and wireless devices attempt-
ing to connect to a specific wireless network must use the 
same SSID. The SSID is case-sensitive.

• WEP: WEP (Wired Equivalent Privacy) is a security protocol 
preventing unauthorized access to your wireless network. 
WEP encrypts the data portion of each packet exchanged on a 
wireless network using a 64-bit or 128-bit WEP encryption key.

• WPA: WPA authorizes and identifies users based on a secret 
key that changes automatically at regular intervals. WPA also 
uses TKIP (Temporal Key Integrity Protocol) and AES 
(Advanced Encryption Standard) for data encryption.

Custom mode
1. Enter the SSID when Edit SSID appears on the top line of the dis-

play, the name that identifies a wireless network. SSID is case-sensi-
tive so you need to enter it carefully. Press OK.

2. Select the type of wireless connections. Press the left/right arrow to 
select the method of Operation Mode you want and press OK.
• Ad-hoc: Allows wireless devices to communicate directly with 

each other in a peer-to-peer environment. Go to step 3.
• Infrastructure: Allows wireless devices to communicate with 

each other through an access point. Go to step 4.
3. Press the left/right arrow to select the method of Channel you want 

and press OK. If you select Auto, the wireless network interface card 
on your machine will automatically adjust the channels.

4. Press the left/right arrow to select the method of WLAN Security 
you want and press OK.
• None: This is used when the validation of a wireless device’s 

identity and data encryption are not required for your network. 
Open system is used for IEEE 802.11 authentication.

• Static WEP: This uses the WEP (Wired Equivalent Privacy) algo-
rithm suggested by IEEE 802.11 standard for security. Static 
WEP security mode requires a proper WEP key for data encryp-
tion, decryption, and IEEE 802.11 authentication. Press the 
left/right arrow to select the setup method you want in Authenti-
cation and press OK.
- Open System: Authentication is not used, and encryption 

may or may not be used, depending on the need for data 
security. Enter the WEP Key using number keypad after 
selecting Open System and then press OK.

- SharedKey: Authentication is used. A device that has a 
proper WEP Key can access the network. Enter the WEP 
Key using number keypad after selecting SharedKey and 
then press OK.

• WPA-PSK or WPA2-PSK: You can select WPA-PSK or 
WPA2-PSK to authenticate the print server based on WPA 
Pre-Shared Key. This uses a shared secret key (generally called 
Pre Shared Key passphrase) which is manually configured on 
the access point and each of its clients.
a. Press OK when WPA-PSK or WPA2-PSK appears on the bot-
tom line of the display.
b. Press the up/down arrow to select TKIP or AES in Encryption 
and press OK. If you select WPA2-PSK, press the left/right arrow 
to select AES or TKIP + AES in Encryption and press OK.
c. Enter the WPA Key using number keypad and press OK.

5. When you have finished, press Stop/Clear to return to the ready 
mode. If you do not know about your wireless environment, please 
ask the network administrator.

 

Disconnect the network cable (standard or crossover). Your 
machine should then start communicating wirelessly with the net-
work. In case of Ad-hoc mode, you can use a wireless LAN and 
wired LAN simultaneously.

Now go to "Installing network connected machine’s driver" on page 38.

Using SyncThru™ Web Service
For information about configuring and using the machine on a wireless 
network environment, refer to the Wireless network install guide pro-
vided with the wireless network interface card. You can also configure 
the network parameters on the SyncThru™ Web Service.
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UPGRADING A MEMORY MODULE

Your machine supports DIMM (Dual Inline Memory Module). Use this 
memory module slot to install additional memory.

When you are expanding the memory capacity, you can add a memory 
module to the vacant memory slot (See "Available accessories" on 
page 97).

We recommend the use of only genuine Samsung DIMM's. You may void 
your warranty if it is determined that your machine problem is being caused 
by third party DIMM's.

Installing a memory module
1. Turn the machine off and unplug all cables from the machine.
2. Grasp the control board cover and remove it.

3.  Take out a new DIMM from its plastic bag.
4. Locate the DMM slot and align the notch on the DIMM with the groove at 

the DIMM slot, holding the DIMM by its edges.

2

1

5. Push the DIMM into the machine until it snaps into place. Make sure that 
the latches fit over the notches located on either side of the DIMM. 

6.  Close the control board cover by aligning the groove on it with the notch 
on the machine and sliding it.

7. Reconnect the power cord and printer cable, and turn the machine on.

Removing a memory
Push the latches at both ends of the DIMM slot away to remove the DIMM 
and pull out the DIMM.
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INSTALLING A HARD DISK

Installing the hard disk allows the data from your computer to be sent to the 
print queue of the printer hard disk. This decreases the workload of the com-
puter. You can also use various print features, such as storing a job in the 
hard disk, proofing a job, and printing private documents.

The order information is provided for optional hard disk (See "Available 
accessories" on page 97).

Installing a hard disk
1. Turn the machine off and unplug all cables from the machine.
2. Grasp the control board cover and remove it.

3. Take out a new hard disk from its plastic bag.
4. Align the connector on the hard disk with the connector on the control 

board. Push the hard disk in until it is latched into place.

5. Fasten down the hard disk with the screws supplied with your new hard 
disk.

 

You only need two b-type screws out of three. Keep the extra one 
in a safe place.

6.  Close the control board cover by aligning the groove on it with the notch 
on the printer and sliding it.

7. Plug all the cables back into the machine, and turn the machine on.
8. You must activate the added hard disk in the driver properties

(See "Activating the added accessories in printer properties" on 
page 100).

PRINTING WITH THE OPTIONAL MEMORY OR 
HARD DISK DRIVE

 

• Some menus may not appear in the display depending on options 
or models. If so, it is not applicable to your machine.

• After installing the optional hard disk, you can use advanced print-
ing features, such as storing or spooling a print job to the hard 
disk, proofing a job, and specifying of printing a private job in the 
printer properties window.
Once you have stored files in the hard disk, you can easily print or 
delete the stored files using the control panel of your printer.
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From the printer driver
After installing the optional memory or HDD, you can use advanced printing 
features, such as proofing a job and specifying of printing a private job in the 
printer properties window.

1. Open the document you want to print.
2. Select Print from the File menu. The Print window appears. 
3. Select your printer driver from the Select Printer list.

The basic print settings including the number of copies and print range 
are selected within the Print window. 

4. Access Printing Preferences (See "Opening printing preferences" on 
page 52).

5. (See "Print Mode" on page 56).

Controlling the active job queue
All of the print jobs waiting to be printed are listed in the active job queue in 
the order you sent them to the printer. You can delete a job from the queue 
before printing, or promote a job to print sooner.

1. Press Menu on the control panel.
2. Press the up/down arrow to highlight Job Management and press OK.
3. Press the up/down arrow to highlight Active Job and press OK.
4. Press the up/down arrow to highlight the user’s name and file name you 

want to use appears and press OK.

 

If the select file is a confidential print job, enter the specified 4-digit 
password.
Use the up/down arrow to enter digits. When you press OK, the 
cursor will move to the next character. When you finish entering 
the password, press OK.
If you enter the incorrect password, Invalid Password appears. 
Re-enter the correct password.

5. Press the up/down arrow to highlight the setting option you want 
appears and press OK.

• Cancel: You can delete a file from the queue.
• Promote: You can select a job waiting in the active job queue and 

change its print order so that it can be printed sooner.
• Release: You can print a job scheduled to be printed at a specified 

time immediately. In this case, the job currently printing is stopped 
and the selected job will be printed. This function is available when 
the job is scheduled for later printing.

6. When Yes appears, press OK.

File Policy
You can choose the file policy for generating file name before you proceed 
with the job through optional HDD or enabled Ram disk. If the optional mem-
ory or HDD already has the same name when you entered a new file name, 
you can rename or overwrite it.

1. Press Menu on the control panel.
2. Press the up/down arrow to highlight Job Management and press OK.
3. Press the up/down arrow to highlight File Policy and press OK.
4. Press the up/down arrow to highlight the setting option you want 

appears and press OK.

• Rename : If the optional memory already has the same name when 
you enter a new file name, the file will be saved as a different name 
that is automatically programmed.

• Overwrite : You can set the machine to delete previous job informa-
tion on optional memory as you store new job information.

Storing a job
You can store jobs on the optional HDD or enabled Ram disk.

1. Open the document you want to print.
2. Select Print from the file menu. The Print window appears. 
3. Select your machine from Select Printer list. 
4. Click Properties or Preferences.
5. Select the print mode you want from the drop-down list

(See "Using help" on page 53).
6. Enter the user’s name and file name and click OK.
7. Click OK until the Print window is displayed.
8. Click OK or Print to start printing.

Printing or deleting a stored job
You can print or delete jobs stored on the optional HDD or enabled Ram 
disk.

1. Press Menu on the control panel.
2. Press the up/down arrow to highlight Job Management and press OK.
3. Press the up/down arrow to highlight Stored Job and press OK.
4. Press the up/down arrow to highlight the user’s name and file name you 

want to use and press OK.

 

If the select file is a confidential print job, enter the specified 4-digit 
password.
Use the up/down arrow to enter digits. When you press OK, the 
cursor will move to the next character. When you finish entering 
the password, press OK.
If you enter the incorrect password, Invalid Password appears. 
Re-enter the correct password.

5. Press the up/down arrow to highlight the setting option you want and 
press OK.

• Print: You can print a stored job.
• Delete: You can delete a stored job.

6. When Yes appears, press OK.

Form file
Form overlay are images stored in the printer hard disk drive (HDD) as a 
special file format that can be printed in layers on any document. 

Creating new form files
Use the steps below to create a new form overlay.
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1. Create or open a document containing text or an image for use in a 
new form file.

2. To save the document as a form file, access Printing Preferences 
(See "Opening printing preferences" on page 52).

3. Click the Advanced tab, and select Edit from the Text drop-down 
list. Edit Overlay window appears.

4. In the Edit Overlay window, click Create. 
5. In the Save As window, type a name of up to eight characters in the 

File name box. Select the destination path, if necessary. (The 
default is C:\Formover.)

6. Click Save. The name appears on the Overlay List. 

7. Click OK or Print until you exit the Print window.

8.  A confirm message appears, click Yes to save.
The file is not printed. Instead, it is stored on your computer hard disk 
drive. 

 

If you click NO, the machine prints your form without saving.

9. A confirm message appears, click Yes to save.

 

The form file size must be the same as the document you print with 
the form file.

Using form files on your machine’s hard disk drive
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Form Menu and press OK.
4. Press the up/down arrow to highlight the setting option you want and 

press OK.

• Off: Prints in normal mode.
• Single Form: Prints all page using the first form.
• Double Form: Prints the front page using the first form and the 

back page using the second form.
5. Press Back.
6. Press the up/down arrow to highlight Select Form and press OK.
7. Press the up/down arrow to highlight the form you want and press 

OK.

Deleting residual image data

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine.

Image Overwrite is a security measure for customers who are concerned 
about unauthorized access and duplication of classified or private docu-
ment.

1. Press Menu on the control panel.
2. Press the up/down arrow to highlight Job Management and press OK.
3. Press the up/down arrow to highlight Image Overwrite and press OK.
4. Press the up/down arrow to highlight the setting option you want and 

press OK.

• Automatic : All residual image data from the machine will be erased 
immediately after each job has been processed.

• Manual : This option provides an on-demand facility for a system 
administrator to erase all the real image data remained in hard disk 
drive (HDD) after this option is enabled. All existing jobs will be 
deleted regardless of their status and all job submissions will be pro-
hibited for the duration of the overwrite.

5. Press the up/down arrow to select On or Off for Automatic.
Press the up/down arrow to select Enable or Disable for Manual.

 

If you select Enable for Manual, the machine asks if the overwrite 
feature should starts now. Press the left/right arrow to select Yes 
or No. If you select Yes, On Demand overwrite starts as soon as 
you select Yes. If you select No, this feature will just be enabled.

6. Press OK.

Held Job Time-out
The machine can automatically delete a stored job after a certain period of 
time. You can set the time the machine will wait before deleting the stored 
job.

1. Press Menu on the control panel.
2. Press the up/down arrow to highlight Job Management and press OK.
3. Press the up/down arrow to highlight Held Job Timeout and press OK.
4. Press the up/down arrow to highlight the setting option you want and 

press OK.

• On : Select to automatically delete a stored job. You can set the 
time the machine will wait before deleting the job.

• Off : Select not to automatically delete a stored job.

REPLACING THE STAPLER CARTRIDGE

When the optional stapler is completely empty, the message for installing 
the staple cartridge appears on the LCD display. 

1. Press the stapler cover at the side of the optional finisher to open.
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2. Pull the stapler unit out.

3. Lift the empty staple cartridge from the stapler unit.

4. Unpack the new staple cartridge. Make sure that all tape and packing 
materials are removed from inside the staple cartridge.

5. Place the staple cartridge back into the stapler unit.

6. Slide the stapler unit in until it locks in place.

7. Close the stapler cover.
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specifications
This chapter guides you about this machine’s specifications.
This chapter includes:

• Hardware specifications
• Environmental specifications
• Electrical specifications
• Print media specifications

 

The specification values are listed below, specification are subject to change without notice. See www.samsung.com/printer for possible changes in infor-
mation.

HARDWARE SPECIFICATIONS

ITEM DESCRIPTION

Dimension Height 420 mm (16.54 inches)

Depth 540 mm (21.28 inches)

Width 464 mm (18.27 inches)

Weight Machine with consumables • ML-5510ND/ML-5512ND/ML-5515ND Series, ML-651x Series: 34.8kg 
(76.72 lbs)

• ML-5510N Series: 34.2kg (75.39 lbs)

Wireless a

a.Optional.

Module ML-NWA65L

ENVIRONMENTAL SPECIFICATIONS

ITEM DESCRIPTION

Noise Levela

a.Sound Pressure Level, ISO 7779. Configuration tested: machine basic installation, A4 paper, simplex printing.

Ready mode 30 dB(A)

Printing mode • ML-551x Series: 56 dB(A)
• ML-651x Series: 58 dB(A)

Quiet mode  52dB(A)

Temperature Operation 10 to 30 °C (50 to 86 °F)

Storage (Packed) -20 to 40 °C (-4 to 104°F)

Humidity Operation 20 to 80% RH

Storage (Packed) 10 to 90% RH
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ELECTRICAL SPECIFICATIONS

 

Power requirements are based on the country/region where the device is sold. Do not convert operating voltages. Doing so might damage the device and 
void the product warranty.

ITEM DESCRIPTION

Power ratinga

a.See the rating label on the machine for the correct voltage, frequency (hertz) and type of current for your machine.

110 volt models AC 110 - 127 V
220 volt models AC 220 - 240 V

Power consumption Average operating mode • ML-551x Series: •Less than 850 W
• ML-651x Series: •Less than 950 W

Ready mode • ML-551x Series: •Less than 100 W
• ML-651x Series: •Less than 120 W

Power save modeb

b.The power consumption of power save mode may be affected by machine's  status, setting conditions, operating environment.

Less than 10W ( ML-5515ND/6515ND : Less than 2.8W )

Power off modec

c. Power consumption can be completely avoided only when the power cable is not connected.

Less than 0 W
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PRINT MEDIA SPECIFICATIONS

TYPE SIZE DIMENSIONS
PRINT MEDIA WEIGHT/CAPACITYa

TRAY1 / OPTIONAL TRAY MULTI-PURPOSE TRAY

Plain paper Letter 216 x 279 mm (8.5 x 11 inches) 70 to 90 g/m2 (19 to 24 lbs bond) 

• 520 sheets of 80 g/m2(20 lbs 
bond)

70 to 90 g/m2 (19 to 24 lbs bond) 

• 100 sheets of 80 g/m2(20 lbs 
bond)

Legal 216 x 356 mm (8.5 x 14 inches)

US Folio 216 x 330 mm (8.5 x 13 inches)

A4 210 x 297 mm (8.27 x 11.69 inches)

Oficio 216 x 343 mm (8.5 x 13.5 inches)

JIS B5 182 x 257 mm (7.17 x 10.12 inches)

ISO B5 176 x 250 mm (6.93 x 9.84 inches) 

Executive 184 x 267 mm (7.25 x 10.5 inches)

A5 148 x 210 mm (5.83 x 8.27 inches)

Statement 140 x 216 mm (5.5 x 8.5 inches)

A6 105 x 148 mm (4.13 x 5.83 inches) 70 to 90 g/m2 (19 to 24 lbs bond) 

• 250 sheets of 80 g/m2(20 lbs 
bond) for tray1.

• Not available in optional trays.

Envelope Envelope Monarch 98 x 191 mm (3.87 x 7.5 inches) 70 to 90 g/m2 (19 to 24 lbs bond) 

• 50 sheets of 80 g/m2(20 lbs 
bond) for tray1 and optional tray 
2 only.

75 to 90 g/m2 (20 to 24 lbs bond)
• 10 sheets

Envelope No. 10 105 x 241 mm (4.12 x 9.5 inches)

Envelope DL 110 x 220 mm (4.33 x 8.66 inches)

Envelope C5 162 x 229 mm (6.38 x 9.02 inches)

Envelope No. 9 98 x 225 mm (3.87 x 8.87 inches)

Envelope C6 114 x 162 mm (4.49 x 6.38 inches) 70 to 90 g/m2 (19 to 24 lbs bond) 

• 50 sheets of 80 g/m2(20 lbs 
bond) for tray1

• Not available in optional trays.

Thick paper Refer to the Plain paper 
section 

Refer to the Plain paper section 90 to 120 g/m2 (24 to 32 lbs bond) 

• 250 sheets of 80 g/m2(20 lbs 
bond)

90 to 120 g/m2 (24 to 32 lbs bond)
• 40 sheets

Thin paper Refer to the Plain paper 
section 

Refer to the Plain paper section 60 to 70 g/m2 (16 to 19 lbs bond)
• 520 sheets 

60 to 70 g/m2 (16 to 19 lbs bond)
• 100 sheets

Thicker paper Refer to the Plain paper 
section 

Refer to the Plain paper section Not available in tray1 / optional 
tray.

163 to 216 g/m2 (43 to 58 lbs 
bond)
• 10 sheets
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Transparency Refer to the Plain paper 
section 

Refer to the Plain paper section • 100 sheets for tray1.
•  Not available in optional trays.

138 to 146 g/m2 (35 to 39 lbs 
bond)
• 20 sheets

Labelsb Refer to the Plain paper 
section 

Refer to the Plain paper section 60 to 70 g/m2 (16 to 19 lbs bond)
• 250 sheets 

120 to 150 g/m2 (32 to 40 lbs 
bond)
• 10 sheets

Card stock Refer to the Plain paper 
section 

Refer to the Plain paper section 120 to 163 g/m2 (32 to 43 lbs 
bond)
• 10 sheets

Minimum size (custom)c 76.2 x 127 mm (3 x 5 inches)  

Maximum size (custom) 216 x 356 mm (8.5 x 14 inches)

a.Maximum capacity may differ depending on media weight, thickness, and environmental conditions. 

b.Smoothness: 100 to 250 (sheffield).

c. The minimum size’s minimum weight is 105 g/m2 (28 lbs bond).

TYPE SIZE DIMENSIONS
PRINT MEDIA WEIGHT/CAPACITYa

TRAY1 / OPTIONAL TRAY MULTI-PURPOSE TRAY
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14.quick guide for windows 8 user
This chapter will outline features specific to the Windows 8 OS. This chapter applies to users running Windows 8. 
• Understanding the screen
• System requirements
• Installing the driver locally
• Installing the driver over the network
• Installing the driver over the wireless network

• Uninstalling the driver
• Using Samsung Printer Experience
• Accessing management tools
• Installing accessories
• Troubleshooting

  

 

• The screen may appear somewhat different depending on the 
model or interface in use.

• Since this guide has been prepared based on Windows 8, some of 
the instructions may differ depending on the version. It may also 
be modified without prior notice.

UNDERSTANDING THE SCREEN

Windows 8 provides both the new Start screen mode and the Desktop 
screen mode of the existing OS.

Start Screen Desktop Screen

SYSTEM REQUIREMENTS

Operat-
ing sys-

tem

Requirement (recommended)

CPU RAM
Free 
HDD 

Space

Win-
dows™ 8

Intel™ Pentium™ IV 1 GHz 
32-bit or 64-bit processor or 
higher

1 GB (2 GB) 16 GB

• Support for DirectX™ 9 graphics with 128 MB memory 
(to enable the Aero theme).

• DVD-R/W Drive

INSTALLING THE DRIVER LOCALLY

A locally connected machine is a machine directly attached to your com-
puter using the cable.

 

• Only use a USB cable no longer than 3 meters (118 inches).
• Samsung Printer Experience app can only be used in the Start 

screen when V4 driver is installed. The V4 driver is automatically 
downloaded from the Windows Update if your computer is con-
nected to the Internet. If not, you can manually download the V4 
driver from Samsung website, www.samsung.com > find your 
product > Support or downloads. 

• If you install the driver using the supplied software CD, V4 driver is 
not installed. If you want to use the V4 driver in the Desktop 
screen, you can download from the Samsung website, www.sam-
sung.com >find your product > Support or downloads.

From the Start Screen
1. Make sure that your computer is connected to the Internet and powered 

on.
2. Make sure that the machine is powered on.
3. Connect the computer and the machine with a USB cable.

The driver is automatically installed from the Windows Update. 

 

• If you want to install Samsung’s printer management tools, you 
need to install them using the supplied software CD (see "From 
the Desktop Screen" on page 113).

• You can download Samsung Printer Experience app from the Win-
dows Store. You need have a Microsoft account to use the Win-
dows Store.

1. From Charms, select Search. 
2. Click Store.
3. Search and click Samsung Printer Experience.
4. Click Install.
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From the Desktop Screen

 

If you install the driver using the supplied software CD, you cannot use 
the installed driver from the Start screen.

1. Insert the supplied software CD into your CD-ROM drive.
If the installation window does not appear, from Charms, select Search 
> Apps and search for Run. Type in X:\Setup.exe, replacing “X” with the 
letter that represents your CD-ROM drive and click OK.

 

If “Tap to choose what happens with this disc.” pop-up window 
appears, click the window and select Run Setup.exe.

2. Review and accept the installation agreements in the installation win-
dow. Then, click Next.

3. Select USB connection on the Printer Connection Type screen. 
Then, click Next.

4. Follow the instructions in the installation window.

INSTALLING THE DRIVER OVER THE NETWORK

 

• Some features and optional goods may not be available depend-
ing on model or country (see "Features by Models" on page 25).

• Machine that do not support networking will not be able to use this 
feature (see "Rear view" on page 27).

• Samsung Printer Experience app can only be used in the Start 
screen when V4 driver is installed. The V4 driver is automatically 
downloaded from the Windows Update if your computer is con-
nected to the Internet. If not, you can manually download the V4 
driver from Samsung website, www.samsung.com >find your prod-
uct > Support or downloads. 

• If you install the driver using the supplied software CD, V4 driver is 
not installed. If you want to use the V4 driver in the Desktop 
screen, you can download from the Samsung website, www.sam-
sung.com >find your product > Support or downloads.

From the Start Screen
1. Make sure that the machine is connected to the network and powered 

on. Also, your machine’s IP address should have been set. 
2. From Charms, select Settings > Change PC settings > Devices.
3. Click Add a device. 

Discovered machines will be shown on the screen. 
4. Click the model name or host name you wish to use. 

 

• You can print a Network Configuration Report from the 
machine’s control panel that will show the current machine’s 
host name.

• If you want to install Samsung’s printer management tools, you 
need to install them using the supplied software CD (see "From 
the Desktop Screen" on page 113).

• You can download Samsung Printer Experience app from the 
Windows Store. You need have a Microsoft account to use 
the Windows Store.

1. From Charms, select Search. 
2. Click Store.
3. Search and click Samsung Printer Experience.
4. Click Install.

5. The driver is automatically installed from the Windows Update. 

From the Desktop Screen

 

If you install the driver using the supplied software CD, you cannot use 
the installed driver from the Start screen.

1. Make sure that the machine is connected to the network and powered 
on. Also, your machine’s IP address should have been set.

2. Insert the supplied software CD into your CD-ROM drive.
If the installation window does not appear, from Charms, select Search 
> Apps and search for Run. Type in X:\Setup.exe, replacing “X” with the 
letter that represents your CD-ROM drive and click OK.

 

If “Tap to choose what happens with this disc.” pop-up window 
appears, click the window and select Run Setup.exe.

3. Review and accept the installation agreements in the installation win-
dow. Then, click Next.

4. Select Network connection on the Printer Connection Type screen. 
5. Follow the instructions in the installation window.

INSTALLING THE DRIVER OVER THE WIRELESS 
NETWORK

 

• Samsung Printer Experience app can only be used in the Start 
screen when V4 driver is installed. The V4 driver is automatically 
downloaded from the Windows Update if your computer is con-
nected to the Internet. If not, you can manually download the V4 
driver from Samsung website, www.samsung.com >find your prod-
uct > Support or downloads. 

• If you install the driver using the supplied software CD, V4 driver is 
not installed. If you want to use the V4 driver in the Desktop 
screen, you can download from the Samsung website, www.sam-
sung.com >find your product > Support or downloads.

• You must set up for wireless network using the supplied software 
CD in Desktop screen mode. 

• If you are using a computer without a CD-ROM, you can set up the 
wireless network from the machine’s control panel.

From the Start Screen
1. After completing the wireless network connection, you need to install a 

machine driver to print from an application. 
2. From Charms, select Settings > Change PC settings > Devices.
3. Click Add a device. 

Discovered machines will be shown on the screen. 
4. Click the model name or host name you wish to use. 

 

You can print a Network Configuration Report from the machine’s 
control panel that will show the current machine’s host name.

5. The driver is automatically installed from the Windows Update. 

 

• If you want to install Samsung’s printer management tools, you 
need to install them using the supplied software CD (see "From 
the Desktop Screen" on page 113).

• You can download Samsung Printer Experience app from the Win-
dows Store. You need have a Microsoft account to use the Win-
dows Store.

1. From Charms, select Search. 
2. Click Store.
3. Search and click Samsung Printer Experience.
4. Click Install.
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From the Desktop Screen

 

If you install the driver using the supplied software CD, you cannot use 
the installed driver from the Start screen.

1. Turn on your computer, access point, and machine.
2. Insert the supplied software CD into your CD-ROM drive.

If the installation window does not appear, from Charms, select Search 
> Apps and search for Run. Type in X:\Setup.exe, replacing “X” with the 
letter that represents your CD-ROM drive and click OK.

 

If “Tap to choose what happens with this disc.” pop-up window 
appears, click the window and select Run Setup.exe.

3. Review and accept the installation agreements in the installation win-
dow. Then, click Next.

4. Follow the instructions in the installation window.

 

For wireless set up or driver installation, refer to the wireless net-
work setup chapter.

UNINSTALLING THE DRIVER

From the Start Screen
1. Make sure that the machine is connected to your computer and powered 

on.
2. Click on the Uninstall Samsung Printer Software tile in the Start 

screen.
3. Follow the instructions in the window.

 

• If you cannot find a Samsung Printer Software tile, unintstall from 
the desktop screen mode (see "From the Desktop Screen" on 
page 114). 

• If you want to uninstall Samsung’s printer management tools, from 
the Start screen, right-click the app > Uninstall > right-click the 
program you want to delete > Uninstall and follow the instruction 
in the window. 

From the Desktop Screen
1. From Charms, select Search > Apps. 
2. Search and click Control Panel.
3. Click Programs and Features.
4. Right-click the driver you want to uninstall and select Uninstall. 
5. Follow the instructions in the window.

USING SAMSUNG PRINTER EXPERIENCE 

Samsung Printer Experience is a Samsung application that combines 
Samsung machine settings and machine management into one location. 
You can set device settings, order supplies, open troubleshooting guides, 
visit Samsung’s web site, and check connected machine information. This 
application will be automatically downloaded from the Windows Store if the 
machine is connected to a computer with an Internet connection. 

Understanding the Samsung Printer Experience
To open the application, 
From the Start screen, select the Samsung Printer Experience 

( ) tile. 

The Samsung Printer Experience interface comprises various useful fea-
tures as described in the following table:

 

The screenshot may differ depending on the model you are using.

 

1

Printer Informa-
tion

This area gives you general information about 
your machine. You can check information, such 
as the machine’s status, location, IP address, 
and remaining toner level.

 

2

User Guide You can view the online User’s Guide. You 
need to be connected to the Internet to use this 
feature.

 

This button opens the Troubleshooting 
Guide when an error occurs. You can 
directly open the troubleshooting section 
in the user’s guide. 

 

3
Order 
Supplies

Click on this button to order replacement toner 
cartridges online. You need to be connected to 
the Internet to use this feature. 

 

4
Visit Samsung Links to Samsung printer website. You need to 

be connected to the Internet to use this feature.
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Adding/Deleting Printers
If you do not have any printer added to the Samsung Printer Experience, 
or if you want to add/delete a printer, follow the instructions below. 

 

You can only add/delete network connected printers.

Adding a printer
1. From the Charms, select Settings.

Or, right-click the Samsung Printer Experience page and select 
Settings.

2. Select Add Printer
3. Select the printer you want to add.

You can see the added printer.

 

If you see  mark, you can also click  mark to add printers.

Deleting a printer
1. From the Charms, select Settings.

Or, right-click the Samsung Printer Experience page and select 
Settings.

2. Select  Remove Printer.
3. Select the printer you want to delete.
4. Click Yes.

You can see that the deleted printer is removed from the screen.

Printing from Windows 8
This section explains common printing tasks from the Start screen.

Basic printing
1. Open the document to print.
2. From the Charms, select Devices.
3. Select your printer from the list
4. Select the printer settings, such as the number of copies and orienta-

tion.

5. Click the Print button to start the print job.

Cancelling a print job
If the printing job is waiting in the print queue or print spooler, cancel the 
job as follows:
• You can access this window by simply double-clicking the machine 

icon ( ) in the Windows task bar. 

• You can also cancel the current job by pressing (Cancel or 

Stop/Clear) button on the control panel.

Opening more settings

 

The screen may appear somewhat different depending on the 
model or options.

You can set up more printing parameters.

6. Open the document you want to print.
7. From the Charms, select Devices.
8. Select your printer from the list
9. Click More settings.

 

5

Printer Settings You can configure various machine settings 
such as machine setup, paper, layout, emula-
tion, networking, and print information through 
SyncThru™ Web Service. Your machine 
needs to be connected to a network. This but-
ton will be disabled if your machine is con-
nected via USB cable.

 

6

Device List & 
Latest Scanned 
Image

The scan list displays devices that supports 
Samsung Printer Experience. Under the 
device, you can see the latest scanned images. 
Your machine needs to be connected to a net-
work to scan from here. 
This section is for the users with multi-functional 
printers.
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Basic tab

Basic
This option allows you to choose the basic printing settings such as cop-
ies, orientation, and document type.
Eco settings
This option allows you to choose multiple pages per side to save media.

Advanced tab

Paper settings
This option allows you to set the basic paper handling specifications.
Layout settings
This option allows you to set the various ways to layout your documents.

Security tab

 

Some features may not be available depending on the model or 
options. If this tab is not shown or disabled, it means that this fea-
tures are not supported.

Job Accounting
This option allows you to print with the given permission.
Confidential Printing
This option is used for printing confidential documents. You need to 
enter a password to print using it.

Using the sharing feature
 Samsung Printer Experience allows you to print from other applica-
tions installed on the computer using the sharing feature. 

 

 This feature is only available for printing jpeg, bmp, tiff, gif, and 
png file formats.

1. Select the content you want to print from other application.
2. From the Charms, select Share > Samsung Printer Experience.
3. Select the printer settings, such as the number of copies and orienta-

tion.
4. Click the Print button to start the print job.
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ACCESSING MANAGEMENT TOOLS

Samsung provides a variety of management tools for Samsung printers. For 
more information on each tool, refer to "Management tools" on page 68.

1. From the Charms, select Search > Apps.
2. Find Samsung Printers.
3. Under Samsung Printers, you can see installed management tools.
4. Click the management tool you want to use.

 

After installing the driver, for some management tools, you can access 
them directly from the Start screen by clicking on the corresponding 
tile.

INSTALLING ACCESSORIES

When you install optional devices, such as optional tray, memory, etc, this 
machine automatically detects and sets the optional devices. If you cannot 
use the optional devices you installed in this driver, you can set the optional 
devices in Device Settings to use.

1. From the Charms, select Search > Settings.
2. Search for Devices and Printers.

3. Right-click on your printer icon and select Printer properties.

 

If Printer properties item has a ▶ mark, you can select other 
printer drivers connected with the selected printer.

4. Select Device Settings. 

 

The Printer properties window may differ depending on the driver 
or operating system you are using.

5. Select the appropriate option.
6. Click OK until you exit the Printer properties window.

TROUBLESHOOTING

Problem Suggested Solutions

Samsung Printer 
Experience is not 
shown when you click 
more settings.

Samsung Printer Experience is not installed. 
Download the app. from the Windows Store 
and install it.

Machine information is 
not displayed when you 
click the device in the 
Devices and Printers.

Check the Printer properties. Click the Ports 
tab.
(Control Panel > Devices and Printers > 
Right-click on your printer icon and select 
Printer properties)
If the port is set to File or LPT, uncheck them 
and select TCP/IP, USB, or WSD.
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contact samsung worldwide
If you have any comments or questions regarding Samsung products, contact the Samsung customer care center.

Country/Region Customer Care Center WebSite

ANGOLA 91-726-7864 www.samsung.com

ARGENTINA 0800-333-3733 www.samsung.com

ARMENIA 0-800-05-555 www.samsung.com

AUSTRALIA 1300 362 603 www.samsung.com

AUSTRIA 0810-SAMSUNG (7267864, € 0.07/min) www.samsung.com

AZERBAIJAN 088-55-55-555 www.samsung.com

BAHRAIN 8000-4726 www.samsung.com/ae (English)
www.samsung.com/ae_ar (Arabic)

BELARUS 810-800-500-55-500 www.samsung.com

BELGIUM 02-201-24-18 www.samsung.com/be (Dutch)
www.samsung.com/be_fr (French)

BOLIVIA 800-10-7260 www.samsung.com

BOSNIA 051 133 1999 www.samsung.com

BOTSWANA 0800-726-000 www.samsung.com

BRAZIL 0800-124-421
4004-0000

www.samsung.com

BULGARIA 07001 33 11 , normal tariff www.samsung.com

CAMEROON 7095- 0077 www.samsung.com

CANADA 1-800-SAMSUNG (726-7864) www.samsung.com/ca (English)
www.samsung.com/ca_fr (French)

CHILE 800-SAMSUNG (726-7864)
From mobile 02-24 82 82 00

www.samsung.com/cl

CHINA 400-810-5858 www.samsung.com

COLOMBIA 01-8000112112
Bogotá: 6001272

www.samsung.com/co

COSTA RICA 0-800-507-7267 www.samsung.com/latin (Spanish)
www.samsung.com/latin_en (English)

CROATIA 062 SAMSUNG (062 726 786) www.samsung.com

Cote D’ Ivoire 8000 0077 www.samsung.com

CYPRUS 8009 4000 only from landline
(+30) 210 6897691 from mobile and land line

www.samsung.com

CZECH 800-SAMSUNG (800-726786) www.samsung.com

DENMARK 70 70 19 70 www.samsung.com

DOMINICA 1-800-751-2676 www.samsung.com/latin (Spanish)
www.samsung.com/latin_en (English)

ECUADOR 1-800-10-7267 www.samsung.com/latin (Spanish)
www.samsung.com/latin_en (English)
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EGYPT 08000-726786 www.samsung.com

EIRE 0818 717100 www.samsung.com

EL SALVADOR 800-6225 www.samsung.com/latin (Spanish)
www.samsung.com/latin_en (English)

ESTONIA 800-7267 www.samsung.com/ee

FINLAND 030-6227 515 www.samsung.com

FRANCE 01 48 63 00 00 www.samsung.com/fr

GERMANY 0180 5 SAMSUNG bzw.
0180 5 7267864* (*0,14 €/Min. aus dem dt. Festnetz, aus dem 
Mobilfunk max. 0,42 €/Min.)

www.samsung.com

GEORGIA 8-800-555-555 www.samsung.com

GHANA 0800-10077
0302-200077

www.samsung.com

GREECE 80111-SAMSUNG (80111 726 7864) only from land line
(+30) 210 6897691 from mobile and land line

www.samsung.com

GUATEMALA 1-800-299-0013 www.samsung.com/latin (Spanish)
www.samsung.com/latin_en (English)

HONDURAS 800-27919267 www.samsung.com/latin (Spanish)
www.samsung.com/latin_en (English)

HONG KONG (852) 3698-4698 www.samsung.com/hk (Chinese)
www.samsung.com/hk_en (English)

HUNGARY 06-80-SAMSUNG (726-7864) www.samsung.com

INDIA 1800 3000 8282
1800 266 8282

www.samsung.com/in

INDONESIA 0800-112-8888
021-5699-7777

www.samsung.com/id

IRAN 021-8255 www.samsung.com

ITALIA 800-SAMSUNG (726-7864) www.samsung.com

JAMAICA 1-800-234-7267 www.samsung.com

JAPAN 0120-327-527 www.samsung.com

JORDAN 800-22273
065777444

www.samsung.com/Levant (English)

KAZAKHSTAN 8-10-800-500-55-500 (GSM:7799) www.samsung.com

KENYA 0800 724 000 www.samsung.com

KUWAIT 183-2255 (183-CALL) www.samsung.com/ae (English)
www.samsung.com/ae_ar (Arabic)

KYRGYZSTAN 00-800-500-55-500 www.samsung.com

LATVIA 8000-7267 www.samsung.com/lv

LITHUANIA 8-800-77777 www.samsung.com/lt

LUXEMBURG 261 03 710 www.samsung.com

MALAYSIA 1800-88-9999 www.samsung.com/my

MEXICO 01-800-SAMSUNG (726-7864) www.samsung.com

Country/Region Customer Care Center WebSite
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MOLDOVA 0-800-614-40 www.samsung.com

MONGOLIA +7-800-555-55-55 www.samsung.com

MONTENEGRO 020 405 888 www.samsung.com

MOROCCO 080 100 2255 www.samsung.com

NAMIBIA 8197267864 www.samsung.com

NIGERIA 0800-726-7864 www.samsung.com

NETHERLANDS 0900-SAMSUNG (0900-7267864) (€ 0,10/min) www.samsung.com

NEW ZEALAND  0800 SAMSUNG (0800 726 786) www.samsung.com

NICARAGUA 00-1800-5077267 www.samsung.com/latin (Spanish)
www.samsung.com/latin_en (English)

NORWAY 815-56 480 www.samsung.com

OMAN 800-SAMSUNG (726-7864) www.samsung.com/ae (English)
www.samsung.com/ae_ar (Arabic)

PANAMA 800-7267 www.samsung.com/latin (Spanish)
www.samsung.com/latin_en (English)

PARAGUAY 98005210001 www.samsung.com

PERU 0-800-777-08 (Only from landline)
336-8686 (From HHP & landline)

www.samsung.com

PHILIPPINES 1-800-10-SAMSUNG(726-7864) for PLDT
1-800-3-SAMSUNG(726-7864) for Digitel
1-800-8-SAMSUNG(726-7864) for Globe
02-5805777

www.samsung.com/ph

POLAND 0 801-1SAMSUNG(172-678) * 
lub +48 22 607-93-33 **
* (całkowity koszt połączenia jak za 1 impuls według taryfy 
operatora)
** (koszt połączenia według taryfy operatora)

www.samsung.com/pl

PORTUGAL 808 20-SAMSUNG (808 20 7267) www.samsung.com

PUERTO RICO 1-800-682-3180 www.samsung.com

QATAR 800-2255 (800-CALL) www.samsung.com/ae (English)
www.samsung.com/ae_ar (Arabic)

ROMANIA 08008 SAMSUNG (08008 726 7864)
TOLL FREE No.

www.samsung.com

RUSSIA 800-00-0077 www.samsung.com

SAUDI ARABIA 9200-21230 www.samsung.com/sa (Arabic)

SENEGAL 8-800-555-55-55 www.samsung.com

SERBIA  +381 11 321 6899 
(old number still active 0700 7267864)

www.samsung.com

SINGAPORE 1800-SAMSUNG (726-7864) www.samsung.com

SLOVAKIA 0800 - SAMSUNG(0800-726 786) www.samsung.com

SOUTH AFRICA 0860 SAMSUNG (726-7864) www.samsung.com

SPAIN 902-1-SAMSUNG(902 172 678) www.samsung.com

SWEDEN 0771 726 7864 (SAMSUNG) www.samsung.com

Country/Region Customer Care Center WebSite
Contact SAMSUNG worldwide_ 120

http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com/be
http://www.samsung.com/be_fr
http://www.samsung.com/be
http://www.samsung.com
http://www.samsung.com/be
http://www.samsung.com/be_fr
http://www.samsung.com/be
http://www.samsung.com/be
http://www.samsung.com/be_fr
http://www.samsung.com/be
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com/be
http://www.samsung.com/be_fr
http://www.samsung.com/be
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com


SWITZERLAND 0848-SAMSUNG (7267864, CHF 0.08/min) www.samsung.com/ch
www.samsung.com/ch_fr/

SYRIA 18252273 www.samsung.com/Levant (English)

TADJIKISTAN 8-10-800-500-55-500 www.samsung.com

TAIWAN 0800-329-999
0266-026-066

www.samsung.com

TANZANIA 0685 88 99 00 www.samsung.com

THAILAND 1800-29-3232
02-689-3232

www.samsung.com/th

TRINIDAD & TOBAGO 1-800-SAMSUNG (726-7864) www.samsung.com

TURKEY 444 77 11 www.samsung.com

U.A.E 800-SAMSUNG (726-7864) www.samsung.com

U.K 0330 SAMSUNG (726-7864) www.samsung.com

U.S.A 1-800-SAMSUNG (726-7864) www.samsung.com

UGANDA 0800 300 300 www.samsung.com

UKRAINE 0-800-502-000 www.samsung.com/ua (Ukrainian)
www.samsung.com/ua_ru (Russian)

URUGUAY 40543733 www.samsung.com

UZBEKISTAN 8-10-800-500-55-500 www.samsung.com

VENEZUELA 0-800-100-5303 www.samsung.com

VIETNAM 1 800 588 889 www.samsung.com

ZAMBIA 211350370 www.samsung.com

Country/Region Customer Care Center WebSite
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glossary

 

The following glossary helps you get familiar with the product by 
understanding the terminologies commonly used with printing as well 
as mentioned in this user’s guide.

802.11
802.11 is a set of standards for wireless local area network (WLAN) 
communication, developed by the IEEE LAN/MAN Standards 
Committee (IEEE 802). 

802.11b/g/n
802.11b/g/n can share same hardware and use the 2.4 GHz band. 
802.11b supports bandwidth up to 11 Mbps, 802.11n supports 
bandwidth up to 150 Mbps. 802.11b/g/n devices may occasionally suffer 
interference from microwave ovens, cordless telephones, and Bluetooth 
devices.

Access point
Access Point or Wireless Access Point (AP or WAP) is a device that 
connects wireless communication devices together on wireless local 
area networks (WLAN), and acts as a central transmitter and receiver of 
WLAN radio signals. 

ADF
An Automatic Document Feeder (ADF) is a scanning unit that will 
automatically feed an original sheet of paper so that the machine can 
scan some amount of the paper at once. 

AppleTalk
AppleTalk is a proprietary suite of protocols developed by Apple, Inc for 
computer networking. It was included in the original Mac (1984) and is 
now deprecated by Apple in favor of TCP/IP networking.

BIT Depth
A computer graphics term describing the number of bits used to 
represent the color of a single pixel in a bitmapped image. Higher color 
depth gives a broader range of distinct colors. As the number of bits 
increases, the number of possible colors becomes impractically large for 
a color map. 1-bit color is commonly called as monochrome or black and 
white.

BMP
A bitmapped graphics format used internally by the Microsoft Windows 
graphics subsystem (GDI), and used commonly as a simple graphics file 
format on that platform.

BOOTP
Bootstrap Protocol. A network protocol used by a network client to 
obtain its IP address automatically. This is usually done in the bootstrap 
process of computers or operating systems running on them. The 
BOOTP servers assign the IP address from a pool of addresses to each 

client. BOOTP enables 'diskless workstation' computers to obtain an IP 
address prior to loading any advanced operating system.

CCD
Charge Coupled Device (CCD) is a hardware which enables the scan 
job. CCD Locking mechanism is also used to hold the CCD module to 
prevent any damage when you move the machine.

Collation
Collation is a process of printing a multiple-copy job in sets. When 
collation is selected, the device prints an entire set before printing 
additional copies.

Control Panel
A control panel is a flat, typically vertical, area where control or 
monitoring instruments are displayed. They are typically found in front of 
the machine. 

Coverage
It is the printing term used for a toner usage measurement on printing. 
For example, 5% coverage means that an A4 sided paper has about 5% 
image or text on it. So, if the paper or original has complicated images or 
lots of text on it, the coverage will be higher and at the same time, a 
toner usage will be as much as the coverage.

CSV
Comma Separated Values (CSV). A type of file format, CSV is used to 
exchange data between disparate applications. The file format, as it is 
used in Microsoft Excel, has become a de facto standard throughout the 
industry, even among non-Microsoft platforms.

DADF
A Duplex Automatic Document Feeder (DADF) is a scanning unit that 
will automatically feed and turn over an original sheet of paper so that 
the machine can scan on both sides of the paper.

Default
The value or setting that is in effect when taking a printer out of its box 
state, reset, or initialized.

DHCP
A Dynamic Host Configuration Protocol (DHCP) is a client-server 
networking protocol. A DHCP server provides configuration parameters 
specific to the DHCP client host requesting, generally, information 
required by the client host to participate on an IP network. DHCP also 
provides a mechanism for allocation of IP addresses to client hosts.
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DIMM
Dual Inline Memory Module (DIMM), a small circuit board that holds 
memory. DIMM stores all the data within the machine like printing data, 
received fax data.

DLNA
The Digital Living Network Alliance (DLNA) is a standard that allows 
devices on a home network to share information with each other across 
the network.

DMPr
The Digital Media Printer (DMPr) is a device that allows printing in DLNA 
home network. The DMPr prints a page by combining images with an 
Extensible HyperText Markup Language (XHTML) template. 

DNS
The Domain Name Server (DNS) is a system that stores information 
associated with domain names in a distributed database on networks, 
such as the Internet.

Dot Matrix Printer
A dot matrix printer refers to a type of computer printer with a print head 
that runs back and forth on the page and prints by impact, striking an 
ink-soaked cloth ribbon against the paper, much like a typewriter.

DPI
Dots Per Inch (DPI) is a measurement of resolution that is used for 
scanning and printing. Generally, higher DPI results in a higher 
resolution, more visible detail in the image, and a larger file size.

DRPD 
Distinctive Ring Pattern Detection. Distinctive Ring is a telephone 
company service which enables a user to use a single telephone line to 
answer several different telephone numbers.

Duplex
A mechanism that will automatically turn over a sheet of paper so that 
the machine can print (or scan) on both sides of the paper. A printer 
equipped with a Duplex Unit can print on both sides of paper during one 
print cycle.

Duty Cycle
Duty cycle is the page quantity which does not affect printer 
performance for a month. Generally the printer has the lifespan limitation 
such as pages per year. The lifespan means the average capacity of 
print-outs, usually within the warranty period. For example, if the duty 
cycle is 48,000 pages per month assuming 20 working days, a printer 
limits 2,400 pages a day.

ECM
Error Correction Mode (ECM) is an optional transmission mode built into 
Class 1 fax machines or fax modems. It automatically detects and 
corrects errors in the fax transmission process that are sometimes 
caused by telephone line noise.

Emulation
Emulation is a technique of one machine obtaining the same results as 
another.
An emulator duplicates the functions of one system with a different 
system, so that the second system behaves like the first system. 
Emulation focuses on exact reproduction of external behavior, which is 
in contrast to simulation, which concerns an abstract model of the 
system being simulated, often considering its internal state.

Ethernet
Ethernet is a frame-based computer networking technology for local 
area networks (LANs). It defines wiring and signaling for the physical 
layer, and frame formats and protocols for the media access control 
(MAC)/data link layer of the OSI model. Ethernet is mostly standardized 
as IEEE 802.3. It has become the most widespread LAN technology in 
use during the 1990s to the present.

EtherTalk
A suite of protocols developed by Apple Computer for computer 
networking. It was included in the original Mac (1984) and is now 
deprecated by Apple in favor of TCP/IP networking. 

FDI
Foreign Device Interface (FDI) is a card installed inside the machine to 
allow a third party device such as a coin operated device or a card 
reader. Those devices allow the pay-for-print service on your machine.

FTP
A File Transfer Protocol (FTP) is a commonly used protocol for 
exchanging files over any network that supports the TCP/IP protocol 
(such as the Internet or an intranet).

Fuser Unit 
The part of a laser printer that fuses the toner onto the print media. It 
consists of a heat roller and a pressure roller. After toner is transferred 
onto the paper, the fuser unit applies heat and pressure to ensure that 
the toner stays on the paper permanently, which is why paper is warm 
when it comes out of a laser printer.

Gateway
A connection between computer networks, or between a computer 
network and a telephone line. It is very popular, as it is a computer or a 
network that allows access to another computer or network.

Grayscale
A shades of gray that represent light and dark portions of an image 
when color images are converted to grayscale; colors are represented 
by various shades of gray.

Halftone
An image type that simulates grayscale by varying the number of dots. 
Highly colored areas consist of a large number of dots, while lighter 
areas consist of a smaller number of dots.
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HDD
Hard Disk Drive (HDD), commonly referred to as a hard drive or hard 
disk, is a non-volatile storage device which stores digitally-encoded data 
on rapidly rotating platters with magnetic surfaces.

IEEE
The Institute of Electrical and Electronics Engineers (IEEE) is an 
international non-profit, professional organization for the advancement 
of technology related to electricity.

IEEE 1284
The 1284 parallel port standard was developed by the Institute of 
Electrical and Electronics Engineers (IEEE). The term "1284-B" refers to 
a specific connector type on the end of the parallel cable that attaches to 
the peripheral (for example, a printer). 

Intranet
A private network that uses Internet Protocols, network connectivity, and 
possibly the public telecommunication system to securely share part of 
an organization's information or operations with its employees. 
Sometimes the term refers only to the most visible service, the internal 
website.

IP address
An Internet Protocol (IP) address is a unique number that devices use in 
order to identify and communicate with each other on a network utilizing 
the Internet Protocol standard.

IPM
The Images Per Minute (IPM) is a way of measuring the speed of a 
printer. An IPM rate indicates the number of single-sided sheets a printer 
can complete within one minute.

IPP
The Internet Printing Protocol (IPP) defines a standard protocol for 
printing as well as managing print jobs, media size, resolution, and so 
forth. IPP can be used locally or over the Internet to hundreds of 
printers, and also supports access control, authentication, and 
encryption, making it a much more capable and secure printing solution 
than older ones.

IPX/SPX
IPX/SPX stands for Internet Packet Exchange/Sequenced Packet 
Exchange. It is a networking protocol used by the Novell NetWare 
operating systems. IPX and SPX both provide connection services 
similar to TCP/IP, with the IPX protocol having similarities to IP, and 
SPX having similarities to TCP. IPX/SPX was primarily designed for 
local area networks (LANs), and is a very efficient protocol for this 
purpose (typically its performance exceeds that of TCP/IP on a LAN).

ISO
The International Organization for Standardization (ISO) is an 
international standard-setting body composed of representatives from 
national standards bodies. It produces world-wide industrial and 
commercial standards.

ITU-T
The International Telecommunication Union is an international 
organization established to standardize and regulate international radio 
and telecommunications. Its main tasks include standardization, 
allocation of the radio spectrum, and organizing interconnection 
arrangements between different countries to allow international phone 
calls. A -T out of ITU-T indicates telecommunication.

ITU-T No. 1 chart
Standardized test chart published by ITU-T for document facsimile 
transmissions.

JBIG
Joint Bi-level Image Experts Group (JBIG) is an image compression 
standard with no loss of accuracy or quality, which was designed for 
compression of binary images, particularly for faxes, but can also be 
used on other images.

JPEG
Joint Photographic Experts Group (JPEG) is a most commonly used 
standard method of lossy compression for photographic images. It is the 
format used for storing and transmitting photographs on the World Wide 
Web.

LDAP
The Lightweight Directory Access Protocol (LDAP) is a networking 
protocol for querying and modifying directory services running over 
TCP/IP.

LED
A Light-Emitting Diode (LED) is a semiconductor device that indicates 
the status of a machine.

MAC address
Media Access Control (MAC) address is a unique identifier associated 
with a network adapter. MAC address is a unique 48-bit identifier usually 
written as 12 hexadecimal characters grouped in pairs (e. g., 
00-00-0c-34-11-4e). This address is usually hard-coded into a Network 
Interface Card (NIC) by its manufacturer, and used as an aid for routers 
trying to locate machines on large networks.

MFP
Multi Function Peripheral (MFP) is an office machine that includes the 
following functionality in one physical body, so as to have a printer, a 
copier, a fax, a scanner and etc.

MH
Modified Huffman (MH) is a compression method for decreasing the 
amount of data that needs to be transmitted between the fax machines 
to transfer the image recommended by ITU-T T.4. MH is a 
codebook-based run-length encoding scheme optimized to efficiently 
compress white space. As most faxes consist mostly of white space, this 
minimizes the transmission time of most faxes. 
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MMR
Modified Modified READ (MMR) is a compression method 
recommended by ITU-T T.6.

Modem
A device that modulates a carrier signal to encode digital information, 
and also demodulates such a carrier signal to decode transmitted 
information.

MR
Modified Read (MR) is a compression method recommended by ITU-T 
T.4. MR encodes the first scanned line using MH. The next line is 
compared to the first, the differences determined, and then the 
differences are encoded and transmitted.

NetWare
A network operating system developed by Novell, Inc. It initially used 
cooperative multitasking to run various services on a PC, and the 
network protocols were based on the archetypal Xerox XNS stack. 
Today NetWare supports TCP/IP as well as IPX/SPX.

OPC
Organic Photo Conductor (OPC) is a mechanism that makes a virtual 
image for print using a laser beam emitted from a laser printer, and it is 
usually green or rust colored and has a cylinder shape. 
An imaging unit containing a drum slowly wears the drum surface by its 
usage in the printer, and it should be replaced appropriately since it gets 
worn from contact with the cartridge development brush, cleaning 
mechanism, and paper.

Originals
The first example of something, such as a document, photograph or text, 
etc, which is copied, reproduced or translated to produce others, but 
which is not itself copied or derived from something else.

OSI
Open Systems Interconnection (OSI) is a model developed by the 
International Organization for Standardization (ISO) for communications. 
OSI offers a standard, modular approach to network design that divides 
the required set of complex functions into manageable, self-contained, 
functional layers. The layers are, from top to bottom, Application, 
Presentation, Session, Transport, Network, Data Link and Physical.

PABX 
A private automatic branch exchange (PABX) is an automatic telephone 
switching system within a private enterprise.

PCL
Printer Command Language (PCL) is a Page Description Language 
(PDL) developed by HP as a printer protocol and has become an 
industry standard. Originally developed for early inkjet printers, PCL has 
been released in varying levels for thermal, dot matrix printer, and laser 
printers.

PDF
Portable Document Format (PDF) is a proprietary file format developed 
by Adobe Systems for representing two dimensional documents in a 
device independent and resolution independent format.

PostScript
PostScript (PS) is a page description language and programming 
language used primarily in the electronic and desktop publishing areas. - 
that is run in an interpreter to generate an image.

Printer Driver
A program used to send commands and transfer data from the computer 
to the printer.

Print Media
The media like paper, envelopes, labels, and transparencies which can 
be used in a printer, a scanner, a fax or, a copier.

PPM
Pages Per Minute (PPM) is a method of measurement for determining 
how fast a printer works, meaning the number of pages a printer can 
produce in one minute.

PRN file
An interface for a device driver, this allows software to interact with the 
device driver using standard input/output system calls, which simplifies 
many tasks. 

Protocol
A convention or standard that controls or enables the connection, 
communication, and data transfer between two computing endpoints.

PS
See PostScript.

PSTN
The Public-Switched Telephone Network (PSTN) is the network of the 
world's public circuit-switched telephone networks which, on industrial 
premises, is usually routed through the switchboard.

RADIUS
Remote Authentication Dial In User Service (RADIUS) is a protocol for 
remote user authentication and accounting. RADIUS enables 
centralized management of authentication data such as usernames and 
passwords using an AAA (authentication, authorization, and accounting) 
concept to manage network access.

Resolution
The sharpness of an image, measured in Dots Per Inch (DPI). The 
higher the dpi, the greater the resolution.

SMB
Server Message Block (SMB) is a network protocol mainly applied to 
share files, printers, serial ports, and miscellaneous communications 
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between nodes on a network. It also provides an authenticated 
Inter-process communication mechanism.

SMTP
Simple Mail Transfer Protocol (SMTP) is the standard for e-mail 
transmissions across the Internet. SMTP is a relatively simple, 
text-based protocol, where one or more recipients of a message are 
specified, and then the message text is transferred. It is a client-server 
protocol, where the client transmits an email message to the server.

SSID
Service Set Identifier (SSID) is a name of a wireless local area network 
(WLAN). All wireless devices in a WLAN use the same SSID in order to 
communicate with each other. The SSIDs are case-sensitive and have a 
maximum length of 32 characters.

Subnet Mask 
The subnet mask is used in conjunction with the network address to 
determine which part of the address is the network address and which 
part is the host address.

TCP/IP
The Transmission Control Protocol (TCP) and the Internet Protocol (IP); 
the set of communications protocols that implement the protocol stack 
on which the Internet and most commercial networks run.

TCR
Transmission Confirmation Report (TCR) provides details of each 
transmission such as job status, transmission result and number of 
pages sent. This report can be set to print after each job or only after 
failed transmissions.

TIFF
Tagged Image File Format (TIFF) is a variable-resolution bitmapped 
image format. TIFF describes image data that typically come from 
scanners. TIFF images make use of tags, keywords defining the 
characteristics of the image that is included in the file. This flexible and 
platform-independent format can be used for pictures that have been 
made by various image processing applications.

Toner Cartridge
A kind of bottle or container used in a machine like a printer which 
contains toner. Toner is a powder used in laser printers and 
photocopiers, which forms the text and images on the printed paper. 
Toner can be fused by by a combination of heat/pressure from the fuser, 
causing it to bind to the fibers in the paper.

TWAIN
An industry standard for scanners and software. By using a 
TWAIN-compliant scanner with a TWAIN-compliant program, a scan can 
be initiated from within the program. It is an image capture API for 
Microsoft Windows and Apple Mac operating systems.

UNC Path
Uniform Naming Convention (UNC) is a standard way to access network 
shares in Window NT and other Microsoft products. The format of a 
UNC path is: \\<servername>\<sharename>\<Additional directory>

URL
Uniform Resource Locator (URL) is the global address of documents 
and resources on the Internet. The first part of the address indicates 
what protocol to use, the second part specifies the IP address or the 
domain name where the resource is located.

USB
Universal Serial Bus (USB) is a standard that was developed by the 
USB Implementers Forum, Inc., to connect computers and peripherals. 
Unlike the parallel port, USB is designed to concurrently connect a 
single computer USB port to multiple peripherals.

Watermark
A watermark is a recognizable image or pattern in paper that appears 
lighter when viewed by transmitted light. Watermarks were first 
introduced in Bologna, Italy in 1282; they have been used by 
papermakers to identify their product, and also on postage stamps, 
currency, and other government documents to discourage 
counterfeiting.

WEP
Wired Equivalent Privacy (WEP) is a security protocol specified in IEEE 
802.11 to provide the same level of security as that of a wired LAN. WEP 
provides security by encrypting data over radio so that it is protected as 
it is transmitted from one end point to another.

WIA
Windows Imaging Architecture (WIA) is an imaging architecture that is 
originally introduced in Windows Me and Windows XP. A scan can be 
initiated from within these operating systems by using a WIA-compliant 
scanner.

WPA
Wi-Fi Protected Access (WPA) is a class of systems to secure wireless 
(Wi-Fi) computer networks, which was created to improve upon the 
security features of WEP.

WPA-PSK
WPA-PSK (WPA Pre-Shared Key) is special mode of WPA for small 
business or home users. A shared key, or password, is configured in the 
wireless access point (WAP) and any wireless laptop or desktop 
devices. WPA-PSK generates a unique key for each session between a 
wireless client and the associated WAP for more advanced security.

WPS
The Wi-Fi Protected Setup (WPS) is a standard for establishing a 
wireless home network. If your wireless access point supports WPS, you 
can configure the wireless network connection easily without a 
computer.
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XPS
XML Paper Specification (XPS) is a specification for a Page Description 
Language (PDL) and a new document format, which has benefits for 
portable document and electronic document, developed by Microsoft. It 
is an XML-based specification, based on a new print path and a 
vector-based device-independent document format.
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